Installing Agile PLM with Oracle Application Server

Release 9.2.1

Part No. E11122-01

Make sure you check for updates to this manual at the Oracle Technology Network (OTN) Web site
Copyrights and Trademarks

Copyright © 1995, 2007, Oracle. All rights reserved.

The Programs (which include both the software and documentation) contain proprietary information; they are provided under a license agreement containing restrictions on use and disclosure and are also protected by copyright, patent, and other intellectual and industrial property laws. Reverse engineering, disassembly, or decompilation of the Programs, except to the extent required to obtain interoperability with other independently created software or as specified by law, is prohibited.

The information contained in this document is subject to change without notice. If you find any problems in the documentation, please report them to us in writing. This document is not warranted to be error-free. Except as may be expressly permitted in your license agreement for these Programs, no part of these Programs may be reproduced or transmitted in any form or by any means, electronic or mechanical, for any purpose.

If the Programs are delivered to the United States Government or anyone licensing or using the Programs on behalf of the United States Government, the following notice is applicable:

U.S. GOVERNMENT RIGHTS Programs, software, databases, and related documentation and technical data delivered to U.S. Government customers are "commercial computer software" or "commercial technical data" pursuant to the applicable Federal Acquisition Regulation and agency-specific supplemental regulations. As such, use, duplication, disclosure, modification, and adaptation of the Programs, including documentation and technical data, shall be subject to the licensing restrictions set forth in the applicable Oracle license agreement, and, to the extent applicable, the additional rights set forth in FAR 52.227-19, Commercial Computer Software--Restricted Rights (June 1987). Oracle USA, Inc., 500 Oracle Parkway, Redwood City, CA 94065.

The Programs are not intended for use in any nuclear, aviation, mass transit, medical, or other inherently dangerous applications. It shall be the licensee’s responsibility to take all appropriate fail-safe, backup, redundancy and other measures to ensure the safe use of such applications if the Programs are used for such purposes, and we disclaim liability for any damages caused by such use of the Programs.

Oracle and Agile are registered trademarks of Oracle Corporation and/or its affiliates. Other names may be trademarks of their respective owners.

The Programs may provide links to Web sites and access to content, products, and services from third parties. Oracle is not responsible for the availability of, or any content provided on, third-party Web sites. You bear all risks associated with the use of such content. If you choose to purchase any products or services from a third party, the relationship is directly between you and the third party. Oracle is not responsible for: (a) the quality of third-party products or services; or (b) fulfilling any of the terms of the agreement with the third party, including delivery of products or services and warranty obligations related to purchased products or services. Oracle is not responsible for any loss or damage of any sort that you may incur from dealing with any third party.

September 12, 2007
## REVISIONS

<table>
<thead>
<tr>
<th>Revision</th>
<th>Date</th>
<th>Pages Affected</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>5/12/06</td>
<td>All</td>
<td>Initial release of manual.</td>
</tr>
<tr>
<td>B</td>
<td>6/11/06</td>
<td>7-6 – 7-9</td>
<td>Updated section on configuring Apache Web Server as a proxy server for Agile PLM.</td>
</tr>
<tr>
<td>C</td>
<td>6/20/06</td>
<td>4-2</td>
<td>Added section called “Choosing Which Oracle Application Server Components to Install”. Also removed the table of OAS installation steps.</td>
</tr>
<tr>
<td>D</td>
<td>6/23/06</td>
<td>7-6</td>
<td>Added steps about editing workers.properties.</td>
</tr>
<tr>
<td>E</td>
<td>6/29/06</td>
<td>4-2, 5-8 – 5-9, 11-1</td>
<td>Updated section called “Choosing Which Oracle Application Server Components to Install”; updated section called “Fixing Agile PLM Client Synchronization Problems and JMS Configuration”; changed JRE 1.5.0 to JRE 5.0.</td>
</tr>
<tr>
<td>F</td>
<td>7/17/06</td>
<td>8-2</td>
<td>Changed caching view server description.</td>
</tr>
<tr>
<td>G</td>
<td>7/24/06</td>
<td>2-3</td>
<td>Added note to “Starting the Agile PLM Installer”.</td>
</tr>
<tr>
<td>H</td>
<td>8/18/06</td>
<td>3-3</td>
<td>Changed book title reference for upgrading the database.</td>
</tr>
<tr>
<td>I</td>
<td>9/21/06</td>
<td>Chapters 2 and 3</td>
<td>Moved Upgrading chapter before Installing chapter.</td>
</tr>
</tbody>
</table>
CONTENTS

Preface
   Agile PLM Documentation ................................................................. xi
   Readme ................................................................. xi
   Agile Training ................................................................. xi
   Developer Documentation and Samples .............................................. xi

Chapter 1  Installation Checklists
   Pre-Installation Checklist .............................................................. 1-2
   Application Server Installation Checklist ........................................... 1-2
   Clustered Application Server Installation Checklist ............................ 1-3
   File Manager Installation Checklist ................................................. 1-4
   Web Proxy Server Installation Checklist .......................................... 1-5
   View Server Installation Checklist .................................................. 1-5
   Product Interchange Installation Checklist ....................................... 1-5

Chapter 2  Upgrading to Agile PLM 9.2.1
   Overview .............................................................................. 2-1
   Upgrading Agile Server Components .............................................. 2-1
   System Requirements for Upgrading ................................................. 2-2
   Checking Available Disk Space and Tablespace Size ........................... 2-2
   Backing Up Files ..................................................................... 2-2
   Disabling Windows Services ......................................................... 2-2
   Backing Up the Windows Registry ................................................. 2-2
   Upgrading the Database ................................................................... 2-3
   Upgrading the Agile PLM 9.2.1 Application ..................................... 2-3
   Upgrading the File Vault .................................................................. 2-3
   Upgrading the Agile Viewer .......................................................... 2-4
   Upgrading the Agile PLM ActiveX Control ..................................... 2-4
   Upgrading Roles and Privilege Masks ............................................. 2-4

Chapter 3  Installing Agile PLM
   Installation Process ........................................................................ 3-1
   Agile PLM System Requirements ................................................... 3-2
   Copying the Agile PLM CDs .......................................................... 3-2
   Copying Agile View Server and Oracle Application Server CDs .......... 3-2
   Starting the Agile PLM Installer .................................................... 3-3
   Installer Online Help .................................................................... 3-4
   Installer Buttons ........................................................................ 3-4
   Agile PLM Components ................................................................... 3-4
   Agile PLM Installation Folders ....................................................... 3-5
   Agile PLM Windows Services ....................................................... 3-5
   Agile PLM LDAP Authentication .................................................... 3-5

Chapter 4  Configuring the Agile Application Server
   Overview .............................................................................. 4-1
**Chapter 10 Configuring Agile Product Interchange**

Overview ................................................................. 10-1
   Requirements .................................................. 10-1
   Configuring the Apache Tomcat Service .................. 10-2
   Testing the Installation ...................................... 10-3
   Using the Agile Product Interchange Dataload Utility ...... 10-3
      Unpacking and Configuring the Agile Product Interchange Dataload Utility 10-3
      Data File Formats ......................................... 10-3
         Internal Manufacturer Alias Format .................. 10-3
         External Manufacturer Alias Format .................. 10-4
         Manufacturer Part Number Alias Format ............ 10-4
         Manufacturer Code Format ............................. 10-4
         Commodity Code Format ................................ 10-5
         Loading Manufacturer Aliases .......................... 10-5
         Loading Manufacturer Part Number Aliases .......... 10-6
         Loading Manufacturer Codes ............................ 10-6
         Loading Commodity Codes ............................... 10-7
         Getting Aliases for Manufacturers and Manufacturer Parts 10-7

**Chapter 11 Installing and Configuring Agile Java Client**

Agile Java Client Requirements .................................. 11-1
   Installing the Agile Java Client ........................... 11-1
   Running Agile Java Client 9.0 and Agile Java Client 9.2.1 on the Same Computer 11-2
   Reconfiguring Java Client JNLP Files ........................ 11-2

**Appendix A Agile PLM Installer Panels**

Common Agile PLM Installer Panels .............................. A-1
   Database Server Panels ................................... A-2
   Application Server Panels ................................. A-3
   Web Server Panels ......................................... A-5
   View Server Panels ........................................ A-6
   File Manager Panels ....................................... A-6
   Directory Server Panels ................................. A-7
   Product InterChange Panels .............................. A-8

**Appendix B Agile Application Server Scripts**

Installation and Configuration Scripts ........................ B-1
   Application Scripts ...................................... B-2
# Contents

## Appendix C  Agile e5.1 Integration
- Overview ................................................................................. C-1
- Configuring Agile PLM ............................................................. C-1
- Configuring Agile e5.1 ............................................................... C-2

## Appendix D  Agile System Maintenance
- Using the Server as a Client .................................................... D-1
- Performance Tuning ................................................................. D-1
  - Tuning JVM Parameters ......................................................... D-1
  - Tuning Oracle HTTP Server .................................................. D-2
- Configuring Database Access using Agile Administrative Settings .................................................................. D-3
- Configuring Your Firewall ....................................................... D-3
- Restarting Windows Servers Periodically ................................ D-3
- Color Settings .......................................................................... D-4
- Dynamic Versus Static IP Addresses ....................................... D-4
- Checking Your TCP/IP Connection .......................................... D-4
- Configuring Browsers on Client Computers ......................... D-4
- Uninstalling Agile PLM ......................................................... D-4

## Appendix E  Tuning Memory for Java Applets
- Tuning Memory for Java Applets ............................................. E-1
- Java Control Panel ................................................................. E-2
- Frequently Asked Questions .................................................. E-2

# Index
The Agile documentation set includes Adobe® Acrobat™ PDF files. The Oracle Technology Network (OTN) Web site contains the latest versions of the Oracle|Agile PLM PDF files. You can view or download these manuals from the Web site, or you can ask your Agile administrator if there is an Oracle|Agile Documentation folder available on your network from which you can access the Oracle|Agile documentation (PDF) files.

To read the PDF files, you must use the free Adobe Acrobat Reader™ version 7.0 or later. This program can be downloaded from the www.adobe.com.

The Oracle Technology Network (OTN) Web site can be accessed through Help > Manuals in both the Agile Web Client and the Agile Java Client. If applicable, earlier versions of Oracle|Agile PLM documentation can be found on the www.agile.com/support.

If you need additional assistance or information, please contact support@agile.com or phone (408) 284-3900 for assistance.

Before calling Agile Support about a problem with an Oracle|Agile PLM manual, please have ready the full part number, which is located on the title page.

Readme

Any last-minute information about Oracle|Agile PLM can be found in the Readme file on the Oracle Technology Network (OTN) Web site.

Agile Training Aids

Go to the Agile Training Web page for more information on Agile Training offerings.
This chapter provides checklists for installing Agile PLM components. It includes the following information:

- Pre-Installation Checklist
- Application Server Installation Checklist
- Clustered Application Server Installation Checklist
- File Manager Installation Checklist
- Web Proxy Server Installation Checklist
- View Server Installation Checklist
- Product Interchange Installation Checklist
Pre-Installation Checklist

Before installing the Agile PLM software, you need to log in to your machine with local Administrator privileges and check the following:

- Can you ping all servers, including the database server, on which you plan to install Agile PLM components? For example, try pinging the database server from the application server.

- Have you verified the Domain Name System (DNS) host name of each server on which you plan to install Agile PLM components? In DNS, the fully qualified domain name consists of the hostname, then a period, then the domain name.
  
  **Note** When you are prompted by the Agile PLM installer to enter a host name, enter the fully qualified domain name of the server.

- If you are installing an application server cluster, have you ensured that all application servers and the load balancer are registered in the same domain?
  
  **Note** You cannot distribute Agile PLM application servers across multiple domains.

- Is your Agile PLM database server installed and running on a separate machine?

- Is Oracle Application Server 10g (10.1.2.0.2) installed or have you copied the CDs onto the machine where you are installing the Agile Application Server?

- If you are using LDAP-based authentication for Agile PLM, is your Directory Server installed?

- Have you verified that you have read, write, and execute permissions for the computer on which you want to install Agile PLM?
  
  Additionally, if you are upgrading:

- Have you backed up the files on your File Manager server?

- Have you uninstalled the previous version of Agile?

  **Note** You must be able to complete this checklist before installing Agile PLM.

Application Server Installation Checklist

Follow these steps to install the Agile Application Server:

1. Install Oracle Application Server 10g (10.1.2.0.2) J2EE and Web Cache.
   
   See “Installing Oracle Application Server” on page 4-2.

2. Stop the Oracle Application Server.
   
   See “Stopping Oracle Application Server” on page 4-3.

3. Install the Agile PLM **Application Server** component.
   
   See Chapter 3, “Installing Agile PLM.”

   **Note** The Agile PLM installer may prompt for you to stop Oracle Application Server even though it is already stopped. If so, click **OK** to continue.

4. On Windows: Restart the server.
## Clustered Application Server Installation Checklist

Follow these steps to install an Agile Application Server cluster:

1. Install Oracle Application Server 10g (10.1.2.0.2) J2EE and Web Cache on each server.
   - **Important** Make sure all servers in the cluster use a like operating system.
   - See “About Agile Application Server Clusters” on page 5-1 and “Installing Oracle Application Server” on page 4-2.

2. Stop Oracle Application Server on each machine in the cluster.
   - See “Stopping Oracle Application Server” on page 4-3.

3. Install the Agile PLM **Application Server** component on the repository host server.
   - See Chapter 3, “Installing Agile PLM.”
   - **Note** The Agile PLM installer may prompt for you to stop Oracle Application Server even though it is already stopped. If so, click **OK** to continue.
   - **Important** During the installation, the repository host ID is displayed. Write it down. You will need to provide the repository host ID during the installation of the non-repository host servers in the cluster.

4. Configure the cluster on the repository host.
   - See “Configuring the Repository Host Server” on page 5-2.

5. Install the Agile PLM **Application Server** component on the non-repository host servers.
   - See Chapter 3, “Installing Agile PLM.”
   - **Important** The Agile PLM installation location (also called the Agile Home) you specify on non-repository host servers must be identical to the Agile Home on the repository host server.

6. Configure the cluster on each non-repository host.
   - See “Configuring Non-Repository Host Servers” on page 5-3.

7. Enable HTTP session replication for the cluster.
   - See “Enabling HTTP Session Replication” on page 5-4.

8. Deploy the Agile application on the repository host server.
   - See “Deploying the Agile Application” on page 5-4.
Follow these steps to install the File Manager:

1. If you are upgrading to Agile PLM 9.2.1 from a release prior to Agile 9, back up and reorganize your file vault.
   See “Upgrading the File Vault” on page 2-3.

2. Install the Agile PLM File Manager component.
   See Chapter 3, “Installing Agile PLM.”

3. Start the Agile Application Server.

   See Chapter 7, “Configuring a Web Proxy Server for Agile PLM.”

5. Configure the File Manager.
   See “Configuring the File Manager” on page 6-4.

6. Start the File Manager.
   See “Starting the File Manager” on page 6-7.

7. Verify that the File Manager is working properly.
   See “Validating the File Manager Installation” on page 6-8.
Web Proxy Server Installation Checklist

Follow these steps to configure a Web proxy server in your company’s DMZ for the Agile Application Server and Agile File Manager:

☐ 1 Stop your Web server.
☐ 2 Install the Agile PLM Web Proxies component.
   See Chapter 3, “Installing Agile PLM.”
☐ 3 Configure your Web server to be a proxy server for either the Agile Application Server, the Agile File Manager, or both.
   See Chapter 7, “Configuring a Web Proxy Server for Agile PLM.”
☐ 4 Test the connection by logging into the Agile Web Client.
   See “Logging In to the Agile Web Client” on page 7-9.

View Server Installation Checklist

Follow these steps to install the File Manager:

☐ 1 Verify the firewall configuration of your network.
   See “Verifying the Firewall Configuration” on page 8-3.
☐ 2 Install the Agile PLM View Server component.
   See Chapter 3, “Installing Agile PLM.”
☐ 3 Start the View Server.
   See “Starting the View Server” on page 8-3
☐ 4 Test the Agile View servlet to make sure it works. The Agile Web Client uses the Agile View servlet to connect to the View Server.
   See “Testing the VueServlet” on page 8-4.

Product Interchange Installation Checklist

Follow these steps to install Agile Product Interchange:

☐ 1 Install the Agile Product Interchange database.
   See the Agile PLM Database Installation Guide.
☐ 2 Install the Agile Product Interchange application.
   See Chapter 3, “Installing Agile PLM.”
☐ 3 Configure the Apache Tomcat service.
   See “Configuring the Apache Tomcat Service” on page 10-2.
☐ 4 Test the installation by going to the Agile Product Interchange URL.
   See “Testing the Installation” on page 10-3.
☐ 5 Use the Agile Product Interchange Dataload utility to load customer data for manufacturer aliases, part aliases, and commodity codes.
   See “Using the Agile Product Interchange Dataload Utility” on page 10-3.
CHAPTER 2

Upgrading to Agile PLM 9.2.1

This chapter describes the process for upgrading to Agile PLM 9.2.1. The upgrade should occur in the order it is presented in this chapter:

- Overview
- Disabling Windows Services
- Backing Up the Windows Registry
- Upgrading the Database
- Upgrading the Agile PLM 9.2.1 Application
- Upgrading the File Vault
- Upgrading the Agile Viewer
- Upgrading the Agile PLM ActiveX Control
- Upgrading Roles and Privilege Masks

Overview

Agile PLM can be distributed over a wide-area network with multiple servers, or it can be limited to a single server with several client computers.

Important Before upgrading to Agile PLM 9.2.1, read through this entire chapter and the Readme for the latest information. For information about optional upgrade services available from Agile, contact Agile Technical Support.

Note All folder names and paths show the default settings provided during installation. Your system structure may be different if folder names or paths were changed during the Agile PLM 9.2.1 installation.

Upgrading Agile Server Components

Before you upgrade any components, you should make sure that all components in the Agile system work and communicate properly. Performing an upgrade on a system that is not functioning correctly will compound troubleshooting techniques.

Important Refer to the Agile PLM Database Upgrade Guide for schema upgrade requirements.
System Requirements for Upgrading

Additional hard disk space may be required for upgrading to Agile PLM 9.2.1 and your Agile PLM database efficiently. Before you can install Agile PLM server components, you must have at least 60 MB of available disk space available where the OS is installed. It is also recommended that you have at least 100 MB of available disk space for the upgrade.

Checking Available Disk Space and Tablespace Size

Be sure you have enough unused disk space available on the computer where the database is installed before upgrading—at least 100 MB plus an amount equal to 100 percent of your current database and at least twice the size of your user-data tablespace.

Important Refer to the Agile Database Installation Guide for tablespace requirements.

Backing Up Files

Note Agile PLM 9.2.1 installs into a new default location. If you accept this location, earlier Agile releases will not be overwritten.

Back up any existing ChangeCAST and other Agile-related folders to a safe location before upgrading any component to Agile PLM 9.2.1.

Disabling Windows Services

Before upgrading Agile on Windows servers, disable any Agile services.

To disable Agile services:

1 Ensure that all Agile services are stopped:
   a Choose Start > Settings > Control Panel.
   b Double-click the Administrative Tools icon and then double-click the Services icon.
   c For each Agile service in the Services dialog box, select the service, right-click and choose Stop in the shortcut menu. Also for each service, open the Properties dialog box and change the Startup Type to Disabled.
   d You must also stop the IIS Admin service if it is running.
   e Close the Services dialog box.

2 Restart all Windows servers in the Agile PLM system.

Backing Up the Windows Registry

If you are upgrading Agile on Windows servers, the registry contains information created by the Agile installation program. You can backup registry branches so that you can return your system to its previous state.

Note If you have disk space available, you can backup the entire registry (instead of specific branches) before upgrading to Agile PLM 9.2.1.

To use regedit to backup registry branches:

1 Choose Start > Run.

2 Type regedit in the Open field of the Run dialog box.

   The Registry window opens.

3 Expand the HKEY_LOCAL_MACHINE > Software tree and select the Agile registry branch.

4 Choose Registry > Export Registry File.
The Export Registry File dialog box appears.

5 Make sure the Agile branch appears in the Select Branch field.

6 Name the branch agilebranch, and save it to a secure location.

7 Select the Oracle registry branch and save it as oraclebranch to a secure location.

In the event you do not want to continue using this release of Agile PLM 9.2.1, you can import these registry branches, and then restart the computer.

**Upgrading the Database**

The Agile database must be upgraded before installing the Agile Application Server. Refer to the Agile PLM Database Upgrade Guide for details about upgrading the Agile PLM 9.2.1 database.

**Upgrading the Agile PLM 9.2.1 Application**

After upgrading to the Agile PLM 9.2.1 database, you should uninstall the previous version of Agile before installing Agile PLM 9.2.1.

**Important** Do not install into the same folder used by the previous implementation of Agile. Choose a new installation location.

**Upgrading the File Vault**

In Agile PLM 9.2.1, the file vault has been redesigned. In previous versions of Agile, files were stored in the <iFS Root> or files directory. In the new design, files are stored in separate directories based on a file ID. All existing files must be reorganized to conform to the new design specifications. If you have an existing distributed iFS or distributed file manager (DFM) configuration, you must reorganize the files on each file server.

**To reorganize existing files:**

1 Back up any existing Agile iFS folders to a safe location before upgrading any component to Agile PLM 9.2.1. The default location for Agile iFS Files in Agile 8.5 is \Program Files\Agile Product Collaboration\iFS\Files.

   If you have an existing distributed configuration, you must also back up the files on all the secondary file servers.

2 After you have copied all files into a backup directory, install the new File Manager by following the instructions in “Starting the Agile PLM Installer” on page 3-3, if it is not already installed.

3 Copy any iFS files that you backed up into the File Manager Storage Location you specified during the file manager installation.

4 Go to the <agile_home>\agileDomain\tools\ directory.

5 Run the iFSReorgV2.jar file:

   Usage: java -jar iFSReorgV2.jar -basedir <value> -oldFilePrefix <value> [-newFilePrefix <value>] [-logging <true/false>]

   where

   • basedir is the file vault location to be reorganized
   • oldFilePrefix is the old file name prefix for the existing files in the vault
   • newFilePrefix is the new file name prefix. All of the existing files will be renamed with this prefix. This is an optional argument. If it is not specified, the old file name prefix is used.
   • logging enables logging of warnings or errors if set to true. The log is saved to a file named ifsReorg.log.

6 After the program completes, the reorganization information displays.
Go to “Configuring the File Manager” on page 6-1 to configure the new file manager with the upgraded vault information and to validate the installation was successful.

Upgrading the Agile Viewer

Before upgrading to the latest Agile Viewer, backup all of the .ini files from the \bin\Profiles directory of the existing Viewer installation. After installing the Agile PLM 9.2.1 Agile Viewer, copy the backed up .ini files to the new Viewer installation directory.

Upgrading the Agile PLM ActiveX Control

If you used the Microsoft Excel-based client to open Agile PLM 9.2 Declarations in Microsoft Excel, you have the Agile PLM ActiveX Control (version 1.0.313.1) installed on your client computer. Agile PLM 9.2.1 uses a later version (1.0313.8) of the Agile PLM ActiveX Control.

Optionally, you can uninstall the older Agile PLM ActiveX Control. If the Agile PLM preference **Allow Downloading of Productivity Components** is set to Yes, the next time you use the Agile Web Client to open a Declaration in Microsoft Excel, the latest version of the Agile PLM ActiveX Control will be downloaded and installed automatically.

Note Before uninstalling the Agile PLM ActiveX Control, close Microsoft Excel.

Upgrading Roles and Privilege Masks

When you upgrade your Agile PLM database, any existing Agile PLM roles and privilege masks that your company uses are not automatically updated to include new privileges and attributes. The Agile PLM administrator must update existing roles and privilege masks manually using the Agile Java Client.

Agile PLM includes a number of example roles that you can use to modify your own roles. They are stored under the Examples node folder in Java Client. Example roles are read-only and cannot be modified. However, you can use Save As to make a copy of an example role and modify the copy.

Example roles include example privilege masks. When you use Save As to create a copy of an example role, the system populates the new role with the privilege masks.

For more information on how to edit roles and privilege masks, see the *Agile PLM Administrator Guide*. 
CHAPTER 3
Installing Agile PLM

This chapter describes the Agile PLM components you need to install, possible deployment choices, and system requirements or recommendations. It includes the following information:

- Installation Process
- Agile PLM System Requirements
- Copying the Agile PLM CDs
- Starting the Agile PLM Installer
- Agile PLM Components
- Agile PLM Installation Folders
- Agile PLM Windows Services
- Agile PLM LDAP Authentication

**Installation Process**

Agile PLM is designed to run optimally on multiple computers. This guide is presented with separate chapters for certain Agile PLM components. To set up an Agile PLM system, you should install the components in the following order:

Refer to the *Agile PLM Database Installation Guide*.

This applies to both a standalone application server or application server clusters.
Important If you are upgrading from a previous version of Agile PLM, first read Chapter 2, “Upgrading to Agile PLM 9.2.1.”

**Agile PLM System Requirements**

Depending on the size and type of network system in each site, Agile PLM may be deployed in different configurations. The amount of time required to complete an installation depends on the complexity of your Agile PLM implementation.

**Note** If you are installing on Windows, make sure you have installed all Windows updates, especially for the DirectX component.

For installations using a certified localized language, all server components must be installed on computers running the same localized OS. Clients can be running on the same localized OS or English OS. For detailed information about using Agile PLM with international operating systems, contact the Agile Support Web site.

The general recommended configuration for Agile PLM components is one computer for each of the following server components:
- Agile database
- Agile Application Server
- Agile View Server

It is acceptable to install multiple server components on the same computer if the additional resources are not available. However, the minimum hardware requirements must be increased based on the number of server components installed on a single computer. For specific hardware and software requirements, see the *Capacity Planning and Deployment Guide.*

Network service and TCP/IP protocol must be enabled before you install Agile PLM.

On Windows, if you receive the error message “Failed to retrieve domain name from registry. Please enter the domain name in the TCP/IP properties and try again later” and the installation aborts, then you must setup Network service, as follows:

1. From the Control Panel window, double-click the Network and Dial-up icon.
2. Right-click on the Local Area Connection icon and choose Enable from the shortcut menu.

**Copying the Agile PLM CDs**

Before installing Agile PLM, the contents of both CDs should be copied to a local directory with the same file structure as the original CDs. The Platforms directory on CD #2 must be copied to the same directory level as the setup file.

**Note** Be sure to check the size of the directory after copying the CD to verify that all files have been copied.

**Copying Agile View Server and Oracle Application Server CDs**

If you purchased Agile View Server and Oracle Application Server 10g Release 2 from Agile, you should have received separate CDs for them. You can copy the CDs to a local drive or a network location that you’ve mounted, or you can use the CDs to install them.

Follow these guidelines to install Agile View Server and Oracle Application Server:

- You must install Agile View Server by running the Agile PLM installer and specifying the path to the View Server CD (or the location where you’ve copied the CD) when you are prompted. The Agile PLM installer configures Agile View Server specifically for Agile PLM. Do not install Agile View Server by running its setup program outside of the Agile PLM installer.
You can install Oracle Application Server by running its setup program located on its CD, or by running the Agile PLM installer and specifying the path to the Oracle Application Server CD (or the location where you’ve copied the CD) when you are prompted. For more information, see “Installing Oracle Application Server” on page 4-2.

Important On Solaris and Linux, you must have Execute permission to the Oracle Application Server setup program. On Solaris, you must also have Execute permission to the Agile View Server. Otherwise, the Agile PLM installer will not be able to run them.

Starting the Agile PLM Installer

Important Install and test this release on a designated development server before installing it on your production environment. Your development environment should mirror your production environment as closely as possible to provide accurate testing results. It is important to validate the installation of this release and confirm your integrations are working correctly as part of your minimum due diligence. Any problems or questions noted during your development system testing should be resolved before installing this release on your production environment.

The Agile PLM installer is a Java program. The installation of all components follows the same initial process up through the panel where you select the components to install.

Before running the installer, make sure

- **On Solaris or Linux:** You are not logged in as the root user.
- You have read and completed the pre-installation checklist. You should also read and follow the installation checklist for each Agile PLM component you plan to install. See Chapter 1, “Installation Checklists.”
- You have enough available disk space.
  - Windows: at least 500Mb of available disk space
  - Solaris or Linux: at least 1700Mb of available disk space on the drive where your default Temp directory is located.
- You have disabled virus protection.
  - If virus protection is enabled, components used in the installer can be falsely identified as being infected and lock up the installation. You can turn the virus protection on after the installation is complete.

To start the Agile PLM installer on Windows:

1. Log in to the computer using a login with local Administrator permissions.
2. In the Disk1\Windows directory, double-click the setup.exe file.
   - Note If there is insufficient disk space available to complete the installation, you will be prompted for another location. Click Choose, select another drive, click OK, and the installer will start.
3. After a few moments, the Welcome screen appears.
4. For information about any screen in the installer, click Help.

To start the Agile PLM installer on Solaris or Linux:

1. Log into the system.
   - Note If you are installing the Agile Application Server, make sure you log in as the same user that installed Oracle Application Server.
2. Open a terminal window.
3. Go to the directory where you copied the Agile PLM CDs. Locate the setup.bin file, and run the program by typing the following:
   
   ./setup.bin
After a few moments, the Welcome screen appears.

4 For information about any screen in the installer, click Help.

**Installer Online Help**

Each installation panel has online help. At any time during installation, you can click Help for more information about the panel’s options.

*Note* If you leave the online help window open, it will be updated when you proceed through the installer panels. Otherwise, click Close at the bottom of the help window.

**Installer Buttons**

Agile PLM installation panels have the following buttons:

- **Cancel** — Exits from the installation program.
- **Help** — Displays online help.
- **Previous** — Returns to the previous step.
- **Next** — Proceeds to the next step.
- **Install** — Starts installing. The Install button appears only on the Pre-Installation Summary panel, after you have specified installation options.
- **Done** — Exits from the installation program. On Windows, after installing certain components you can choose whether to restart the computer when you click Done. The Done button appears only on the Install Complete panel, after you have finished installing.

**Agile PLM Components**

During Agile PLM installation, you must select components to install. The list of components you can install is based on your license key. Choose from the following components.

Table 3-1: Agile PLM components

<table>
<thead>
<tr>
<th>Component</th>
<th>Platform</th>
<th>Installation/Configuration Documentation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database Server &gt; Agile PLM</td>
<td>Windows/Solaris/Linux</td>
<td>Agile PLM Database Installation Guide</td>
</tr>
<tr>
<td>Database Server &gt; Product Interchange</td>
<td>Windows/Solaris/Linux</td>
<td>Agile PLM Database Installation Guide</td>
</tr>
<tr>
<td>Application Server</td>
<td>Windows/Solaris/Linux</td>
<td>Chapter 4, “Configuring the Agile Application Server” and Chapter 5, “Configuring Application Server Clusters”</td>
</tr>
<tr>
<td>File Manager</td>
<td>Windows/Solaris/Linux</td>
<td>Chapter 6, “Configuring the File Manager”</td>
</tr>
<tr>
<td>Web Proxies</td>
<td>Windows/Solaris/Linux</td>
<td>Chapter 7, “Configuring a Web Proxy Server for Agile PLM”</td>
</tr>
<tr>
<td>Product InterChange</td>
<td>Windows</td>
<td>Chapter 10, “Configuring Agile Product Interchange”</td>
</tr>
</tbody>
</table>
| View Server                | Windows/Solaris  | Chapter 8, “Configuring Agile View Server”
*Note*: When you install View Server, the latest service pack is also installed. After the service pack is installed, a Web page appears that instructs you to manually copy files after installation. Ignore that instruction. You don’t need to manually copy any View Server files.

| ChangeCAST Client          | Windows          | See online help for the Agile PLM installer.                                                               |
| Portlet Services           | Windows/Solaris  | See the separate Agile Portlet Services Installation and Configuration Guide.                             |
| API                        | Windows/Solaris/Linux | See online help for the Agile PLM installer.                                                               |

*Note* If any of these components do not appear, your license key was not authorized for the component.
Agile PLM Installation Folders

After you install Agile PLM, the following folders appear in the `<agile_home>` folder.

**Note** This list includes the folders for all Agile PLM components, although it is not recommended that you install them all on one computer.

Table 3-2: Agile PLM installation folders

<table>
<thead>
<tr>
<th>Folder</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>agileDomain</td>
<td>Agile Application Server</td>
</tr>
<tr>
<td>AgilePI</td>
<td>Agile Product Interchange</td>
</tr>
<tr>
<td>AgileProxies</td>
<td>Web proxy configuration files</td>
</tr>
<tr>
<td>AVS</td>
<td>Agile View Server</td>
</tr>
<tr>
<td>changecast</td>
<td>ChangeCAST client</td>
</tr>
<tr>
<td>install</td>
<td>Installation and configuration scripts</td>
</tr>
<tr>
<td>integration</td>
<td>Agile Integration Framework (AIF) products such as Agile Integration Services (AIS) and Agile SDK</td>
</tr>
<tr>
<td>jdk</td>
<td>Java Development Kit 1.4.2</td>
</tr>
<tr>
<td>Portlet_50</td>
<td>Agile Portlet Services for WebSphere Portal 5.0.2</td>
</tr>
<tr>
<td>Portlet_51</td>
<td>Agile Portlet Services for WebSphere Portal 5.1.0.2</td>
</tr>
<tr>
<td>Tomcat</td>
<td>Tomcat 5.03</td>
</tr>
<tr>
<td>Uninstaller</td>
<td>Agile PLM uninstaller</td>
</tr>
</tbody>
</table>

Agile PLM Windows Services

After you install Agile PLM on Oracle Application Server for Windows, the following Windows services are added to your system:

Table 3-3: Agile PLM Windows services

<table>
<thead>
<tr>
<th>Service</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agile ChangeCAST</td>
<td>Agile ChangeCAST service</td>
</tr>
<tr>
<td>Agile View Server</td>
<td>Agile View Server service</td>
</tr>
<tr>
<td>Apache Tomcat</td>
<td>Apache Tomcat service. Start this service to also start Agile File Manager.</td>
</tr>
<tr>
<td>Oracle&lt;instance_name&gt;ASControl</td>
<td>Oracle Application Server Control Console service</td>
</tr>
<tr>
<td>Oracle&lt;instance_name&gt;ProcessManager</td>
<td>Oracle Process Manager service. Start this service to start all Oracle Application Server managed processes, including the Agile Application Server.</td>
</tr>
</tbody>
</table>

Agile PLM LDAP Authentication


After installation is complete, you must use the Agile Java Client to configure the directory server for Agile PLM. For instructions on how to configure the directory server, see the *Agile PLM Administrator Guide*. 
CHAPTER 4
Configuring the Agile Application Server

This chapter describes how to configure the Agile Application Server. It includes the following information:

- Overview
- Copying the Oracle Application Server CD to the Solaris or Linux Server
- Installing Oracle Application Server
- Stopping Oracle Application Server
- Deploying the Agile Application
- Verifying Your Agile Application Server

Important When you install and configure the Agile Application Server, follow the sequence recommended in “Application Server Installation Checklist” on page 1-2.

Overview

The Agile Application Server is the center of the Agile system, the base for the PLM platform, where all common services and business logic reside for the entire solution. The installation of the Agile Application Server includes the Agile Content Service.

The Agile Application Server runs on Oracle Application Server 10g or BEA WebLogic Server. All client servers and users connect to the Application Server either directly or indirectly through a Web proxy server.

Note If you are configuring an application server cluster, go to Chapter 5, “Configuring Application Server Clusters” for configuration instructions.

Copying the Oracle Application Server CD to the Solaris or Linux Server

To simplify the Oracle Application Server installation, you can copy the data from the installation CD onto the Solaris or Linux server. For Solaris and Linux, Oracle Application Server 10g Release 2 (10.1.2.0.2) has one CD.

To copy the Oracle Application Server software onto the Solaris or Linux server:

1. Log in as the user who will own and administer the Agile PLM deployment (for example, the Unix user “agile”).
2. Create a directory on your hard drive called OracleAS_10g where you will copy the Oracle Application Server disk. Under the parent directory, create a subdirectory called Disk1.

   $ mkdir /opt/agile/OracleAS_10g/Disk1

Note This step assumes you have created the user agile with the home directory /opt/agile.
Copy the contents of the CD-ROM into the corresponding directory:

```
$ cp -pr /<cdrom_mount_point>/10.1.2disk1/* /opt/agile/OracleAS_10g/Disk1/
```

Continue installing Oracle Application Server.

**Installing Oracle Application Server**

This section provides basic steps for installing Oracle Application Server 10g Release 2 (10.1.2.0.2) J2EE and Web Cache. Please see the complete Oracle Application Server installation documentation from Oracle before installing the server.

**Note**  
If you obtained Oracle Application Server CDs from Agile, you can install the server from the Agile PLM installation program. When you are prompted, specify the Oracle Application Server installation location. The Agile PLM installation program then installs Oracle Application Server in silent mode.

For an Oracle Application Server cluster, make sure you install Oracle Application Server into the same directory structure on each server in the cluster. Also, all servers in the cluster must use a like operating system. Otherwise, you will be unable to deploy the Agile application to all servers in the cluster.

**To install Oracle Application Server 10g Release 2 (10.1.2.0.2) on Windows:**

1. Log in to the computer as a user who is a member of the Administrators group.
2. Insert Oracle Application Server disk 1 or the Oracle Application Server DVD-ROM.
   
   If your computer supports the auto run feature, the installer launches automatically.
3. If your computer does not support the auto run feature, double-click the `setup.exe` file. If you are installing from DVD-ROM, the `setup.exe` file is located in the `application_server` directory.

   This launches Oracle Universal Installer.

**To install Oracle Application Server 10g Release 2 (10.1.2.0.2) on Solaris or Linux:**

1. Log in as the user who will own and administer the Agile deployment (for example, the Unix user “agile”).
2. Copy the Oracle Application Server CD to your hard drive. See “Copying the Oracle Application Server CD to the Solaris or Linux Server” on page 4-1.
3. Start the installer:
   
   `$ <installer_path>/Disk1/runInstaller`

   This launches Oracle Universal Installer.

**Choosing Oracle Application Server Components to Install**

When you install Oracle Application Server as a standalone server or as a cluster, choose the following components:

- Oracle HTTP Server
- OracleAS 10g Containers for J2EE

**Note**  
If you use the Oracle Universal Installer to install Oracle Application Server, the above two components are selected by default and cannot be deselected.

For more information, see the complete Oracle Application Server installation documentation from Oracle.

**What To Do Next**

Stop the Oracle Application Server. See the next section.
Stopping Oracle Application Server

Before installing Agile PLM, stop the Oracle Application Server Control Console and all Oracle Application Server applications.

*Note* The Oracle Application Server Control Console isn’t needed to install, deploy, or manage Agile PLM. To conserve memory on your server, you can keep the Oracle Application Server Control Console stopped and use `opmnctl` commands to manage Oracle Application Server processes instead.

On Windows, you can stop the Oracle Application Server Control service. The name of the service starts with “Oracle,” followed by the name of the Oracle Home, followed by the word “ASControl.” By default, the Application Server Control service starts automatically when the system starts.

To stop Oracle Application Server on Windows:

1. Open a Command Prompt window.
2. Stop the Oracle Application Server Control Console:
   ```bash
   \<oracle_home>\bin\emctl stop iasconsole
   ```
3. Stop the Oracle Application Server instance:
   ```bash
   \<oracle_home>\opmn\bin\opmnctl stopall
   ```

To stop Oracle Application Server on Solaris or Linux:

1. Open a terminal window and log on as the user who installed Oracle Application Server.
2. Stop the Oracle Application Server Control Console:
   ```bash
   /<oracle_home>/bin/emctl stop iasconsole
   ```
3. Stop the Oracle Application Server instance:
   ```bash
   /<oracle_home>/opmn/bin/opmnctl stopall
   ```

*What To Do Next*

Install the Agile Application Server. See Chapter 3, “Installing Agile PLM.”

Deploying the Agile Application

Install the Agile Application Server by starting the Agile PLM installer and following the instructions in online help. See Chapter 3, “Installing Agile PLM.”

After you install the Agile Application Server, you are ready to deploy the application.

*Note* For Solaris or Linux operating systems, substitute forward slashes for back slashes in the steps below.

To deploy the Agile application:

1. Windows: Open a Command Prompt window.
   Solaris or Linux: Open a terminal window and log on as the user who installed Oracle Application Server.
2. Restart the Oracle Application Server instance:
   ```bash
   \<oracle_home>\opmn\bin\opmnctl stopall
   \<oracle_home>\opmn\bin\opmnctl startall
   ```
3. Check the status of the Oracle Application Server instance:
   ```bash
   \<oracle_home>\opmn\bin\opmnctl status
   ```
4. Deploy the Agile application:
   Windows: `\<agile_home>\agileDomain\bin\DeployAgile.cmd`
Solaris or Linux: `/<agile_home>/agileDomain/bin/DeployAgile.sh`

When deployment is finished, the script prompts that the Agile application has been deployed.

5 Verify that the Agile application is deployed:

`<oracle_home>\dcm\bin\dcmctl listapplications`

If Agile is listed, you can log in to the application server.

**What To Do Next**

Verify your Agile Application Server. See the next section.

**Verifying Your Agile Application Server**

Once the Agile application is deployed, you should verify that the system works before installing other Agile PLM components. The simplest test is to log into Agile Web Client.

Before using Agile Integration Framework (AIF) products such as Agile Integration Services (AIS) or the Agile SDK, you must ensure that the system is properly configured. This involves checking whether Web services and Agile SDK clients can connect successfully to the Agile Application Server. You must also make sure that HTTP ports are configured correctly on your server.

For more information about using AIS and the Agile SDK to develop custom solutions for Agile PLM, see the separate *Agile Integration Services Developer Guide* and the *Agile SDK Developer Guide*, respectively.

**Verifying the Agile Application Server Login**

After you deploy the Agile application, test whether you can log in.

**To start the Agile Application Server and test logging in:**

1 Open a Web browser.
2 Test the login using the following URL:

   `http://<hostname>.<domain>:<port>/<appserver_virtual_path>/PLMServlet`

For example, the URL might look something like this:

   `http://plmserver.yourcompany.com:7777/Agile/PLMServlet`

**Note** The URL is case-sensitive.

**Important** It is important that you do NOT provide users with this URL. The port you specified during the Application Server installation is not standard and should not be used by external or remote Agile Web clients. This URL is a direct connection to the Application Server, and it should be used only for testing and troubleshooting purposes.

A login window appears.
3 If you have not added Agile PLM users, type `admin` for the user and `agile` for the password.
Checking Whether Agile Web Services Work

Before trying to compile and run the sample AIS web service clients, or developing custom web service extensions to the Agile PLM system, make sure your server is working properly. First, try accessing the following URLs to see if they correctly return WSDL from the server.


All three URLs should return WSDL. If any do not, follow these instructions:

- If the first two URLs fail to return the WSDL, it may be because your server does not have the right xmlparserv2.jar file. This applies only if you are hosting Agile PLM on Oracle Application Server. Contact Agile Support to get an older version of the file xmlparserv2.jar. Place the xmlparserv2.jar file that you receive from Agile Support in the following location on the Agile Application Server:
  <drive>:\<oracle_home>\lib

- If the first two URLs fail to return the WSDL but the other URL works fine, then the server does not have the url-handlers.jar file available on the bootclasspath. Find the url-handlers.jar file that was installed in the Agile installation folder, and copy it to the appropriate jre/lib/ext directory for your application server (for example, /<oracle_home>/jdk/jre/lib/ext).

- If the third URL fails for any reason, there is something wrong with your web service installation. You may need to uninstall Agile PLM from the application server and reinstall it.

Checking Whether the Agile SDK Works

If you purchased a license to the Agile SDK, Agile PLM provides both server-side and client-side components that allow you to develop Java programs and web services that extend the functionality of Agile PLM and help you integrate it with other applications. Before beginning to develop Agile SDK programs, make sure your system is working properly. You should be able to establish a connection with the Agile Application Server or the Web proxy server used for the Agile PLM system. You should also be able to create an Agile PLM session and download classes from the server.

Checking Your Connection

To check your connection, access the following servlet URL that is installed with Agile PLM:

http://<servername>.<domain>[:<port>]/<appserver_virtualPath>/ServerAPIProperties

For example, the URL might look something like this:

http://plm.yourcompany.com/Agile/ServerAPIProperties

The servlet should return the following information:

- Minimum Agile API version needed to connect to the server
- Current Agile PLM server version
- Current Agile PLM release
- Agile PLM session class
- Agile PLM authenticator class
- Agile PLM application server type
- name/value pairs for environment variables
If the page cannot be found, you are unable to connect to the server. There are several possible causes for the problem:

- You typed the URL incorrectly.
- The server may be down temporarily.
- You may be experiencing problems with your network.

Whatever the cause, you must fix the problem before you can run an Agile SDK client. If you need help, contact your company's Help Desk or your Agile PLM administrator.

**Configuring HTTP Ports Correctly**

If you can connect to the server, but your Agile SDK program has trouble creating an Agile PLM session on Oracle Application Server (OAS), it could be because the server is incorrectly configured. For more information, see “Configuring Oracle HTTP Server” on page 4-7.

**Granting Write Permission to the AgileSDK.cache and sdk.extensions.lib Folders**

When you run an Agile SDK client program, it connects to the Agile Application Server and automatically downloads the classes it needs into a local cache folder named AgileSDK.cache. Similarly, when you run a process extension from one of the Agile PLM clients or invoke a web service extension, the server automatically copies any updated libraries into a folder named sdk.extensions.lib before loading them. On Windows, these folders are created automatically in the c:\Documents and Settings\<username> folder and there is never any need to modify them. However, on Unix-based operating systems such as Solaris and Linux, the system administrator must create the %tmp%AgileSDK.cache and %tmp%sdk.extensions.lib directories and grant users write access to them.

If you don’t have write access to the the %tmp%AgileSDK.cache and %tmp%sdk.extensions.lib directories, you won’t be able to run Agile SDK client programs, use process extensions from Agile PLM clients, or use Agile PLM web service extensions. Please see your system administrator and make sure you have proper access to those directories.

Alternatively, an Agile SDK client program can programmatically change the location of the AgileSDK.cache directory at run time. For example, you can use the java.io.tempdir option of the Java Virtual Machine to specify a temp directory where all users have write access.

**Setting the sdk.extensions Property**

If your company uses the Agile SDK to develop process extensions or web service extensions, the finished programs are copied to the <agile_home>\integration\sdk\extensions folder located on the Agile Application Server. From there, the server uses special-purpose class loaders to load the programs when they are invoked.

The agile.properties file located in <agile_home>\agileDomain\config contains an sdk.extensions property that specifies the location of the extensions folder. If process extensions or web service extensions don’t run successfully, it could be because the sdk.extensions property is set incorrectly and does not match the location where the programs have been placed.

**Note** Ordinarily, you should never need to edit the agile.properties file. The sdk.extensions property should be set correctly when you install Agile PLM. If you modify the sdk.extensions property, you must restart the server.
Configuring Oracle HTTP Server

Oracle HTTP Server is a version of the Apache Web Server that is included with your installation of Oracle Application Server. There are several problems that can occur with Agile PLM if you have configured Oracle HTTP Server incorrectly. For example, you may have trouble creating an Agile session from an Agile SDK program. Or you may have trouble importing data from the Microsoft Excel-based client. To fix these problems, you must reconfigure the Oracle HTTP Server.

The main configuration file for Oracle HTTP Server is `httpd.conf`. It is located in the following directory:

Windows: `<oracle_home>\Apache\Apache\conf`

Solaris or Linux: `<oracle_home>/Apache/Apache/conf`

Open the `httpd.conf` file to edit it. You can use any text editor.

Make sure the Port and Listen values in `httpd.conf` are set correctly. The Port and Listen values should always match, even if the Oracle HTTP Server is fronted by a proxy server. Here is what the Port section of the `httpd.conf` file should look like:

```
# Port: The port to which the standalone server listens. Certain firewall
# products must be configured before Apache can listen to a specific port.
# Other running httpd servers will also interfere with this port. Disable
# all firewall, security, and other services if you encounter problems.
# To help diagnose problems use the Windows NT command NETSTAT -a
# Port 7777
Listen 7777
```

Note If port 7777 is already being used, Oracle HTTP Server listens on the next available port number between a range of 7777 and 7877.

Make sure the server status reports section of the `httpd.conf` file uses the fully qualified domain name for your server. Here is what that section should look like:

```
# Allow server status reports, with the URL of http://servername/server-status
# Change the ".your_domain.com" to match your domain to enable.
#
<Location /server-status>
  SetHandler server-status
  Order deny,allow
  Deny from all
  Allow from localhost servername.your_domain.com servername
</Location>
```

Important If you modify the `httpd.conf` file, you must restart Oracle Application Server.

Setting the Temp Directory

When you installed Oracle Application Server, you logged into your operating system as a particular user. You should always log in as that user to manage your installation. Several environment variables are set when you install Oracle Application Server. One of them is the `TMP` environment variable, which sets the temp directory that the server uses. By default, the `TMP` environment variable for Oracle Application Server is set to the temp directory of the user that installed the software.

Several Agile PLM services use the temp directory to store temporary files. If you inadvertently delete the temp directory that Oracle Application Server is using, Agile PLM services that were using the temp directory will no longer operate successfully.
If you notice that Agile PLM export and import operations are no longer working, check the application server log and see if there is an error like this:

```
Exception msg: java.rmi.RemoteException: An error was encountered while exporting data: com.agile.util.exception.CMAppException: C:\Documents and Settings\<user>\Local Settings\Temp\2\AgilePC9Extract\223673754\223673754.xml (The system cannot find the path specified)
```

The message confirms that Oracle Application Server can no longer find the temp directory. To resolve the problem, you can recreate or restore the temp directory, or set the TMP environment variable for Oracle Application Server to another location.

**To reset the temp directory for Oracle Application Server:**

1. Stop Oracle Application Server.
2. Open the `opmn.xml` file located in the `\oracle_home\opmn\conf` directory.
3. Look for the following section:
   ```xml
   <ias-instance id="instance_name.server_name.domain">
   <environment>
     <variable id="TMP" value="temp_directory"/>
   </environment>
   </ias-instance>
   ```
4. Change the `temp_directory` value to a valid directory. It must be a directory that the user who manages OAS can access.
5. Save the file.
6. Restart Oracle Application Server.

**Recompiling Agile PLM JSP Files**

If you have edited Agile PLM JSP files to modify the Agile Web Client user interface, you need to modify the Oracle Application Server main_mode parameter to make sure the JSP files are recompiled before they are loaded.

```
<init-param>
  <param-name>main_mode</param-name>
  <param-value>recompile</param-value>
</init-param>
```

For information about how to modify the Agile Web Client user interface, please see your Agile Solutions Delivery representative.
This chapter describes how to configure an Agile Application Server cluster. It includes the following information:

- About Agile Application Server Clusters
- Configuring the Repository Host Server
- Configuring Non-Repository Host Servers
- Enabling HTTP Session Replication
- Deploying the Agile Application
- Starting the Agile Cluster
- Configuring the Load Balancer
- Configuring the JNLP MIME Type on Solaris or Linux
- Configuring the Agile Application on Non-Repository Host Servers
- Testing the Agile Cluster
- Fixing Agile PLM Client Synchronization Problems and JMS Configuration

Important  When you install and configure an Agile Application Server cluster, follow the sequence recommended in “Clustered Application Server Installation Checklist” on page 1-3.

About Agile Application Server Clusters

Agile takes advantage of clustering capability provided by the supported application servers. Oracle Application Server clustering requires a minimum of two servers to set up a clustered environment. A cluster is a group of servers that work together to provide a more scalable, more reliable application platform than a single server. A cluster appears to its clients as a single server, but is actually a group of servers acting as one. A cluster provides two key advantages over a single server:

- Scalability: The capacity of a cluster is not limited to a single server or a single machine. New servers can be added to the cluster dynamically to increase capacity. If more hardware is needed, a new server on a new machine can be added.
- High-Availability: A cluster uses the redundancy of multiple servers to insulate clients from failures. The same service can be provided on multiple servers in the cluster. If one server fails, another can take over. The ability to fail over from a failed server to a functioning server increases the availability of the application to clients.
Traffic to multiple application servers needs to be managed or balanced by some device in-between the server cluster and the clients. With Oracle Application Server, clients access the cluster through a load balancer.

Before continuing with a clustered installation of Agile PLM on Oracle Application Server, you should understand the following Oracle Application Server terms:

- **server farm** — A collection of Oracle Application Server clusters and Oracle Application Server instances that are grouped and managed together and share the same metadata repository. The shared repository is also called the repository host. You can create an Oracle Application Server server farm by adding multiple instances to a common repository. A farm can hold cluster as well as standalone instances.

- **cluster** — A collection of Oracle Application Server instances with identical configuration and application deployment characteristics. To become members of a DCM-managed cluster, Oracle Application Server instances must be of the same installation type and version, reside on a like operating system, and contain only Oracle HTTP Server, OC4J, OPMN, and JAZN components.

- **repository host** — Also called a file-based repository. When an Oracle Application Server instance is defined as the repository host for a file-based farm, the repository for that Oracle Application Server instance contains the configuration metadata for all Oracle Application Server instances in the file-based farm. When you deploy the Agile application on the repository host, it propagates to all non-repository hosts in the cluster.

- **non-repository host** — An Oracle Application Server instance that is not the repository and therefore does not contain the configuration metadata for the server farm.

Each application server in the cluster should share a common file vault for Agile File Manager. You can install File Manager and set up the file vault on a separate server on the same subnet as the cluster. Create a Files folder on that server, and then give it write permission.

**Important** Make sure all application servers and the load balancer used for Agile PLM are registered in the same domain. You cannot distribute Agile PLM application servers across multiple domains.

### Configuring the Repository Host Server

After installing the repository host server, you must configure the application server cluster. You must join the file-based farm, and then create and join the cluster.

**Note** For Solaris or Linux operating systems, substitute forward slashes for back slashes in the steps below.

**To configure the repository host server:**

1. **Windows:** Open a Command Prompt window.
2. **Solaris or Linux:** Open a terminal window and log on as the user who installed Oracle Application Server.
3. Restart the Oracle Application Server instance:
   ```bash
   \<oracle_home\>\opmn\bin\opmnctl stopall
   \<oracle_home\>\opmn\bin\opmnctl startall
   ```
4. Check the status of the Oracle Application Server instance:
   ```bash
   \<oracle_home\>\opmn\bin\opmnctl status
   ```
5. If the dcm-daemon process is not alive, start it:
   ```bash
   \<oracle_home\>\dcm\bin\dcmctl start -admin
   ```
6. If you started the dcm-daemon process, run the `opmnctl status` command again to verify that it is alive.
7. View which farm is associated with the repository server:
   ```bash
   \<oracle_home\>\dcm\bin\dcmctl whichfarm
   ```
7 If the output reads **Distributed File Based (host)**, skip this step. If the output reads **Standalone Instance**, associate the instance with a server farm:

```
\<oracle_home>\dcm\bin\dcmctl joinfarm -r <repository_id>
```

**Note** If you don’t know the repository ID, run the following command on the repository server:

```
\<oracle_home>\dcm\bin\dcmctl getrepositoryid
```

The command should return something like `<repository_host_name>:7100`.

8 Create the cluster:

```
\<oracle_home>\dcm\bin\dcmctl createcluster -cl AgileCluster
```

9 Join the cluster:

```
\<oracle_home>\dcm\bin\dcmctl joincluster -cl AgileCluster
```

After configuring the repository host server, you can install and configure Agile Application Server on non-repository host servers.

**What To Do Next**

Install the Agile PLM Application Server component on non-repository host servers. See Chapter 3, “Installing Agile PLM.”

**Configuring Non-Repository Host Servers**

After Agile PLM is installed on each non-repository server, configure the cluster. You need to join the server farm on the repository host server and then join the cluster.

**Note** For Solaris or Linux operating systems, substitute forward slashes for back slashes in the steps below.

**To configure a non-repository Host server:**

1 **Windows**: Open a Command Prompt window.

    **Solaris or Linux**: Open a terminal window and log on as the user who installed Oracle Application Server.

2 Restart the Oracle Application Server instance:

```
\<oracle_home>\opmn\bin\opmnctl stopall
\<oracle_home>\opmn\bin\opmnctl startall
```

3 Check the status of the Oracle Application Server instance:

```
\<oracle_home>\opmn\bin\opmnctl status
```

4 If the `dcm-daemon` process is not alive, start it:

```
\<oracle_home>\dcm\bin\dcmctl start -admin
```

5 Run the `opmnctl status` command again to verify that the `dcm-daemon` process is alive.

6 View which farm is associated with the repository server:

```
\<oracle_home>\dcm\bin\dcmctl whichfarm
```

7 If the output reads **Standalone Instance**, associate the instance with a server farm:

```
\<oracle_home>\dcm\bin\dcmctl joinfarm -r <repository_id>
```

**Note** If you don’t know the repository ID, run the following command on the repository server:

```
\<oracle_home>\dcm\bin\dcmctl getrepositoryid
```
The command should return something like \texttt{repository_host_name}:7100.

\textbf{Note} If the output for the \texttt{whichfarm} command reads \texttt{Distributed File Based (host)}, the Oracle Application Server instance is configured to be a repository host and already belongs to a server farm. Make sure the Oracle Application Server instance is not the repository host for Agile PLM. If it is not, you can remove the instance from the farm by running the \texttt{dcmctl leavefarm} command. Then run the \texttt{joinfarm} command mentioned above.

8 Join the cluster:

\texttt{oracle_home}\texttt{dcm\bin\dcmctl joincluster -cl AgileCluster}

After configuring all non-repository host servers in the cluster, you are ready to deploy the Agile application on the repository host server.

\textbf{What To Do Next}

Enable HTTP session replication for the cluster. See the next section.

\section*{Enabling HTTP Session Replication}

After installing the AgileCluster on Oracle Application Server, you need to enable HTTP session replication for each of the nodes.

\textbf{To enable HTTP session replication for the AgileCluster:}

1 Start Oracle Enterprise Manager 10g Application Server Control Console and log in as the administrator (ias_admin).

2 Navigate to \texttt{AgileCluster} > \texttt{managedServer} > \texttt{Home} > \texttt{Replication Properties}.

3 Make sure the \texttt{Replicate Session State} box is checked.

4 For \texttt{Multicast Host} and \texttt{Multicast Port} fields, use the default values.

5 Click \texttt{Apply}.

6 Ensure that each node in the cluster has Replication enabled.

7 Restart the AgileCluster.

\textbf{Note} After you deploy the Agile application, you need to configure each non-Repository Host server to ensure that HTTP session replication works. See "Setting the Cluster ID of Non-Repository Host Servers" on page 5-6.

\textbf{What To Do Next}

Deploy the Agile application on the repository host server. See the next section.

\section*{Deploying the Agile Application}

After the Agile PLM application server has been installed on each Oracle Application Server instance in the cluster, you can now deploy the Agile application. You should deploy Agile on the repository host server, where it is automatically propagated to other servers in the cluster.

\textbf{Note} For Solaris or Linux operating systems, substitute forward slashes for back slashes in the steps below.

\textbf{To deploy the Agile application:}

1 \textbf{Windows:} Open a Command Prompt window.

\textbf{Solaris or Linux:} Open a terminal window and log on as the user who installed Oracle Application Server.
2 On the repository host server, restart the Oracle Application Server instance:

  \{oracle_home\}/opmn/bin/opmnctl stopall
  \{oracle_home\}/opmn/bin/opmnctl startall

3 Check the status of the Oracle Application Server instance:

  \{oracle_home\}/opmn/bin/opmnctl status

4 If the dcm-daemon process is not alive, start it:

  \{oracle_home\}/dcm/bin/dcmctl start -admin

5 Run the opmnctl status command again to verify that the dcm-daemon process is alive.

6 Deploy the Agile application:

   Windows: \{agile_home\}/agileDomain/bin/DeployAgile.cmd
   Solaris or Linux: /\{agile_home\}/agileDomain/bin/DeployAgile.sh

   When deployment is finished, the script prompts that the Agile application has been deployed.

7 Verify that the Agile application is deployed:

   \{oracle_home\}/dcm/bin/dcmctl listapplications

   If Agile is listed, you can log in to the application server.

What To Do Next

Configure a load balancer or a Web proxy server for your Agile PLM system. On Windows, IIS is not supported as a Web proxy server for an OAS cluster, so a load balancer is recommended. For more information, see “Configuring the Load Balancer” on page 5-5 and Chapter 7, “Configuring a Web Proxy Server for Agile PLM.”

Starting the Agile Cluster

Once the Agile application is deployed to every Oracle Application Server in the cluster, the cluster should be active. You can use the opmnctl command-line interface to stop and start individual servers in the cluster. Alternatively, you can restart all servers in the cluster using the following dcmctl command:

   On Windows:

   \{oracle_home\}/dcm/bin/dcmctl start -cl AgileCluster

   On Solaris or Linux:

   /\{oracle_home\}/dcm/bin/dcmctl start -cl AgileCluster

   Note The dcmctl start command is deprecated in Oracle Application Server 10g and is provided for backward compatibility only.

Configuring the Load Balancer

A load balancer is deployed to protect the application server and to balance user load across a cluster. When external users need access to Agile, this device is deployed in the DMZ. The load balancer does not need to be installed in the DMZ if Agile PLM is only accessed internally from within the corporate firewall. Load balancers can be used with the Java Client and the Web Client.
To configure a load balancer:
- Configure three virtual IP addresses, one for the application server (port 7777 by default), one for the File Manager (port 8080 by default), and one for ORMI (port 23791 by default).
- Set the load balancer policy to Round-robin.

To access the system after you have configured the load balancer, use the IP address of the virtual server in the URL used to access Agile. The following URL is an example:

http://loadbalancer.mydomain.com/Agile/PLMServlet

or

ormi://loadbalancer.mydomain.com/Agile

What To Do Next
Verify that the Agile cluster is working properly. See “Testing the Agile Cluster” on page 5-8.

Configuring the JNLP MIME Type on Solaris or Linux
A JNLP file is an XML document that describes a Java application to be launched by Java Web Start. To successfully download and install applications using Java Web Start, you must configure the JNLP MIME type for your server.

Add the following line to the mime.types file in the /<oracle_home>/Apache/Apache/conf directory of each application server in the cluster:

```
application/x-java-jnlp-file            JNLP
```

Configuring the Agile Application on Non-Repository Host Servers
After deploying the Agile application to the servers in your cluster and configuring a Web proxy server for your Agile PLM system, you must make a few manual changes to the Agile application on each non-repository host server.

Setting the Cluster ID of Non-Repository Host Servers

Important This section applies only to clustered Agile PLM systems that use a Web proxy server instead of a load balancer. Otherwise, you can skip these manual configuration steps.

To enable HTTP session failover, Agile provides a file named orion-web.xml inside the application.war file. In that file is a <cluster-config> tag that identifies the host machine. If the cluster ID is set incorrectly (for example, to the repository host ID), HTTP session replication won’t work. For example, if you try to view or redline a file in the Agile Java Client, a new login page will appear. This happens because the request has been routed to another node in the cluster. To fix this problem, edit the orion-web.xml file and set the cluster ID correctly.

To set the cluster ID of non-repository host servers:

1. Open the following file on the non-repository host:
   `<oracle_home>/j2ee/home/config/server.xml`

2. Find the `<cluster>` tag, and copy the cluster ID (the value in quotes).
   `<cluster id="-12345" />`

3. Open the following file on the non-repository host:
   `<oracle_home>/j2ee/home/application-deployments/Agile/application/orion-web.xml`

4. Find the `<cluster-config id="-12345" />` tag.

5. Replace the cluster ID value with the ID you copied from server.xml in step 2 above.

6. Repeat these steps for all non-repository hosts in the cluster.
7 Restart the cluster

**Configuring jndiurl.properties and pcclient.jnlp**

*Important* This section applies only to clustered Agile PLM systems on Solaris or Linux that use a Web proxy server instead of a load balancer. Otherwise, you can skip these manual configuration steps.

**To configure jndiurl.properties and pcclient.jnlp on non-repository host servers:**

1. Stop the Web proxy server.
2. Stop Oracle Application Server on each server in the cluster.
3. On each non-repository host server, open the following file in a text editor:
   ```
   /<oracle_home>/j2ee/home/applications/Agile/APP-INF/classes/jndiurl.properties
   ```
4. Edit the URL to point to the non-repository host:
   ```
   server2=ormi://<non-repository_hostname>/<appserver_virtual_path>
   ```
5. Save the jndiurl.properties file.
6. On each non-repository host server, open the following file in a text editor:
   ```
   /<oracle_home>/j2ee/home/applications/Agile/JavaClient/pcclient.jnlp
   ```
7. Find the following tags and edit the values listed below in blue:
   ```
   jnlp:
   <jnlp spec="1.0+" codebase="http://<non-repository_hostname>..<domain>..<port>/JavaClient">
   serverURL:
   <argument>serverURL=ormi://<non-repository_hostname>..<domain>..<port>/<appserver_virtual_path></argument>
   webserverName:
   <argument>webserverName=<proxy>..<domain>..<port></argument>
   ```
   where
   - `<non-repository_hostname>` is the hostname for the non-repository host (not the repository host).
   - `<domain>` is the fully qualified domain name.
   - `<port>` is the server port.
   - `<appserver_virtual_path>` is the Agile Application Server virtual path. The default is “Agile”.
   - `<proxy>` is the Web proxy server hostname.
8. Save the file.
9. On each non-repository host server, open the following file in a text editor:
   ```
   /<oracle_home>/j2ee/home/applications/Agile/JavaClient/oas/ext.jnlp
   ```
10. Find the following tag and edit the values listed below in blue:
    ```
    jnlp:
    <jnlp spec="1.0+" codebase="http://<non-repository_hostname>..<domain>..<port>/JavaClient">
    ```
    where
Installing Agile PLM with Oracle Application Server

- `<non-repository_hostname>` is the hostname for the non-repository host (not the repository host).
- `<domain>` is the fully qualified domain name.
- `<port>` is the server port.

11 Save the file.
12 Restart Oracle Application Server on each server in the cluster.
13 Restart the Web proxy server.

**Testing the Agile Cluster**

Use the following URLs to test each server in the cluster and the load balancer:

**Web Client**

http://hostname.domain.com:7777/Agile/PLMServlet

For example, if your hosts are named host1, host2, and host3, the Web Client URLs could look like this:

http://host1.mydomain.com:7777/Agile/PLMServlet
http://host2.mydomain.com:7777/Agile/PLMServlet
http://host3.mydomain.com:7777/Agile/PLMServlet

**Java Client**

http://hostname.domain.com:7777/JavaClient/start.html

For example, if your hosts are named host1, host2, and host3, the Java Client URLs could look like this:

http://host1.mydomain.com:7777/JavaClient/start.html
http://host2.mydomain.com:7777/JavaClient/start.html
http://host3.mydomain.com:7777/JavaClient/start.html

**Load Balancer**

If you use a load balancer for your application server cluster, test the entire system by going to the load balancer URLs for Web Client and Java Client:

http://loadbalancer.domain.com/Agile/PLMServlet
http://loadbalancer.domain.com/JavaClient/start.html

**Troubleshooting**

For information about how to check and troubleshoot problems with your Agile PLM installation on Oracle Application Server, see “Verifying Your Agile Application Server” on page 4-4.

**Fixing Agile PLM Client Synchronization Problems and JMS Configuration**

If you are running your Oracle Application Server cluster, you may notice synchronization problems with Agile PLM clients. On non-Repository Host servers, the JMS host may be set to the name of the computer instead of the fully qualified domain name of the Repository Host server. Consequently, the Agile PLM metadata is not synchronized on all servers in the cluster. To fix this problem, you need to update the JMS configuration file (jms.xml) on each non-Repository Host server.
To fix JMS configuration:

1. On the Repository Host server, open a terminal window and log on as the user who installed Oracle Application Server.
2. In the `/<oracle_home>/j2ee/home/config` directory, open the jms.xml file in a text editor.
3. Search for “host=”. For all instances that you find, make sure the hostname is the fully qualified domain name of the Repository Host server.
4. Save the jms.xml file.
5. Copy the jms.xml file to the `/<oracle_home>/j2ee/home/config` directory of each non-Repository Host server in the cluster.
6. Restart each Oracle Application Server instance. Make sure you start the OAS instance on the Repository Host server first.

   `<oracle_home>/opmn/bin/opmnctl stopall`

   `<oracle_home>/opmn/bin/opmnctl startall`
CHAPTER 6

Configuring the File Manager

This chapter describes how to configure file management servers. It includes the following information:

- About File Management
- Configuring the File Manager
- Starting the File Manager
- Validating the File Manager Installation

About File Management

The File Manager manages files in a repository in the file system. A file management server configuration provides a place to store and retrieve files locally or remotely. The File Management Server can be installed on the same machine as the Agile Application Server or on a separate machine. The server can also be installed in a cluster or distributed across geographic regions.

The Agile View Server communicates with the File Manager which in turn makes remote calls to the Agile Application server using the HTTP protocol. Because of this communication, each File Manager should have an associated View Server on the same machine or separate machines.

In the preferred clustered environment, file management servers run on each application server node managing a shared drive. In a distributed environment, files are stored locally for efficient downloads and uploads. If a file is not found on a local file management server, the file is replicated from the primary file manager. The primary file manager is the file manager that is local to the application server.

Distributed File Managers

Multiple Agile File Managers can be deployed in a distributed configuration with a proxy server (Microsoft IIS or Apache HTTP Server) in the DMZ. A Distributed File Manager configuration allows you to create additional file managers at remote locations so that remote sites can store and retrieve files locally, while still making the files available to the Agile PLM system. This reduces the download time by placing file managers close to remote clients. The additional file managers can also support unique configuration settings, such as fully qualified names or IP addresses.

The determination for using distributed file management is based on your Agile server and network configuration. In general, the following criteria can help you to determine if you need additional file managers:

- Multiple remote locations
  - If you have multiple remote sites connected over a WAN, clients at remote locations who need to store and retrieve files from the main file manager can experience large time delays.
Reducing inter-network traffic

If your network is divided into subnets to reduce network traffic, then you should consider putting a file manager in each subnet that contains Agile users to reduce your intersubnet network traffic.

The usage model for a distributed file manager configuration is as follows:

- Local users store files on a local file manager, which should be designated the primary file manager.
- Creating a file attachment goes to the primary file manager.
- File replication is on-demand. When a remote user requests a file residing on a non-preferred file manager, the system copies the file to the remote user’s preferred file manager.
- Accessing any non-preferred file manager prompts the user for a login name and password.
- Copying a file creates the copy on the same computer. It does not replicate the file to a remote user’s preferred file manager.
- Checking out and checking in files is the same as adding and getting files.
- Viewing a file or viewing a redline file is the same as getting a file.
- Redlining a file only redlines the file on the primary file manager.
- Redlining a file is the same as adding a file.
- Deleting a file only removes the file from the primary file manager. Use the vault utility to clean up additional files on non-primary file managers.

Deployment Configurations

You can deploy the File Manager in either a standalone or cluster configuration.

**Standalone**

The following figure shows a single server standalone deployment configuration. The web server in the DMZ forwards calls to the Application Server as well as the File Manager.

If you plan to install the Application Server and File Manager on the same box (co-deploy), choose both components during installation.
Cluster

The preferred cluster deployment configuration is shown in the following figure. Each node in the cluster has the Application and File Manager deployed. File Managers have a shared disk for managing files. Each File Manager communicates with the local application server for optimized performance. The File Managers join in a Tomcat cluster to support failovers. The Load Balancer exposes two virtual IP addresses, one for the application server and one for the File Manager.

When installing this type of cluster, choose both the Application Server and File Manager components during installation before selecting the Cluster configuration.

Figure 6-2: Preferred Clustered File Manager Configuration

You can also choose to manage a separate File Manager cluster and Application Server cluster, but that configuration requires more hardware. If you choose to install this type of setup, the clusters should be installed separately before configuring and validating.
Figure 6-3: Application Server and File Manager clusters

Configuring the File Manager

After installing the File Manager and setting up a proxy server for it, you must configure the File Manager settings in the Java Client.

Note Before configuring the File Manager, make sure you set up a proxy server.

To configure File Manager settings:
1 Start the Agile Application Server.
2 Start the Agile Java Client, as described in “Installing and Configuring Agile Java Client” on page 11-1.
3 Log in as an Agile Administrator user.
4 Click the Admin tab.
5 Choose Server Settings > Locations. The Server Location window appears.
6 Click the File Manager tab to bring it forward.
7 Double-click the entry to display the File Manager dialog box.
8 Click the Advanced button.
9 Enter the values of the **File Manager URL** and the **File Manager Internal Locator**.

The **File Manager URL** is the URL the Agile Web Client connects to. The format is:

```
http://<proxy/loadbalancer>:<port>/<fileserver_virtual_path>/AttachmentServlet
```

The **File Manager Internal Locator** is the URL the file management server uses. The format is:

```
http://<proxy/loadbalancer>:<port>/<fileserver_virtual_path>/services/FileServer
```

**Note** If you have co-deployed the Application Server and the File Manager, use the Application Server URL, not the proxy server.

10 Enter the values of the **Viewer Server URL**, **Viewer Proxy URL**, and the **Viewer Content URL**, if needed:

The **Viewer Server URL** is the URL the Web Client uses to connect to the View Server. The format is:

```
http://<proxy/loadbalancer>:<port>/<fileserver_virtual_path>/VueServlet
```

The **Viewer Proxy URL** is the URL the View Server uses to communicate with the File Manager. The format is:

```
http://<proxy/loadbalancer>:<port>/<fileserver_virtual_path>/VueLink
```

The **Viewer Content URL** is the location from where the Viewer Applet is downloaded. The format is:

```
http://<proxy/loadbalancer>:<port>/<appserver_virtual_path>/jVue
```

11 Click the Standard Vault Type to display the drop-down list.

You can choose to have **Standard** or **Custom** vault. A standard vault is the default vault type that contains the new files and redlines, while a custom vault allows you to attach a disk of data to Agile PLM as-is without reorganizing the files. A custom vault is always set up as read-only.

You can attach an arbitrary file structure to the File Manager without the files being uploaded. Refer to the *Agile PLM Import and Export Guide* for more information on how to configure FileLoad for custom vaults.

12 Enter a description of the vault in the **Description** field.
Verify that the primary location where the files are stored in the **Base Storage Directory** field is the same location you entered during installation. The default location is \files\. The location can be a shared network storage directory, such as a Storage Area Network (SAN).

**Important** Do not specify a mapped location. Instead, specify the actual machine name and directory, like this:

\files\files

**14** Enter a location where the purged (deleted) files are automatically moved in the **Purge Directory** field. The default location is <agile_home>\files\purge. The location can be a shared network storage directory, such as a Storage Area Network (SAN).

**Important** Do not specify a mapped location. Instead, specify the actual machine name and directory, like this:

\files\purge

**15** Select if the vault is **Read-Write** or **Read-Only** from the Category drop-down list. Each File Manager can have only one read-write vault.

If you have upgraded and have multiple vaults, then the additional vaults should be cascaded as read-only vaults.

**16** Click the plus-sign to add additional vaults.

**17** Click **OK** when done.

**18** Start the File Manager (Tomcat). For instructions, see the next section, “Starting the File Manager.”

There are additional configuration settings used to fully configure File Manager through the Java Client. These settings are:

- Filename Prefix (Preferences)
- Checksum computation (Preferences)
- DFM Optimized Replications (Preferences)

For more information on these additional settings, see the *Agile PLM Administrator Guide*.

### Reconfiguring File Manager After Setting Up a Web Proxy Server

If you set up a Web proxy server for Agile File Manager that is different from the server or port you specified when you installed Agile PLM, you must make sure that File Manager points to the proxy server on the correct port. Otherwise, File Manager may not start successfully and Agile PLM clients won’t be able to access file attachments.

For instructions on setting up a Web proxy server for File Manager, see Chapter 7, “Configuring a Web Proxy Server for Agile PLM.”

**To configure File Manager after setting up a Web proxy server:**

1. Configure File Manager locations in Java Client. See “Configuring the File Manager” on page 6-4.

2. Stop the File Manager.

3. Using a text editor, open the server.conf file for File Manager. The server.conf file is located in the following folder:

   \agile_home\Tomcat\webapps\<fileserver_virtual_path>\WEB-INF\classes\com\agile\webfs\configuration

4. Find the file.server.url entry, and update it to point to the proxy server and port number. After you modify the file.server.url entry, it should look something like this:


5. Save the server.conf file.

6. Restart the File Manager.
Chapter 6  Configuring the File Manager

Configuring the Apache Tomcat Administration Tool

The Apache Tomcat Web Server used for File Manager has a Web-based Administration Tool you can use to add administrator users. Before using the Administration Tool, you need to define the initial admin user by editing the tomcat-users.xml file.

To create an admin user for File Manager:

1. Stop the File Manager (Tomcat).
2. Using a text editor or XML editor, open the tomcat-users.xml file located in the <agile_home>\Tomcat\conf directory.
3. Add the boldface text shown below:

```xml
<?xml version='1.0' encoding='utf-8'?>
<tomcat-users>
    <role rolename="tomcat"/>
    <role rolename="role1"/>
    <role rolename="AgileUser"/>
    <role rolename="admin"/>
    <user username="admin" password="agile" roles="admin"/>
    <user username="tomcat" password="tomcat" roles="tomcat"/>
    <user username="role1" password="tomcat" roles="role1"/>
    <user username="both" password="tomcat" roles="tomcat,role1"/>
</tomcat-users>
```
4. Save the tomcat-users.xml file.
5. Restart the File Manager (Tomcat).

To log into the Apache Tomcat Administration Tool:

Open a browser and go to the following URL:

http://<fileserver_host>:<port>/admin

For example, you might type the following URL:

http://filevault.mycompany.com:8080/admin

Starting the File Manager

After you have configured the File Manager, you can start the server.

To start the File Manager on Windows:

2. Start the Apache Tomcat service.

You can check for errors in the stdout and stderr logs in the <agile_home>\Tomcat\logs directory.

To start the File Manager on Solaris or Linux:

1. Open a terminal window.
2. Change to the /opt/<agile_home>/Tomcat/bin directory.
3. Set and export the JAVA_HOME variable on the command line:

   ```
   > JAVA_HOME=/opt/<agile_home>/jdk
   > export JAVA_HOME
   ```
4. Start the File Manager:

   ```
   > ./catalina.sh run
   ```
Validating the File Manager Installation

To verify that the File Manager installed successfully, check the following URL:

http://<fileserver_host>:<port>/<fileserver_virtual_path>/Configuration

For example, you might type the following URL:

http://filevault.mycompany.com:8080/Filemgr/Configuration

If you are using a Web proxy server for File Manager, the URL might look like this:

http://filevault.mycompany.com:80/Filemgr/Configuration

After a moment, the File Manager Configuration page should display. This page tests the File Manager and Application Server connections. If Success is listed in the Status column for all connections, your installation was successful.

Figure 6-5: File Manager Configuration page
This chapter describes how to configure a Web proxy server for Agile PLM. It includes the following information:

- Overview
- Configuring IIS as a Proxy Server for Agile PLM
- Configuring IIS as a Proxy Server for Agile File Manager
- Using Apache Web Server as a Proxy Server for Agile PLM and Agile File Manager
- Logging In to the Agile Web Client
- Troubleshooting the Agile Web Client

Important When you configure a Web proxy server for Agile PLM, follow the sequence recommended in “Web Proxy Server Installation Checklist” on page 1-5.

Overview

The Agile Web client is a fully functional Web interface that allows Agile-enabled manufacturers to securely provide internal users and trusted supply chain partners access to Agile PLM.

To connect to the Agile Web Client on a Web proxy server, Agile Web proxy files must be installed on the Web server. Agile Web Client uses Microsoft Internet Information Services (IIS) or Apache Web Server. The Agile Web client connects to an Agile Application Server in the same manner as all other Agile Application Server clients. Secure access is maintained using SSL encryption with HTTPS and is recommended for the Internet. Standard firewall configurations are supported by the Web server.

Note If you are using an Oracle Application Server cluster on Windows, you must use a load balancer instead of a Web proxy server to protect the application server and to balance user load across the cluster.

Agile Internet Security

A Web browser uses the Agile Web client to communicate with the Agile Application Server over the Internet using the HTTPS protocol, which uses the Secure Sockets Layer (SSL) protocol. SSL is a standard Internet connection-based protocol for secure communications.

Recommended Security Practices

It is important that you change all default passwords for both Agile PLM and the database. In addition, users should change their passwords at least every 30 days.
Configuring Internet Information Server

Before you install Agile Web proxy files on Windows, a Microsoft Internet Information Server (IIS) must be installed on the same computer. In addition, IIS must be configured as follows:

1. Choose Start > Administrative Tools > Internet Information Services (IIS) Manager, and create a new web site called Agile PLM Web Site. For more information on how to create a web site, see the Internet Information Server documentation online at the Microsoft TechNet: http://technet.microsoft.com/

   Note Due to security vulnerabilities, we recommend that you don’t use the Default Web Site installed with Internet Information Server. You can either delete or disable the Default Web Site.

2. Right-click the Agile PLM Web Site, and choose Properties from the shortcut menu.


4. Make sure Allow Anonymous Access is checked.


6. Click OK.

Also, search the \winnt\system32 folder for the wininet.dll file. The file must be at least version 5.00.2919.6305 or later. Install at least Internet Explorer version 5.00.2919.6305 to update the DLL file.

For security reasons, Agile recommends installing Agile Web proxy files on a server separate from other Agile PLM servers.

Firewall Configuration

A user typically runs the Agile Web client in a browser from behind a corporate firewall. This communicates over the Internet to the Agile servers behind another corporate firewall.

If you want to use HTTPS, each Agile Web client’s firewall must be configured to allow outgoing HTTPS connections from the user’s browser to the Internet.

The corporate firewall on the Agile application side must be configured to allow:

- Incoming HTTPS connections from the Internet to the Web server
- Outgoing TCP/IP connections from the Web server to the Application Server

Important On Windows, encryption is supported only between IIS and the client’s browser, not between IIS and the Application Server. Do not put a certificate on the Application Server.

Deployment Scenarios in the DMZ

This section contains deployment scenarios. For deployment diagrams, see the Capacity Planning and Deployment Guide.

Single Firewall

In the first scenario, there is only one firewall between the DMZ and internet.

In this setup, the computers in the intranet are referenced by a single IP address. There is no network address translation (NAT) between the DMZ and intranet. Only the Web server in the DMZ is referenced by two IPs or hostnames. Agile Web clients are deployed in this environment as follows:

- The Web server resides on one computer in the DMZ with the Agile Application Server, Agile View Server, and the database residing in the Safe Zone.

When the Application Server and Agile Web proxy files are installed, you must open application server-specific HTTP/HTTPS ports from the DMZ to the intranet. This enables communication between the IIS Web server
proxies and the Agile Application Server. The application server-specific ports must be dedicated and
bidirectional between the Web server in DMZ and application server in the intranet.
You are not required to open any other ports from the DMZ to the intranet.

Advantages:
• Firewall friendly and secure without exposing Agile in the DMZ.
• Modest performance boost because Agile Web proxies reside with other Agile Application Server components

Disadvantages:
• An additional computer is needed.
• Additional configuration requirements.

1  Install the Agile Web proxy files on the IIS computer in the DMZ.
2  Set up the IIS folder as specified in this chapter.

Two Firewalls
In the second scenario, there are two firewalls—one between the DMZ and the internet, and one between the DMZ
and the intranet. In this setup, the computers in the intranet are referenced by two IP addresses. There is IP address
translation or network address translation between the DMZ and intranet to enable mapping external IP addresses
to internal IPs of the computers. However, in such environments, third-party vendor applications typically
encounter problems with firewall configuration.

❑ The IIS Web server resides on one computer in the DMZ, and the Agile Application Server resides on another
computer in the intranet with Agile View Server and the database.

Advantages:
• Firewall friendly and secure without exposing Agile in the DMZ.
• Modest performance boost because Agile Web proxies reside with other Agile Application Server components

Disadvantages:
• An additional computer is needed.
• Additional configuration requirements.

Configuring IIS as a Proxy Server for Agile PLM
When you install the Agile PLM Web Proxies component, the setup program creates the \\
<agile_home>\AgileProxies
folder. For example, if you accepted the default installation location at \Agile\Agile921, the AgileProxies folder
appears in that folder. The AgileProxies folder contains the following files that enable communication between the
IIS Web server and the Agile Application Server:

❑ oracle_proxy.dll — an ISAPI filter, which allows IIS to process HTTP requests
❑ 9ias.conf — initialization file to direct the proxy filters where to route the HTTP/HTTPS traffic specific to Agile
PLM from IIS

To configure IIS to be a Web proxy server for Agile PLM:

1  On the Web server computer, choose Start > Administrative Tools > Internet Information Services (IIS) Manager.
The Internet Information Services Manager window appears.

2  Expand the folder for Internet Information Services > servername.

3  Right-click the Agile PLM Web Site, and choose Properties from the shortcut menu.
The Agile PLM Web Site Properties dialog box appears.
Note Due to security vulnerabilities, we recommend that you don’t use the Default Web Site installed with Internet Information Server and instead create a new Web site named Agile PLM Web Site. For more information, see “Configuring Internet Information Server” on page 7-2.

4 Click the **Home Directory** tab.

5 Set the permissions to **Scripts and Executables**.

6 Select the **ISAPI Filters** tab.

7 Click **Add**.

   The Add/Edit Filter Properties dialog box appears.

8 Type **oproxy** in the **Filter Name** field.

9 Click **Browse** and locate the **oracle_proxy.dll** file from \<agile_home>\AgileProxies folder. After you select the **oracle_proxy.dll** file, click **Open** to close the dialog box.

10 In the Add/Edit Filter Properties dialog box, click **OK**.

   The Agile PLM Web Site Properties dialog box appears.

11 Click **OK** to close the Agile PLM Web Site Properties dialog box.

12 Right-click the **Agile PLM Web Site**, and choose **New > Virtual Directory** from the shortcut menu.

   The Virtual Directory Creation Wizard appears.

13 Click **Next**.

14 Type **oproxy** in the **Alias** field. Click **Next**.

15 On the Web Site Content Directory page, click **Browse**, locate the \<agile_home>\AgileProxies folder, and then click **OK**. Click **Next**.

16 Check the **Execute** checkbox. Click **Next**.

17 Click **Finish**.

18 Select the **Web Service Extensions** folder.

19 Select **All Unknown ISAPI Extensions**.

20 Click **Allow**.

21 Close IIS Manager.

22 Restart IIS.

   **Note** To restart IIS, stop all of the IIS services through the control panel and then restart them, or restart the computer. This ensures that the .dll is reloaded. Do not use IIS Manager to restart IIS.

### Testing the Configuration

After you set up the oproxy ISAPI filter, you should test whether the filter loads successfully.

To make sure the oproxy filter added to ISAPI Filters tab is loaded properly on the Web server:

1 Select the **Agile PLM Web Site** node, right-click, and choose **Properties** from the shortcut menu.

   The Agile PLM Web Site Properties dialog box appears.

2 Select the **ISAPI Filters** tab.

   The status for the oproxy filter shows an arrow pointing up, indicating that it is loaded on the IIS Web server and ready to proxy all external HTTP/HTTPS requests to the Agile Web client server.

   **Note** If the arrow is not pointing up, the filter is not loaded properly. In that case, restart the computer.
The IIS Web server is now ready to accept all external Agile Web clients using HTTP requests on standard ports 80. The IIS Web server provides a proxy to the application server running Agile Web clients on the port you specified during the Agile Application Server installation.

### Configuring IIS as a Proxy Server for Agile File Manager

When you install Agile Web proxies, the setup program creates the \<agile_home>\AgileProxies folder. For example, if you accepted the default installation location at \Agile\Agile921, the AgileProxies folder appears in that folder.

The \<agile_home>\AgileProxies folder contains the following files that enable communication between the IIS Web server and the File Manager (Tomcat):

- isapi_redirect.dll - The IIS server plugin.
- workers.properties - A file that describes the hosts and ports used by Tomcat processes.
- uriworkermap.properties - A file that maps URL-Path patterns to Tomcat processes.

**Note** If you set up a Web proxy server for Agile File Manager that is different from the server or port you specified when you installed Agile PLM, you must make sure that File Manager points to the proxy server on the correct port. For more information, see “Reconfiguring File Manager After Setting Up a Web Proxy Server” on page 6-6.

To configure IIS as a proxy server for File Manager:

1. On the File Manager computer, open the \<agile_home>/Tomcat/conf/jk2.properties file.
2. Add the following entry, replacing @AJP-PORT@ with the actual AJP port number:
   ```
   channelSocket.port=@AJP-PORT@
   ```

   **Note** To see which AJP port number to enter, open the \<agile_home>/Tomcat/conf/server.xml file and look for the following section:
   ```
   <!--  Define a Coyote/JK2 AJP 1.3 Connector on port 8009   -->
   <Connector port="8009" enableLookups="false" redirectPort="8443" debug="0"
   protocol="AJP/1.3" /> 
   ```


   The Internet Information Services Manager window appears.

4. Expand the folder for Internet Information Services > servername.

5. Right-click the Agile PLM Web Site, and choose Properties from the shortcut menu.

   The Agile PLM Web Site Properties dialog box appears.

   **Note** Due to security vulnerabilities, we recommend that you don’t use the Default Web Site installed with Internet Information Server and instead create a new Web site named Agile PLM Web Site. For more information, see “Configuring Internet Information Server” on page 7-2.

6. Select the ISAPI Filters tab.

7. Click Add.

   The Add/Edit Filter Properties dialog box appears.

8. Type Jakarta IIS Connector in the Filter Name field.

9. Click Browse and locate the isapi_redirect.dll file from the \<agile_home>\AgileProxies folder. After you select the isapi_redirect.dll file, click Open to close the dialog box.

10. In the Add/Edit Filter Properties dialog box, click OK.

   The Agile PLM Web Site Properties dialog box appears.
11 Click OK to close the Agile PLM Web Site Properties dialog box.

12 Right-click the Agile PLM Web Site, and choose New > Virtual Directory from the shortcut menu.

The Virtual Directory Creation Wizard appears.

13 Click Next.

14 On the Virtual Directory Alias page, type Jakarta as the alias name. Click Next.

15 On the Web Site Content Directory page, click Browse, locate the \\agile_home\\AgileProxies folder, and then click OK. Click Next.

16 On the Access Permissions page, make sure the Execute checkbox is checked. Click Next.

17 Click Finish.

18 Close IIS Manager.

19 Open the workers.properties file in the <agile_home>\AgileProxies folder.

20 Make sure the File Manager host name is correct in the following entry:

   worker.ajp13w.host=<File Manager host name>

21 Save and close the file.

22 Restart IIS.

   Note To restart IIS, stop all of the IIS services through the control panel and then restart them, or restart the computer. This ensures that the .dll is reloaded. Do not use IIS Manager to restart IIS.

Testing the Configuration

After you set up the Jakarta IIS Connector ISAPI filter, you should test whether the filter loads successfully.

To make sure the isapi_redirect filter added to ISAPI Filters tab is loaded properly on the Web server:

1 Select the Agile PLM Web Site node, right-click, and choose Properties from the shortcut menu.

The Agile PLM Web Site Properties dialog box appears.

2 Select the ISAPI Filters tab.

The status for the Jakarta IIS Connector filter shows an arrow pointing up, indicating that it is loaded on the IIS Web server and ready to proxy all requests to the File Manager.

   Note If the arrow is not pointing up, the filter is not loaded properly. In that case, restart the computer.

Using Apache Web Server as a Proxy Server for Agile PLM and Agile File Manager

On Solaris or Linux operating systems, you can use Apache Web Server as the Web proxy server for Agile PLM. If you choose the Apache Web Server when you install Agile PLM, you must specify the Apache Home Directory.

   Note If you set up a Web proxy server for Agile File Manager that is different from the server or port you specified when you installed Agile PLM, you must make sure that File Manager points to the proxy server on the correct port. For more information, see “Reconfiguring File Manager After Setting Up a Web Proxy Server” on page 6-6.
Configuring Apache Web Server on Solaris

This section shows how to configure an Apache Web Server 2.0.55 proxy for Agile PLM and Agile File Manager on Oracle Application Server 10g for Solaris.

Apache Http Server 2.0.x for Solaris:
http://archive.apache.org/dist/httpd/binaries/

Mod_Jk Connector for Apache 2.0:
http://www.apache.org/dist/tomcat/tomcat-connectors/jk/binaries/solaris/jk-1.2.6/

To configure Apache Web Server to be a Web proxy server for Agile PLM and Agile File Manager on Solaris:

1. Download, build, and install Apache Web Server for Solaris. For installation instructions, refer to the Apache documentation.
   ```
   ./configure --prefix=/opt/apache2 -enable-mods-shared=all
   make
   make install
   ```

2. After installing Apache Web Server, install the proxy plug-in:
   a. Go to the following directory:
      ```
      $Apache/modules/proxy
      ```
   b. Run the following commands:
      ```
      $Apache/bin/apxs -i -a -n proxy_connect.c
      $Apache/bin/apxs -i -a -n proxy_httpd.c
      ```

3. Download the Mod_Jk Tomcat Connector (jakarta-tomcat-connectors-jk-1.2.6-solaris8-sparc-apache-2.0.43_native.so) from the URL listed above. Save it as $Apache/modules/mod_jk.so.

4. Create a Mod_Jk configuration file ($Apache/conf/workers.properties) with the following entries:
   ```
   worker.list=default
   worker.default.type=ajp13
   worker.default.host=<File Manager host name>
   worker.default.port=8009
   ```

5. Add the following lines to the $Apache/conf/httpd.conf file:
   ```
   #Enable Mod_proxy for Application Server Proxying
   LoadModule proxy_connect_module modules/mod_proxy_connect.so
   LoadModule proxy_http_module modules/mod_proxy_http.so
   #Enable Mod_Jk for File Manager proxying
   LoadModule jk_module modules/mod_jk.so
   # Add the proxy forward path. Replace appropriately with actual Virtual path and server host/port
   ProxyPass /Agile http://server:7777/Agile
   ProxyPassReverse /Agile http://server:7777/Agile
   #Entries for File mgr proxying
   JKWorkersFile conf/workers.properties
   #Filemgr is virtual path for Agile File Manager
   JKMount /Filemgr default
   JKMount /Filemgr/* default
   ```

6. If mod_proxy was not compiled into httpd, add the following to the $Apache/conf/httpd.conf file:
   ```
   LoadModule proxy_module modules/mod_proxy.so
   ```
7 Open $Tomcat/conf/jk2.properties and add the following entry:

channelSocket.port=8009

The AJP Port specified above must match the AJP port specified in $Tomcat/conf/server.xml.

<Connector port="8009"
    maxThreads="150" minSpareThreads="25" maxSpareThreads="75"
    enableLookups="false" redirectPort="8443" debug="0"
    protocol="AJP/1.3" />

8 Restart Apache Tomcat.

9 Restart Apache Web Server.

   $apache/bin/apachectl stop
   $apache/bin/apachectl start

Configuring Apache Web Server on Linux

This section shows how to configure an Apache Web Server 2.0.x proxy for Agile PLM and Agile File Manager on Oracle Application Server 10g for Linux.

Generally, when you install Red Hat Linux it includes Apache Web Server 2.0 and the MOD_PROXY Connector. If your Linux server does not have Apache Web Server, you can download it from the following location:

Apache Http Server 2.0.x for Linux:
http://archive.apache.org/dist/httpd/binaries/

The Mod Jk Connector for Apache Http Server, which is necessary for using Apache as a proxy for Agile File Manager (Tomcat), can be installed using Red Hat RPM. You can also download the source from the following location and compile it.

Mod_Jk Connector for Apache 2.0:
http://www.apache.org/dist/tomcat/tomcat-connectors/jk/binaries/linux/jk-1.2.14/

To configure Apache Web Server to be a Web proxy server for Agile PLM and Agile File Manager on Linux:

1 Open the Apache Web Server $Apache/conf/httpd.conf file and ensure that the following modules are uncommented:

    LoadModule proxy_module modules/mod_proxy.so
    LoadModule proxy_connect_module modules/mod_proxy_connect.so
    LoadModule proxy_http_module modules/mod_proxy_http.so

2 At the end of the $Apache/conf/httpd.conf file, add the following ProxyPass and ProxyPassReverse commands. Replace the hostname, port, and Agile virtual path with appropriate values for your server.

    ProxyPass /Agile http://server:7777/Agile
    ProxyPassReverse /Agile http://server:7777/Agile

3 Copy the workers.properties and uriworkermap.properties files from the <agile_home>/AgileProxies directory to the $Apache/conf directory.

4 Replace the following tokens in the workers.properties and uriworkermap.properties files:

    @FILE_SERVER_VIRTUAL_PATH@ = File Manager Virtual Path
    @FILE-SERVER-HOST@ = Tomcat hostname or IP address
    @AJP-PORT@ = Tomcat AJP Protocol port (This port can be found in Tomcat’s server.xml file)

5 Add the following lines to the $Apache/conf/httpd.conf file:

    LoadModule jk_module modules/mod_jk-1.2.14-apache-2.0.54.so
    JkWorkersFile conf/workers.properties
    JkMount conf/uriworkermap.properties
Open $Tomcat/conf/jk2.properties and add the following entry:

```properties
channelSocket.port=8009
```

The AJP Port specified above must match the AJP port specified in $Tomcat/conf/server.xml.

```xml
<Connector port="8009"
    maxThreads="150" minSpareThreads="25" maxSpareThreads="75"
    enableLookups="false" redirectPort="8443" debug="0"
    protocol="AJP/1.3" />
```

Restart Apache Tomcat.

Restart Apache Web Server.

```bash
$apache/bin/apachectl stop
$apache/bin/apachectl start
```

### Enabling Debugging Information for the Jakarta Tomcat Connector

To troubleshoot problems with the Apache Web Server proxy for Agile File Manager, you can save debugging information for the Jakarta Tomcat Connector.

To save debugging information for the Jakarta Tomcat Connector:

1. Open the $Apache/conf/httpd.conf, and add the following lines (after the JkMount setting):

   ```
   JkLogFile "logs/mod_jk.log"
   JkLogLevel debug
   ```

2. Save the file.


4. Open the log file and check for errors.

### Logging In to the Agile Web Client

Open your browser and go to the following URL to test the Agile Web client setup:

```
http://webserver_hostname/virtual_folder/PLMServlet
```

**Note** The URL is case-sensitive. The default virtual folder name is Agile. The location must have a public IP address that is externally accessible.

The login window for the Agile Web client appears in the browser.

### Troubleshooting the Agile Web Client

This section provides the basics for troubleshooting the Agile Web client and Web server issues.

### Confirming Accessibility

Confirm that the following connections are valid:

- Ping the Agile Application Server computer to make sure it is accessible from the Agile Web components computer and that the specified port is available.

- Make sure the IIS Web server is up and running on the specified ports, and that the specified DNS hostname is valid and registered for external accessibility by the Agile Web client browsers.
URL Error Messages

If you specify this URL in the browser and receive the message “Page not found,” check the following:

- Make sure that the IIS Web server is accessible.
- Open the iisproxy.ini file and make sure the client virtual path name is the same as the login URL for the Agile Web client.
- Make sure the Agile View Server has started on the host computer.

If the following error message appears:

   “Servlet tunneling to AgileViewServerHost:5099 (IP=x.x.x.x) Connection state: ERROR”

- Check to see if the Agile View Server hostname specified during the installation is correct and the port number is available. The information on the Agile View Server hostname and port number is specified in the web.xml file.
- Make sure the Agile View Server-specific ports are open from DMZ firewall to the internal firewall.

Customized Virtual Path Does Not Work

Check the isisforward.dll and isisproxy.dll files in the AgileProxies folder where the iisproxy.ini file is located. You may need to delete the settings you specified in “Configuring IIS as a Proxy Server for Agile PLM” on page 7-3 and set them up again. Then stop and restart the IIS Admin and Worldwide Web services.

Browser Shows A Proxy Timeout Message

The proxy has a timeout default value of 1500 seconds. If you frequently see this message, you should increase the timeout value to a larger value.

To change the proxy timeout:

1. Open the \<agile_home>\AgileProxies\iisproxy.ini file.
2. Change or add the following line:
   
   ```
   ConnectTimeoutSecs=1500
   ConnectRetrySecs=value must equal ConnectTimeoutSecs
   HungServerRecoverSecs=value greater than ConnectTimeoutSecs
   ```

Sending Large Attachments

You may receive an application error if you attach files larger than 350MB. Generally, you should limit attachment size to less than 100MB. However, increasing the amount of available RAM to at least 1024MB will allow you to send files of at least 250MB.

Log Files (Disk Space)

There are three log files for the Agile Web client:

- OASproxy log
- Proxy log
- Web client log

If all log files are on, disk space can fill quickly. You may need to clean up the log files or turn logging off.

For the OASproxy.log file:

1. Locate the key, HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\IIS Proxy Adapter, in the Windows Registry Editor.
2. Delete the log-level entry in the right pane.
For the proxy log file:

Open the `<agile_home>\AgileProxies\iisproxy.ini` file and remove either of the following lines:

- `Debug=on`
- `Debug=ALL`

For the Agile Web client log file:

1. Open the `<agile_home>\agileDomain\config\log.xml` file.
2. Change the `<priority value="debug" />` line to `<priority value="error" />`.
3. Delete all files with a LOG extension appearing in the `<agile_home>\agileDomain\config` folder.

**Connection Refused or Server is Busy Error Message**

TCP connections can be buffered in a wait queue, which has a default value of 50. To increase this value, open `<agile_home>\agileDomain\config\config.xml` and increase the wait queue attribute value by 25 percent until the messages no longer appear.

**Changing Logging Priority**

You can change the behavior of the information added to the log file for the Agile Web client.

1. Using a text editor, open the `log.xml` file (by default, it is located in `<agile_home>\agileDomain\config` folder).
2. Scroll to the bottom of the file and add the following lines before the `</configuration>` line:

   ```xml
   <category name="com.agile">
   <priority value="error" />
   <appender-ref ref="A1" />
   </category>
   ```

3. Save and close the file.
4. Open a browser and type the following in the **Address** field:

   ```
   http://hostname:portnumber/virtual_folder/PLMServlet?changeLog=true
   ```
CHAPTER 8
Configuring Agile View Server

This chapter describes how to configure, test, and administer Agile View Server, a Java-based file viewer. It includes the following information:

- Overview
- Verifying the Firewall Configuration
- Configuring the Caching View Server
- Starting the View Server
- Testing the VueServlet
- Managing Multiple Agile View Servers for Load Balancing
- Removing Agile View Server
- Troubleshooting the Agile View Server
- Additional Agile View Server Documentation

Overview

Agile View Server allows users to view and mark up documents, drawings, and CAD files using a Web browser such as Microsoft Internet Explorer or Netscape Communicator.

Agile Viewer consists of four installation components:

- Agile View Server
- Agile View servlet
- Agile View applet
- Caching View Server (optional)

Important Do not install Agile View Server on the same Web server with Agile Application Server. Agile View Server must be installed on a separate server inside the firewall with other Agile servers.

Agile View Server requires no maintenance on the client computer. A Web browser downloads the applet from the File Manager and stores it in the browser cache. The next time the Agile Viewer is launched, the applet is loaded from the cache, unless a new version is found on the File Manager.

The Agile View servlet (VueServlet) is packaged and deployed as part of the File Manager installation. The VueLink Servlet is also deployed on the File Manager and tunnels the requests to the Agile Application Server using HTTP protocol. Because of this communication, each File Manager should have an associated View Server on the same machine or separate machines. No additional configuration is required except that specified for the Agile Web client and the caching View Server. The VueServlet is used to access Agile View Server across firewalls from external clients, such as the Agile Web client, on standard HTTP/HTTPS ports.
Caching View Server

The Agile View Server converts files from their native format to a metafile format (CMF). The metafile format is used to render the 2D/3D images from the cache. These files are approximately 20% the size of the source files which helps to improve View Server performance.

There are two types of metafile caching; on-demand and offline. On-demand caching occurs in the background when a user views a file in the Agile Viewer. Offline caching occurs without any user intervention through a caching utility located on the File Manager.

During offline caching, the files are translated on a dedicated caching view server. The Agile View Server should not be used for offline caching as performance can be impacted. So, the caching view server should not be installed on the same machine as the Agile View Server. Also, offline metafile caching is only supported on the primary File Manager. Distributed file managers installed in remote locations cannot use offline caching.

Client Requirements

Client computers require a Java-compatible browser (this includes Netscape Navigator 7.1, Internet Explorer 6.0 with SP1) running on Windows 2000 Professional with SP4 or Windows XP Professional. Additionally, Java clients require JRE 5.0.

Netscape users may receive security warning dialog box that the Agile Viewer client is requesting privileges that are usually granted for plug-ins, even though a plug-in is not required. This is a shortcut for enabling a set of permissions that the applet needs to work properly.

Architecture

Agile View Server was designed to provide server scalability to support increasing demand for file viewing and markup on intranets and the Internet. The system allows you to add servers to support more users while the servers are online without restarting or disconnecting existing servers. Doubling the capacity is as simple as adding one more computer. When you use multiple Agile View Servers, the load is efficiently balanced across the Agile Viewer server cluster. The servers automatically divide up the load in a “peer-to-peer” fashion to avoid any bottlenecks.

Agile View Server embeds several different rendering schemes to accommodate multiple environments. These schemes allow the server to take into account issues such as network bandwidth, load balancing between server and client, server configuration and performance, intranet/extranet/Internet use, and file size and format to be viewed. However, in all rendering options, Agile View Server keeps all necessary information for querying purposes; the “intelligence” of drawings is preserved. For example, users can perform text searches on text and CAD files, or perform queries based on drawing attributes in a CAD file.

Depending on your network configuration (for example, existing firewalls, DMZ, secure connections, and proxy servers), a client is able to connect to the Agile View Server using direct sockets or the HTTP/HTTPS protocol (through a Java servlet) and avoid any security breach in your system.

Security

During the viewing process, documents available for viewing are rendered on the Agile View Server, and an intelligent and displayable data stream is delivered to the client. In this way, the Agile View Server implementation eliminates any concerns about security since the original document is not transferred to the client computer. While the viewable data is being transmitted, Agile View Server uses compression and streaming algorithms to achieve a quick and responsive feedback to the client side for large and multi-page documents.

The server has complete control over the functions available to clients. For example, users may be granted or denied rights to perform printing, redlining, or any other functions depending on their access permissions.
Agile View Server uses cookies to track the number of users on an Agile View Server. The cookie is a unique number assigned to each browser that defines a user as a single session, regardless of the number of files a user consecutively or simultaneously opens.

**Note** If you disable or refuse cookies in your browser, Agile View Server will continue to work. However, each new instance of the browser creates a new session in Agile View Server.

Netscape users receive a security warning dialog box when accessing Agile View Server. You must leave this permission enabled for the Agile View Server applet to function properly. If you disable the permission, Netscape users cannot connect to the Agile View Server.

**Note** These permissions are valid only for the current session and must be re-enabled each time if you do not check the Remember that decision box in the warning dialog box.

HTTPS can be used for secure communications if you tunnel all communications between the Agile Viewer client and the Agile View Server through HTTPS, which uses SSL. The applet must communicate with the Agile View Server through the Agile View Server servlet. Any Agile View Server communications that are tunneled are encrypted using SSL.

### Verifying the Firewall Configuration

The firewall on the Agile PLM side must be configured to allow:

- Incoming HTTP/HTTPS connections from the Internet to the Web server.
- Outgoing TCP/IP connections from the Web server in the DMZ to the Application Server inside the firewall on port 7001 or 7002 (SSL) for BEA WebLogic, port 7777 or 8888 (SSL) for Oracle Application Server, or port 9080 or 9081 (SSL) for WebSphere Application Server.

### Configuring the Caching View Server

**To configure the Caching View Server for offline caching:**

1. Start the Agile Application Server.
2. Start the Agile Java Client, as described in “Installing and Configuring Agile Java Client” on page 11-1.
3. Log in as an Agile Administrator user.
4. Click the Admin tab.
5. Choose Server Settings > Locations. The Server Location window appears.
6. Click the File Manager tab to bring it forward.
7. Double-click the entry to display the File Manager dialog box.
8. Click the Advanced button.
10. Type the host name and port number of the caching view server in the designated fields.
11. Click OK when done.

### Starting the View Server

**To start the View Server on Windows:**

Start the Agile View Server service or choose Start > All Programs > Agile Advanced View Server > Start AutoVue SolidModel Server.
To start the View Server on Solaris or Linux:

1. In a console window, go to the `<agile_home>/AVS/bin` directory.
2. Type the following command to initialize the server:
   
   `jvueserver &`

### Testing the VueServlet

**Note** The Agile View servlet (VueServlet) is packaged and deployed as part of the File Manager installation. The VueServlet is used to access Agile View Server across firewalls from external clients on standard HTTP/HTTPS ports.

The Agile View servlet (VueServlet) is packaged and deployed as part of the File Manager installation. The VueServlet is deployed on the File Manager and tunnels the requests to the Agile Application Server using HTTP protocol. No additional configuration is required.

The VueServlet is used to access Agile View Server across firewalls from external clients on standard HTTP/HTTPS ports.

On the Application Server, you must make sure that the VueServlet has been loaded from the Agile Viewer home directory and that the VueServlet communicates with the Agile View Server. Open a browser and type the following URL in the location bar:

```
http://FileManager_hostname or LoadBalancer:port/Filemgr/VueServlet
```

A message should appear indicating that JVueServer is up and running. The sample page should appear that includes information about servlet tunneling and licensing.

- On Windows, if you receive the message “The page cannot be displayed,” make sure the World Wide Web server service is running on the computer. If it is not running, start the service from the Services window.
- If you specify this URL in the browser and receive the message “Page not found,” check the following:
  - Make sure that the Web server is accessible.
  - On Windows, open the isproxy.ini file and make sure the client virtual path name is the same as the login URL for the Agile Web client.
  - Make sure the Agile View Server has started on the host computer.

### Managing Multiple Agile View Servers for Load Balancing

Agile View Server is designed to provide server scalability to support increasing demand for file viewing and markup on intranets and the Internet. It can run in a process pool on a single computer that improves the responsiveness for simultaneous connections and balances the load across a multi-CPU computer.

The default process pools four concurrent services. It is specified in the `jvueserver.properties` file located in the Agile View Server home folder at `\<agile_home\>\AVS\bin`:

```
jvueserverx.nt.processPoolSize=4
```

As a general rule, you should allow approximately 50 MB for each process in the pool. A process pool size of four services requires approximately 200 MB of RAM; on a computer with 256 MB of RAM, this allows the remaining RAM to run the operating system and other services. Increasing the RAM on a computer allows you to increase the number of services using the process pool.

The system allows you to add servers to support more users while the servers are online, without restarting or disconnecting existing servers. Doubling the capacity is as simple as adding another computer. When using multiple Agile View Servers, the load can be efficiently balanced across the servers by manually directing the Viewer client requests to different View Servers.

Dynamic and static load balancing are supported. For more information, see the *AutoVue Client-Server Edition Installation and Administration Manual* mentioned in “Additional Agile View Server Documentation” on page 8-7.
Multiple Agile View Servers functionality must be configured as follows:

- Each Agile View Server computer acts independently.
- Each Agile View Server computer can point to the same Agile Application Server computer or to a different Agile Application Server computer in a single or distributed Agile PLM system.
- The Agile View Servers are not clustered, so there is no single entry point computer for all Java clients to connect into any Agile View Server.

For Agile Web clients outside the corporate firewall, the functionality for multiple Agile View Servers must be configured as follows:

- The Agile Viewer client applet can communicate across firewalls on a standard HTTP/HTTPS port.
- Each Agile View Server computer acts independently.
- Each Agile View Server computer can point to the same Agile Application Server computer or to a different Agile Application Server computer in a single or distributed Agile PLM system.
- External Agile Web clients are given different URLs that point to different Web servers hosting an Agile Web client with an Agile Viewer client and an Agile View servlet. In turn, each Agile Viewer client and Agile View servlet points to the different Agile View Server to distribute the load.
- The Agile View Servers are not clustered, so there is no single entry point computer for all Agile Web clients to connect into any Agile View Server.

To configure Agile View Server and Agile Viewer client communication across firewalls on specific ports, you should use standard HTTP ports.

Client-Server Communications

For Agile View Server, the issue of using IP addresses for client-server communication at runtime (rather than hostnames or DNS names) is resolved because the Application Server also hosts the VueServlet. The VueServlet acts as a proxy for Agile View Server, and it is placed on the intranet with other Agile server components. In addition, since the VueServlet is running on the Application Server with an Agile Web client, the Web server proxies also forward external requests to the intranet. The VueServlet comes as part of the File Manager installation.

Removing Agile View Server

Follow these instructions to remove Agile View Server.

To remove the Agile View Server on Windows:

1. Stop the Agile View Server service.
   a. Open the Services dialog box.
   b. Select Agile View Server and stop the service.
   c. Close the Services dialog box.
2. Choose to Start > Settings > Control Panel.
3. Double-click Add/Remove Programs.
   The Add/Remove Programs Properties dialog appears.
4. Scroll down the window and select AutoVue Client-Server Edition.
5. Click Change/Remove.
6. Click Uninstall, and click OK to confirm the deletion.
7. Click Exit.
To remove Agile View Server from the Start menu:
1. Choose Start > All Programs > Agile Advanced View Server > Setup > Uninstall AutoVue SolidModel for Java.
2. Select and delete the installation folders from the location of Agile home directory.

Troubleshooting the Agile View Server

This section contains information for troubleshooting your Agile View Server installation.

View Server Errors

This section describes the errors that you may encounter when using Agile View Server.

Java Client or the Web Client Cannot Connect

If you receive the following error messages when the Java client or the Web client tries to start Agile View Server, follow the directions provided in the solution:

- “jVue not found” appears because of the following:
  - Web server is down.
  - Incorrect Web server name.
  - Incorrect Web server port.
  - Incorrect client applet alias specified instead of mandatory “jVue.”

  **Solution:** Confirm that the Web server is running.

- “An error occurred while connecting to the server. Restart the applet?” appears because of the following:
  - Agile View Server is down.
  - Incorrect Agile View Server name.
  - Incorrect Agile View Server port.
  - Incorrect proxy server name.
  - Incorrect proxy server port.

  **Solution:** Confirm that the Agile View Server and proxy server are running.

**Important** If either of these errors occur, make sure that Agile File Manager locations are configured correctly in the Agile Java Client. See “Configuring the File Manager” on page 6-4.

File Manager is Not Available

If you receive the following error message when the Java client or the Web client tries to connect to a file manager, follow the directions provided in the solution:

- “File not found” appears because of the following:
  - The file manager is down.
  - The VueServer.ini file points to incorrect file manager.

  **Solution:** Confirm that the file manager is up and running.

Font Not Appearing Correctly

If an attachment uses special fonts, the computer where View Server is installed must have those special fonts installed locally. Otherwise, a file error may occur or an incorrect font substitution may occur with viewing or printing the attachment.
Changing Port Numbers

Some Agile View Server port numbers can be changed in the event of a port conflict. It is important to change the port number in all referenced locations.

- Port 5099 is used for communication between Agile View Server and Viewer clients.
  
  For Agile View Server, go to the `\<agile_home>\AVS\bin` folder and open the `jvueserver.properties` file. Locate the following port information:
  
  ```
  # * Socket port number
  jvueserver.socket.port=5099
  ```
  
  You can change port 5099 to another available port number.

- Port 2001 is used for RMI.
  
  For Agile View Server, go to the `\<agile_home>\AVS\bin` folder and open the `jvueserver.properties` file. Locate the following port information:
  
  ```
  # * RMI Registry port number
  jvueserver.rmi.port=2001
  ```
  
  You can change port 2001 to another available port number.

Additional Agile View Server Documentation

On the computer where you installed Agile View Server, the *AutoVue Client-Server Edition Installation and Administration Manual* (install.pdf) is installed in the following location:

`<agile_home>\AVS\docs`

Please refer to the *AutoVue Client-Server Edition Installation and Administration Manual* for the following information:

- How to use the AutoVue Server Console.
- How to enable debugging information (logging) for the Agile View Server.
- How to further configure the Agile View Server.
CHAPTER 9

Configuring the Microsoft Excel-based Client for Agile PG&C

This chapter describes how to configure the Microsoft Excel-based client for Agile Product Governance & Compliance. It includes these topics:

- Overview of the Microsoft Excel-based Client for Agile PG&C
- Microsoft Excel-based Client FAQ
- Configuration Sequence
- Setting Privileges for Agile Product Governance & Compliance Objects
- Restricting the Length of Declaration Names
- Deploying License Files for the Agile PLM ActiveX Control
- Using the Developer Version of the Microsoft Excel Integration License File
- Digitally Signing the Agile PLM ActiveX Control
- Enabling Downloading of Productivity Components
- Installing the Agile PLM ActiveX Control
- Testing the Microsoft Excel-based Client for Agile PG&C
- Troubleshooting

Overview of the Microsoft Excel-based Client for Agile PG&C

Important  Configuration steps described in this chapter apply only to customers that have purchased Agile Product Governance & Compliance.

Agile Product Governance & Compliance (PG&C), one of the Agile PLM product solutions, is designed to help manufacturers audit the presence and amount of regulated substances used in their products, and to demonstrate that they responsibly dispose of, recycle, or reuse parts containing those substances. Agile PG&C includes built-in support for the Microsoft Excel-based client for OEM manufacturing regulations, including the Japan Green Procurement Survey Standardization Initiative (JGPSSI), and substance and weight rollups.

Important  Although Agile provides two Microsoft Excel templates for Agile PG&C, the solution is extensible. You can develop other Microsoft Excel templates to handle other Declaration classes your company has defined. For information about how to develop Microsoft Excel templates for use with Agile PG&C, contact your Agile Solutions Delivery representative.
**JGPSSI Support**

JGPSSI has created a standardized digital form that companies can use to inquire about the chemical substances contained in parts and materials they procure in Asia. For more information about JGPSSI, see the Japan Electronics and Information Technology Industries Association Web site:

http://home.jeita.or.jp/eps/greenTOP-eg.html

JGPSSI uses Microsoft Excel tools for collecting information about substances contained in assemblies for Japanese Green Procurement. Agile provides a flexible and reusable integration between Agile PG&C and Microsoft Excel that allows customers to use the JGPSSI spreadsheet without modification, and then upload the information to Agile PG&C after validation.

*Note* Agile PLM supports the JGPSSI survey tool (a Microsoft Excel template) version 2.02.

**Substance and Weight Rollups**

You can use Microsoft Excel to perform analysis of the Bill of Substances (BOS) information for an assembly. Using an Actions menu command, the integrated Excel spreadsheet can roll up the substances and weights for the top-level assembly.

**Client Software Requirements**

The Microsoft Excel-based client for Agile PG&C requires the following client-side software:

**Operating System**

- Windows 2000 Pro SPX or Windows XP Pro SP2

**Client Applications**

- Microsoft Excel 2000, Microsoft Excel XP, or Microsoft Excel 2003
- Microsoft Internet Explorer 5.5 or 6.0

For complete Agile PLM software requirements, see the *Agile PLM Capacity Planning and Deployment Guide*.

**Microsoft Excel-based Client FAQ**

This section answers some common questions about the Microsoft Excel-based client for Agile PG&C.

**How does the Microsoft Excel-based client work? What’s the underlying technology used to integrate with Agile PG&C?**

The Microsoft Excel-based client uses the following technology:

- **Agile PLM Process Extensions** – The Agile Web Client launches the Microsoft Excel-based client through process extensions, which are programs that extend the functionality of the client interface.
- **Agile PLM ActiveX Control** – an Internet Explorer plugin that monitors use of the Microsoft Excel-based client and downloads and uploads data from the Agile PLM server as requested by the client.
- **HTTP, HTTPS, or SMTP** – standard protocols used to move data between the server and the client
- **Microsoft Excel** – spreadsheet client with its own client-side business logic.

**Other than Microsoft Excel, is any other client software required for the Microsoft Excel-based client?**

The Agile PLM ActiveX Control, an Internet Explorer plugin, is required. It’s downloaded and installed automatically the first time a user launches the Microsoft Excel-based client from the Agile Web Client. Of course, Internet Explorer 5.5 or 6.0 is also required, as well as a Windows operating system.
What Microsoft Excel templates does Agile PG&C provide by default?
There are two Excel applications provided out-of-the-box with Agile P&C:

- JGPSSI Declaration application – supports Japanese Green Procurement
- Rollup In Excel application – calculates substance and weight rollups for top-level assemblies

Can I create new Microsoft Excel templates for use with Agile PG&C?
Yes, the solution is extensible. For information on how to develop Microsoft Excel templates for Agile PG&C, contact your Agile Solutions Delivery representative.

Can I create Microsoft Excel templates for use with other Agile PLM solutions, such as Product Collaboration?
No. Currently, only Declaration classes and their subclasses are supported. Other classes may be supported in future Agile PLM releases.

Can I use the Firefox browser to launch the Microsoft Excel-based client?
No. Only Microsoft Internet Explorer 5.5 or 6.0 are supported.

Must I be logged into the Agile Web Client to use the Microsoft Excel-based client for Agile PG&C?
No. You can use the Microsoft Excel-based client synchronously (that is, by opening a spreadsheet from the Agile Web Client) or asynchronously (that is, by opening a spreadsheet attached to an email message).

How do I launch the Microsoft Excel-based client from the Agile Web Client?
Agile PLM process extensions are used to launch the Microsoft Excel-based client. The process extensions are initiated from the Actions menu of Declaration objects. For information about developing process extensions, see the Agile SDK Developer Guide.

Can I sign the Agile PLM ActiveX Control with my company’s certificate?
Yes. See “Digitally Signing the Agile PLM ActiveX Control” on page 9-7.

Does the Microsoft Excel-based client require any special authentication?
The Microsoft Excel-based Client uses the same credentials that you use to log into the Agile Web Client, and it prompts you to log into a separate Agile PLM session when you choose Agile > Submit Response or Agile > Open Request.

Where does the client-side business logic for the Microsoft Excel-based client reside?
Client-side business logic resides entirely in the Microsoft Excel template.

How does the Microsoft Excel-based client handle notifications for Declarations?
Agile PLM provides four system-generated notifications related to the Microsoft Excel-based client:

- Declaration Excel Submit Success Supplier Notification – notification sent to the supplier to confirm successful submission of a Declaration.
- Declaration Excel Submit Import Failure – notification sent to the compliance manager or originator to inform him that the submitted Declaration failed to be processed on the server due to import problems.
- Declaration Excel Submit Failure – notification sent to the compliance manager or originator to inform him that the submitted Declaration failed to be processed on the server due to an exception.
- Declaration Excel Submit Failure Supplier Notification – notification sent to the supplier to inform him that the Declaration failed to be submitted due to import errors.

Each notification includes text for the subject and body of a message. The Agile PLM administrator can modify these notification messages.
To customize these notifications, start the Agile Java Client and log in as an administrator user. Click the **Admin** tab, and choose **System Settings > Notifications > Declaration Notifications**. Microsoft Excel-based client notifications are listed under “Declaration Miscellaneous Notifications.”

For more information about Agile PLM notifications, see the *Agile PLM Administrator Guide*.

**What languages does the Microsoft Excel-based client support?**

The JGPSSI and Rollup in Excel standard templates support English only. Other templates can be developed to support other languages.

Microsoft Excel-based client messages and captions support all languages supported by Agile PLM 9.2.1. Additionally, the menus of Microsoft Excel templates can be customized for different languages.

**Does the Microsoft Excel-based client use VBA macros?**

The Microsoft Excel templates provided for Agile PG&C do not use VBA macros. Although you are not prevented from developing a Microsoft Excel template that uses VBA macros, antivirus software may prevent the macros from running, and you should set the security level in Microsoft Excel to at least Medium (choose **Tools > Macro > Security**).

**Configuration Sequence**

To enable support for the Microsoft Excel-based client for Agile PG&C, you must perform the following manual configuration steps after Agile PLM has been installed:

1. Set up privileges for Agile PG&C objects (such as Substances and Declarations).
2. Restrict Declaration names to no more than 50 characters for every class that you are enabling the Microsoft Excel-based client.
3. Obtain a production license for the Agile PLM ActiveX Control from your Agile Account Executive and deploy the related files on the Agile Application Server.
4. Optionally, digitally sign the Agile PLM ActiveX Control.
5. Use Agile Java Client to set the **Allow Download of Productivity Components** preference to Yes. This allows Agile Web Client users to download the Agile PLM ActiveX Control from the server.

**Setting Privileges for Agile Product Governance & Compliance Objects**

This section describes how to set privileges for Agile PG&C objects. If you don’t ensure that privileges are properly set, you may not be able to move data from the JGPSSI spreadsheet into Agile PLM and vice versa.

**To set privileges for Agile PG&C objects:**

1. Log into Agile Java Client as a user with Administrator privileges.
2. Click the **Admin** tab.
3. Choose **User Settings > Privileges**.
4. Open the following privilege masks, and for each one click the drop-down arrow next to the **Applied To** field and add the following attributes:

<table>
<thead>
<tr>
<th>Privilege Mask</th>
<th>Attributes to Add to the Applied To Field</th>
</tr>
</thead>
<tbody>
<tr>
<td>Read Substances</td>
<td>Substances.Page Two.Text01</td>
</tr>
<tr>
<td>Modify Substances</td>
<td>Substances.Page Two.Text25</td>
</tr>
</tbody>
</table>
5 After modifying the Applied To field for each of the privilege masks listed above, click **OK**.

6 To save the privilege mask, click **Save**.

7 Click **Close**.

### Restricting the Length of Declaration Names

Agile’s Microsoft Excel-based client requires Declaration names to not exceed 50 characters. If a Declaration has a name longer than 50 characters, you might not be able to open it in Microsoft Excel.

To avoid potential problems opening Declarations with long names, you should restrict Declaration names to 50 characters for every class that you are enabling the Microsoft Excel-based client. You can do this by making autonumbers required (assuming that each number in the autonumber sequence does not exceed 50 characters) or by adjusting the maximum length of the **Cover Page > Reference Number** attribute.

**To make autonumbers required for a Declaration subclass:**

1 Log into the Agile Java Client as an administrator.

2 Click the **Admin** tab.

3 Under **Data Settings**, double-click **Classes**.

4 Open a Declaration subclass that has enabled the Microsoft Excel-based client (for example, JGPSSI Declaration).

5 Select the **General Information** tab.

6 In the **Autonumber Required** list, select Yes.

7 In the **Autogenerate** list, select Yes.

8 Click **Save**.

---

**Table 9-1: Modifying privileges for Agile PG&C objects (continued)**

<table>
<thead>
<tr>
<th>Privilege Mask</th>
<th>Attributes to Add to the Applied To Field</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modify Supplier Created Declarations</td>
<td>Declarations.Page Two.Text02, Text03, Text08 – Text10, Text14, Text19 – Text21</td>
</tr>
<tr>
<td>Read Declarations</td>
<td>Declarations.Items.Date01</td>
</tr>
<tr>
<td>Read My Open and Submitted Declarations</td>
<td>Declarations.Items.List01 - List03</td>
</tr>
<tr>
<td>Read Supplier Created Declarations</td>
<td>Declarations.Items.Text01 - Text09</td>
</tr>
<tr>
<td>Modify Declarations</td>
<td>Declarations.Manufacturer Parts.Date01</td>
</tr>
<tr>
<td>Modify My Open Declarations</td>
<td>Declarations.Manufacturer Parts.List01 - List03</td>
</tr>
<tr>
<td></td>
<td>Declarations.Manufacturer Parts.Text01 - Text09</td>
</tr>
<tr>
<td></td>
<td>Declarations.Part Groups.Date01</td>
</tr>
<tr>
<td></td>
<td>Declarations.Part Groups.List01 - List03</td>
</tr>
<tr>
<td></td>
<td>Declarations.Part Groups.Text01 - Text09</td>
</tr>
<tr>
<td></td>
<td>Declarations.Page Two.Text14, Text19 – Text21</td>
</tr>
<tr>
<td></td>
<td>Declarations.Items.Date01</td>
</tr>
<tr>
<td></td>
<td>Declarations.Items.List01 - List03</td>
</tr>
<tr>
<td></td>
<td>Declarations.Items.Text01 - Text09</td>
</tr>
<tr>
<td></td>
<td>Declarations.Manufacturer Parts.Date01</td>
</tr>
<tr>
<td></td>
<td>Declarations.Manufacturer Parts.List01 - List03</td>
</tr>
<tr>
<td></td>
<td>Declarations.Manufacturer Parts.Text01 - Text09</td>
</tr>
<tr>
<td></td>
<td>Declarations.Part Groups.Date01</td>
</tr>
<tr>
<td></td>
<td>Declarations.Part Groups.List01 - List03</td>
</tr>
<tr>
<td></td>
<td>Declarations.Part Groups.Text01 - Text09</td>
</tr>
</tbody>
</table>

---

9-5
To adjust the maximum length of Declaration names:

1. Log into the Agile Java Client as an administrator.
2. Click the Admin tab.
3. Under Data Settings, double-click Classes.
4. Open a Declaration class that has subclasses that have enabled the Microsoft Excel-based client (for example, JGPSSI Declarations).
5. Click the User Interface Tabs tab.
7. Click the Attributes: Cover Page tab.
8. Double-click the Reference Number attribute.
9. Set the MaxLength property to 50 or less.
10. Click Save.

Deploying License Files for the Agile PLM ActiveX Control

To enable support for the Microsoft Excel-based client for Agile PG&C, you must obtain a valid license for the Agile PLM ActiveX Control, an Internet Explorer plugin. This license is specific to the server on which the Agile Application Server is installed. To obtain the license file (license.xml) and a properties file (properties.js), contact your Agile Account Executive.

After you obtain the license file and properties file, you need to deploy the files on the Agile Application Server.

Note: If you have an application server cluster, you must deploy the Agile PLM ActiveX Control license files on the Repository Host server for Oracle Application Server or the Administration Server for WebLogic Server. The application server will then propagate the license files to other servers in the cluster.

To deploy license files for the Agile PLM ActiveX Control:

1. Stop the Web proxy server.
2. Stop the Agile Application Server.
3. Windows: On the application server computer, open a command prompt window.
   Solaris or Linux: On the application server computer, open a terminal window and log on as the user who installed the Agile Application Server.
4. Expand the Agile application.ear file:
   
   Windows: \<agile_home>\install\bin\ExtractArchive.cmd
   Solaris or Linux: /<agile_home>/install/bin/ExtractArchive.sh
5. Copy the license.xml and properties.js files that you received from Agile to the following location:
   \<agile_home>\agileDomain\applications\ExpandedEar\ExpandedWar\ambassador
6. Repack the Agile application.ear file:
   
   Windows: \<agile_home>\install\bin\RepackArchive.cmd
   Solaris or Linux: /<agile_home>/install/bin/RepackArchive.sh
7. Undeploy the Agile application, and then redeploy it.
   
   Windows:
   \<agile_home>\agileDomain\bin\UnDeployAgile.cmd
   \<agile_home>\agileDomain\bin\DeployAgile.cmd
Solaris or Linux:

/\agile_home/\agileDomain/bin/UnDeployAgile.sh
/\agile_home/\agileDomain/bin/DeployAgile.sh

8 Start the Agile Application Server.
9 Start the Web proxy server.

**Using the Developer Version of the Microsoft Excel Integration License File**

If you are developing or testing Microsoft Excel templates for Agile PLM Declaration classes, you can use the developer version of the Microsoft Excel integration license file that is installed with the Agile PLM server. The developer license for the Agile PLM ActiveX Control provides the same functionality as the production license. However, when you install it, a warning message appears: “An UNTRUSTED web site is trying to use Agile PLM ActiveX Control to control your desktop.” Click **Yes** in the warning dialog box to continue installing the control.

**Digitally Signing the Agile PLM ActiveX Control**

The first time you choose one of the commands that launch the Microsoft Excel-based client (such as **Actions > Open In Excel**) in the Agile Web Client, the Agile PLM ActiveX Control is automatically downloaded and installed on your computer. For security reasons, Internet Explorer requires that software it downloads must have a digital signature. A digital signature lets you verify the contents of a file and ensures that it comes from a trusted source.

When you install Agile PLM, the Agile PLM ActiveX Control is already digitally signed from Agile Software. You can choose to use your company’s own digital signature for the control instead. If you use your company’s digital signature, each time a user of your Agile PLM system downloads the Agile PLM ActiveX Control it will be recognized as coming from your company and not from Agile Software.

You provide a digital signature by purchasing a certificate from a certificate authority. A certificate authority is an entity that issues digital certificates for use by other parties. Examples of certificate authorities are Verisign (http://www.verisign.com/) and CAcert (http://www.cacert.org/).

For more information about digital signatures, go to the MSDN site (http://msdn.microsoft.com/) and search for “Digitally Signing ActiveX Components”.

**To digitally sign the Agile PLM ActiveX Control:**

1 Stop the Web proxy server.
2 Stop the Agile Application Server.
3 **Windows:** On the application server computer, open a command prompt window.
   **Solaris or Linux:** On the application server computer, open a terminal window and log on as the user who installed the Agile Application Server.
4 Expand the Agile application.ear file
   **Windows:** `\agile_home\install\bin\ExtractArchive.cmd`
   **Solaris or Linux:** `/\agile_home/\install/bin/ExtractArchive.sh`
5 Digitally Sign the agileambassador.cab file found in the following location:
   `\agile_home\agileDomain\applications\ExpandedEar\ExpandedWar\ambassador`
6 Repack the Agile application.ear file
   **Windows:** `\agile_home\install\bin\RepackArchive.cmd`
   **Solaris or Linux:** `/\agile_home/\install/bin/RepackArchive.sh`
7  Undeploy the Agile application, and then redeploy it.

    Windows:
    \<agile_home>\agileDomain\bin\UnDeployAgile.cmd
    \<agile_home>\agileDomain\bin\DeployAgile.cmd

    Solaris or Linux:
    /<agile_home>/agileDomain/bin/UnDeployAgile.sh
    /<agile_home>/agileDomain/bin/DeployAgile.sh

8  Start the Agile Application Server.

9  Start the Web proxy server.

**Enabling Downloading of Productivity Components**

The Agile PLM ActiveX Control is a plugin for Microsoft Internet Explorer that users can download to their client machines. To enable downloading of the Agile PLM ActiveX Control from the server, the Agile PLM administrator must log into the Agile Java Client and make sure the Agile PLM preference named *Allow Download of Productivity Components* is set to Yes. Otherwise, users won’t be able to download the ActiveX control and use the Microsoft Excel-based client.

- **Note** The Agile PLM ActiveX Control is supported only on the Microsoft Internet Explorer browser. You cannot use it with other browsers, such as Firefox.

**To enable downloading of the Agile PLM ActiveX Control:**

1  Log into Agile Java Client as a user with Administrator privileges.

2  Click the *Admin* tab.

3  Choose *Server Settings > Preferences*.

4  For the **Allow Download of Productivity Components** preference, select Yes.

5  Click *Save*.

For more information about setting Agile PLM preferences, see the *Agile PLM Administrator Guide*.

**Installing the Agile PLM ActiveX Control**

If you enable downloading of the Agile PLM ActiveX Control (see the previous section), the plugin is installed automatically on the client computer when you choose a command (such as **Actions > Open In Excel**) that launches the Microsoft Excel-based client. Separate installation of the plugin is unnecessary.

Some companies have strict security procedures that prohibit users from installing ActiveX controls automatically onto their desktop computers. If that is the case with your company, your IT department can install the Agile PLM ActiveX Control by downloading an installer for the plugin from the Agile Support site (http://support.agilesoft.com).

**Testing the Microsoft Excel-based Client for Agile PG&C**

This section describes how to test whether the Microsoft Excel-based client works properly.

**To test JGPSSI Declarations:**

1  In Agile Web Client, choose **Create > Declarations > JGPSSI Declarations**.

2  Specify a supplier. Also, make sure the **Continue Creation in Wizard** box is checked. Click **Continue**.

3  In the **Compliance Manager** field, select a user who is a compliance manager.
4 In the Workflow field, select Default Declarations. Click Next.

5 On the Add Specifications page, click Next.

6 On the Add Items page, click Add to add an item. Type an existing item number and click OK.

7 Click Finish.

8 Choose Actions > Open in Excel.

After a moment, a Security Warning dialog box appears.

9 Make sure the Always trust content from Agile Software Corporation box is checked. Click Yes to install and run the Agile PLM ActiveX Control (also called Agile Ambassador).

10 After a moment, Microsoft Excel is launched and a file with the name declaration_number.xls is opened. You are prompted to save the file to a folder on your desktop called Material Declaration Requirements. Click Save.

11 Close Microsoft Excel and return to the Agile Web Client.

12 For the new JGPSSI Declaration you created, click Next Status to open it to the supplier.

13 Select users to notify, and click OK.

14 Click the Exit button to log out.

15 Click Login. Log in as a contact user for the supplier associated with the JGPSSI Declaration.

16 Click the link to the JGPSSI Declaration to open it.

17 In the Navigation pane, click Open In Excel.

18 After a moment, Microsoft Excel is again launched and the same file as earlier is opened. You are prompted to save the file to a folder on your desktop called Material Declaration Requirements. You’ve already save it earlier, so click Cancel.

19 Fill in a one or more fields on the sheet. For example, change the value of the Parts Mass field.

20 Save the Microsoft Excel file.

21 Choose Agile > Submit Response.

The Submit Response window appears.

22 Type your approval password, and click Submit.

23 Wait while your response is uploaded. After a minute, a message box should appear: “Your response was successfully submitted for processing.” Click OK.

To test Substance and Weight Rollups:

1 In Agile Web Client, open a part that is a top-level assembly with multiple substances.

2 Choose Actions > Rollup in Excel.
3 Select a Specification, and click **OK**.

The Microsoft Excel file with the same filename as the part number should appear, showing the rolled up amounts for materials and substances used in the assembly.

**Troubleshooting**

This section provides solutions to problems you may encounter in configuring the Microsoft Excel-based client for Agile PG&C.

**Import and Error Logs**

Import and error logs for the Microsoft Excel-based client can be found in the server’s Temp folder.

On Windows 2000/2003 servers, the Temp folder is usually found at

- `C:\Documents and Settings\<current_logged_in_user>\Local Settings\Temp\AgileEITemp`
- `C:\Winnt\Temp\AgileEITemp`

If you are unsure where to find the Temp folder, open a Command Prompt window and type the following command:

```
cd %temp%\AgileEITemp
```

On Solaris or Linux servers, the Temp directory is usually found at

```
/var/tmp/AgileEITemp
```

The most recent folder under AgileEITemp contains data and import or error logs of the last submission done in Excel.

**Runtime error**

When you choose any command that launches the Microsoft Excel-based client (such as **Actions > Open In Excel**) in the Agile Web Client, a Runtime Error window appears.

**Solution:**

The license files for the Agile PLM ActiveX Control, which are located on the Agile Application Server, are invalid. Please contact Agile Support to request new license files. Once you receive the files, you must deploy them on the application server. See “Deploying License Files for the Agile PLM ActiveX Control” on page 9-6.

**This feature has not been enabled by the application administrator**

When you choose a command that launches the Microsoft Excel-based client (such as **Actions > Open In Excel**) in the Agile Web Client, the popup window reads, “This feature has not been enabled by the application administrator.” Consequently, the Agile PLM ActiveX Control could not be downloaded.

**Solution:**

In the Agile Java Client, set the Agile PLM preference **Allow Downloading of Productivity Components** to Yes. See “Enabling Downloading of Productivity Components” on page 9-8.
The page cannot be displayed

When you choose a command that launches the Microsoft Excel-based client (such as Actions > Open In Excel) in the Agile Web Client, the popup window reads, “The page cannot be displayed.”

Solution:

❑ Make sure the Web proxy server is running.

Instead of opening a Microsoft Excel file, the Agile Web Client login page appears in another window

When you choose any command that launches the Microsoft Excel-based client (such as Actions > Open in Excel) in the Agile Web Client, the Microsoft Excel file doesn’t appear and instead a new browser window opens with the Agile Web Client login page.

Solution:

❑ Make sure the Agile Web Client login page you’re using has the fully qualified domain name for the server in the URL. For example, if the fully qualified domain name of the server is “plm.mycompany.com”, the Agile Web Client login page URL should look like this:

   http://plm.mycompany.com/Agile/PLMServlet

❑ Make sure the Agile PLM ActiveX Control license file (license.xml) uses a fully qualified domain name for the Agile Application Server.

The Open In Excel pop-up window appears and then closes, but Microsoft Excel doesn’t launch

When you choose any command that launches the Microsoft Excel-based client (such as Actions > Open in Excel) in the Agile Web Client, the Open In Excel pop-up window appears for a few seconds, and then it closes without launching Microsoft Excel.

Solution:

The Declaration you’re trying to open has a very long name. Choose Actions > Save As to save the Declaration with a name that is 50 characters or less.

To avoid this problem, restrict Declaration names to 50 characters. See “Restricting the Length of Declaration Names” on page 9-5.

The Actions menu does not include commands to launch the Microsoft Excel-based client

When you open a Part object in the Agile Web Client, the Rollup in Excel command isn’t available on the Actions menu. When you open a JGPSSI Declaration in the Agile Web Client, the Open In Excel, Import JGPSSI, and Export JGPSSI commands aren’t available on the Actions menu.

Solution:

The Agile PG&C process extensions have not been assigned to Agile PLM classes. The Agile PG&C process extensions are assigned automatically to classes when Agile PLM is installed, but perhaps the Administrator modified the classes and inadvertently unassigned the Agile PG&C process extensions.
Here is how the Agile PG&C process extensions should be assigned:

- The Rollup In Excel process extension should be assigned to the Parts class.
- The Open In Excel, Import JGPSSI, and Export JGPSSI process extensions should be assigned to the JGPSSI Declarations class.

For information on how to assign process extensions to classes, see the Agile PLM Administrator Guide.

### The cell or chart you are trying to change is protected and therefore read-only

When you open a JGPSSI Declaration in Microsoft Excel and try to edit one of the cells, you see the following error message: “The cell or chart you are trying to change is protected and therefore read-only. To modify a protected cell or chart, first remove protection using the Unprotect Sheet command (Tools menu, Protection submenu). You may be prompted for a password.”

**Solution:**

The colored cells of the JGPSSI template (such as headings) are protected and cannot be edited. You should edit only unshaded (white) cells.

### Microsoft VBScript runtime error 1B6: Object doesn't support this property or method

When you choose any command that launches the Microsoft Excel-based client (such as Actions > Open in Excel) in the Agile Web Client, an error message appears: “Microsoft VBScript runtime error 1B6: Object doesn't support this property or method.”

**Solution:**

Internet Explorer had problems downloading the digital certificate for the Agile PLM ActiveX Control. Click OK in the error message box to continue.

The problem may be due to a comma in the Company field of the digital certificate. If there isn’t a comma in the Company field, you may need to update your Internet Explorer browser with the latest patch from Microsoft.

### You must restart your computer before the new settings will take effect

When you choose any command that launches the Microsoft Excel-based client (such as Actions > Open in Excel) in the Agile Web Client, a message box appears: “You must restart your computer before the new settings will take effect. Do you want to restart your computer now?”

**Solution:**

You have a previous version of the Agile PLM ActiveX Control installed, and Microsoft Excel is currently open, so the control cannot be updated. To install the new control, close Excel, and then click No in the message box (to not restart the computer). Choose Actions > Open in Excel again.

### Long part numbers display in Microsoft Excel in scientific notation

When you open a part and choose Actions > Rollup in Excel, long part numbers display in scientific notation (for example, 8.1E+22).

**Solution:**

Microsoft Excel uses the General number format by default. This causes large numbers, such as item numbers and manufacturer part numbers, to be converted into scientific notation. You can fix that problem by formatting the cells to use Text format.
To format numbers as text in Excel:
1. Select the cells you want to format.
3. Click the Number tab.
4. In the Category list, select Text, and then click OK.
5. If there are any cells that still display in scientific notation, click each cell, press F2, and then press Enter to reenter the number as text.
CHAPTER 10

Configuring Agile Product Interchange

This chapter describes how to configure the Agile Application Server. It includes the following information:

- Overview
- Configuring the Apache Tomcat Service
- Testing the Installation
- Using the Agile Product Interchange Dataload Utility

Important  When you install and configure the Agile Product Interchange, follow the sequence recommended in “Product Interchange Installation Checklist” on page 1-5.

Overview

Agile Product Interchange™, which is part of the Agile Content Framework, enables users to rapidly identify any structural or parts-related issues in BOMs and AMLs and resolve these issues in a systematic fashion. It automates product record handoffs and the refresh of AML records by leveraging real-time links to source component intelligence dispersed throughout the supply chain. Customers can ensure that product content is synchronized with component events occurring in the supply chain, and they benefit from clean, accurate product records across all PLM processes.

Agile Product Interchange has both database and application components. This chapter describes how to configure only the Agile Product Interchange application.

Note  For information about Agile Product Interchange database installation, see the Agile PLM Database Installation Guide.

Requirements

For Agile Product Interchange hardware and software requirements, see the Agile PLM Capacity Planning and Deployment Guide.

To use the Product Interchange Dataload utility, Microsoft Excel should be installed on the same computer as the Product Interchange application.

Note  DO NOT install Agile Product Interchange on the same machine as the Agile PLM application server. Agile Product Interchange is a database-intensive application and can severely impact the performance of the Agile PLM application server if they are installed on the same machine.
Configuring the Apache Tomcat Service

Agile Product Interchange uses the Apache Tomcat server, which is installed as a Windows service. Before starting the Apache Tomcat service, you must configure it for Agile Product Interchange.

To configure the Apache Tomcat service for Agile Product Interchange:

1. Choose Start > All Programs > Apache Tomcat 5.0 > Configure Tomcat.

   The Apache Tomcat Properties dialog box appears.

2. On the General tab, make sure the Startup Type option is set to Automatic. This ensures that the Apache Tomcat service will start automatically when you restart the server.

3. Click the Java tab.

4. Make sure the Java Virtual Machine and Java Classpath options point to the location for Java Development Kit (JDK) 1.4.2.

   Note: JDK 1.4.2 is installed automatically with Agile Product Interchange and is located in the \agile_home\jdk folder.

5. In the Java Options box, remove the entry for java.endorsed.dirs. The complete entry to remove looks like this:

   -Djava.endorsed.dirs=D:\Agile\Agile921\Tomcat\common\endorsed

6. Set the Initial Memory Pool size to 512 (Mb).

7. Set the Maximum Memory Pool size to 1024 (Mb).

8. Click the Logging tab.

9. By default, Apache Tomcat saves stdout and stderr log files in the <agile_home>\Tomcat\logs folder. These files are excellent resources for troubleshooting errors. Optionally, you can change the location of these files and their filenames by modifying the Log Path, Redirect Stdout, and Redirect Stderr options.

10. Click the General tab again.

11. Toward the bottom of the tab, Service Status indicates whether the Apache Tomcat service is started. If Service Status is “Started,” click Stop to stop the service.

12. Click Start to restart the service.

13. Click OK to close the Apache Tomcat Properties dialog box.
Testing the Installation

After the Agile Product Interchange application has been installed and the Apache Tomcat service has been started, open a browser window and test the installation by going to the following URL:

https://<Agile-PI-Host-Name>:<SSL-Port>/orexec/SignInRequest.fma?orgId=1

where

<Agile-PI-Host-Name> is the fully qualified domain name of the machine where the Agile Product Interchange application is installed

<SSL-Port> is the Secure Sockets Layer (SSL) port that Tomcat listens to. If you are using the default SSL port (443), you can omit the SSL port from the URL.

Here are examples of URLs you might type:

https://piserver.mycompany.com:8443/orexec/SignInRequest.fma?orgId=1
https://piserver.mycompany.com/orexec/SignInRequest.fma?orgId=1

Use the following username/password logins to verify the installation:

❑ admin/agile
❑ agileuser1/agile

Using the Agile Product Interchange Dataload Utility

This section describes how to use the Agile Product Interchange Dataload utility to load customer data for manufacturer aliases (internal and external), part aliases, and manufacturer codes.

Unpacking and Configuring the Agile Product Interchange Dataload Utility

The Agile Product Interchange Dataload utility (pidataload.zip) is installed into the following folder on your Agile Product Interchange application machine:

<agile_home>\AgilePI\pidataload

To extract and configure the Agile Product Interchange Dataload utility:

1. In the pidataload folder, open pidataload.zip using WinZip or another archive utility. Extract the contents of the file to the same folder.

2. Edit the database details in the config.properties file found in the following folder:

<agile_home>\AgilePI\pidataload\config

For guidelines on how to edit the config.properties file, read instructions in the file.

Data File Formats

Before loading data into Agile Product Interchange using the Dataload utility, make sure your Microsoft Excel data files conform to the proper format.

Internal Manufacturer Alias Format

The Microsoft Excel file used for internal manufacturer aliases should have the following format:

❑ Column A should contain internal standard manufacturers.
❑ Column B should contain aliases.
❑ The first row of the file should be the header.
The following table shows the format for an internal manufacturer alias file.

Table 10-1: Example of an internal manufacturer alias file

<table>
<thead>
<tr>
<th>Internal Standard Mfr</th>
<th>Alias Mfr</th>
</tr>
</thead>
<tbody>
<tr>
<td>PANASONIC</td>
<td>PANASONIC CORP</td>
</tr>
<tr>
<td>PANASONIC</td>
<td>PANASONIC INC</td>
</tr>
<tr>
<td>PANASONIC</td>
<td>PANASONIC LTD</td>
</tr>
<tr>
<td>MICROSEMI</td>
<td>MICROSEMI DIV</td>
</tr>
<tr>
<td>MICROSEMI</td>
<td>MICROSEMI INC</td>
</tr>
</tbody>
</table>

**External Manufacturer Alias Format**

The Microsoft Excel file used for external manufacturer aliases should have the following format:

- Column A should contain standard manufacturers.
- Column B should contain DataSource manufacturer aliases.
- The first row of the file should be the header.

The following table shows the format for an external manufacturer alias file.

Table 10-2: Example of an external manufacturer alias file

<table>
<thead>
<tr>
<th>Internal Standard Mfr</th>
<th>PartMiner Mfr</th>
</tr>
</thead>
<tbody>
<tr>
<td>3M PRODUCTS</td>
<td>3M INTERCONNECT SOLUTIONS</td>
</tr>
<tr>
<td>AAVID THERMAL PRODUCTS</td>
<td>AAVID THERMALLOY</td>
</tr>
<tr>
<td>ADVANCED POWER SOLUTIONS</td>
<td>ADVANCED POWER TECHNOLOGY</td>
</tr>
<tr>
<td>AGERE</td>
<td>AGERE SYSTEMS</td>
</tr>
</tbody>
</table>

**Manufacturer Part Number Alias Format**

The Microsoft Excel file used for manufacturer part number aliases should have the following format:

- Column A should contain the dirty manufacturers.
- Column B should contain the dirty parts.
- Column C should contain the clean manufacturers.
- Column D should contain the clean parts.
- The first row of the file should be the header.

The following table shows the format for an manufacturer part number alias file.

Table 10-3: Example of a manufacturer part number alias file

<table>
<thead>
<tr>
<th>Dirty Mfr</th>
<th>Dirty Part</th>
<th>Clean Mfr</th>
<th>Clean Part</th>
</tr>
</thead>
<tbody>
<tr>
<td>3M</td>
<td>152244-0113GG</td>
<td>3M INTERCONNECT SOLUTIONS</td>
<td>1522440113GG</td>
</tr>
<tr>
<td>3M</td>
<td>2304-6111TG</td>
<td>3M INTERCONNECT SOLUTIONS</td>
<td>23046111TG</td>
</tr>
<tr>
<td>3M</td>
<td>2402-6112TB</td>
<td>3M INTERCONNECT SOLUTIONS</td>
<td>24026112TB</td>
</tr>
</tbody>
</table>

**Manufacturer Code Format**

The Microsoft Excel file used for manufacturer codes should have the following format:

- Column A should contain the manufacturer name.
- Column B should contain the manufacturer code.
❑ The first row of the file should be the header.

The following table shows the format for a manufacturer code file.

Table 10-4: Example of a manufacturer code file

<table>
<thead>
<tr>
<th>Mfr Name</th>
<th>Mfr Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>3L ELECTRONIC CORP</td>
<td>7095</td>
</tr>
<tr>
<td>NETERGY MICROELECTRONICS</td>
<td>2018</td>
</tr>
<tr>
<td>8 X 8 INC</td>
<td>4659</td>
</tr>
</tbody>
</table>

Commodity Code Format

The Microsoft Excel file used for commodity codes should have the following format:

❑ Column A should contain the internal commodity code.
❑ Column B should contain the description of the commodity.
❑ Column C should contain the corresponding PartMiner Commodity Code.
❑ The first row of the file should be the header.

The following table shows the format for a commodity code file.

Table 10-5: Example of a commodity code file

<table>
<thead>
<tr>
<th>Internal Commodity Code</th>
<th>Description</th>
<th>PartMiner Commodity Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>06370</td>
<td>IC, MEMORY, EPROM</td>
<td>4420</td>
</tr>
<tr>
<td>06400</td>
<td>IC, PROC</td>
<td>3780</td>
</tr>
<tr>
<td>06500</td>
<td>IC, ANALOG</td>
<td>3690</td>
</tr>
</tbody>
</table>

Loading Manufacturer Aliases

Use the runMfrAliasLoader.bat script to load manufacturer aliases into your system.

To load manufacturer aliases from an internal data source:
1. Open a Command Prompt window.
2. Change directories to the <agile_home>\AgilePI\pidataload directory.
3. Run a script called runMfrAliasLoader.bat using the following syntax:
   
   runMfrAliasLoader <MfrAliases_Datafile_Path> <Config_File_Path>

   where
   
   <MfrAliases_Datafile_Path> is the path to the internal manufacturer alias data file.
   <Config_File_Path> is the path to the config.properties file for the Agile Product Interchange Dataload utility.

   For example:
   
   runMfrAliasLoader.bat "d:\Agile\Agile921\AgilePI\pidataLoad\files\InternalAliasesData.xls" "d:\Agile\Agile921\AgilePI\pidataLoad\config\config.properties"

To load manufacturer aliases from an external data source:
1. Open a Command Prompt window.
2. Change directories to the <agile_home>\AgilePI\pidataload directory.
3 Run a script called `runMfrAliasLoader.bat` using the following syntax:

```
runMfrAliasLoader <MfrAliases_Datafile_Path> <DataSource_Org_Name> <Config_File_Path>
```

where

- `<MfrAliases_Datafile_Path>` is the path to the external manufacturer alias data file.
- `<DataSource_Org_Name>` is the data source organization name exactly as configured in Agile Product Interchange.

**Note** You can see the list of Organizations in Agile Product Interchange. Log in as admin and create a new Data Source Profile.

- `<Config_File_Path>` is the path to the config.properties file for the Agile Product Interchange Dataload utility.

For example:

```
runMfrAliasLoader.bat "d:\Agile\Agile921\AgilePI\pidataLoad\files\ExternalAliasesData.xls" "PartMiner" "d:\Agile\Agile921\AgilePI\pidataLoad\config\config.properties"
```

**Loading Manufacturer Part Number Aliases**

Use the `runMpnAliasLoader.bat` script to load manufacturer part number aliases into your system.

**To load manufacturer part number aliases:**

1 Open a Command Prompt window.

2 Change directories to the `<agile_home>\AgilePI\pidataload` directory.

3 Run a script called `runMpnAliasLoader.bat` using the following syntax:

```
runMpnAliasLoader <MpnAliases_Datafile_Path> <DataSource_Profile_Name> <Config_File_Path>
```

where

- `<MpnAliases_Datafile_Path>` is the path to the manufacturer part number alias data file.
- `<DataSource_Profile_Name>` is the data source profile name exactly as configured in Agile Product Interchange.

**Note** A valid data source profile is one of the data source profile names that you get as result when you search for all Data Source Profiles in Agile Product Interchange.

- `<Config_File_Path>` is the path to the config.properties file for the Agile Product Interchange Dataload utility.

For example:

```
runMpnAliasLoader.bat "d:\Agile\Agile921\AgilePI\pidataLoad\files\mpndl.xls" "PartMiner" "d:\Agile\Agile921\AgilePI\pidataLoad\config\config.properties"
```

**Loading Manufacturer Codes**

Use the `runMfrCodesLoader.bat` script to load manufacturer codes into your system.

**To load manufacturer codes:**

1 Open a Command Prompt window.

2 Change directories to the `<agile_home>\AgilePI\pidataload` directory.
3 Run a script called runMfrCodesLoader.bat using the following syntax:
   runMfrCodesLoader <MfrCodes_Datafile_Path> <Config_File_Path>

   where
   <MfrCodes_Datafile_Path> is the path to the manufacturer codes data file.
   <Config_File_Path> is the path to the config.properties file for the Agile Product Interchange Dataload utility.

   For example:
   runMfrCodesLoader.bat "d:\Agile\Agile921\AgilePI\pidataLoad\files\mfrcodes.xls" "d:\Agile\Agile921\AgilePI\pidataLoad\config\config.properties"

### Loading Commodity Codes

Use the runCommodityDetails.bat script to load commodity codes into your system.

#### To load commodity codes:

1 Open a Command Prompt window.

2 Change directories to the $agile_home$\AgilePI\pidataload directory.

3 Run a script called runCommodityDetails.bat using the following syntax:
   runCommodityDetails <CommodityCodes_Datafile_Path> <Config_File_Path>

   where
   <CommodityCodes_Datafile_Path> is the path to the commodity codes data file.
   <Config_File_Path> is the path to the config.properties file for the Agile Product Interchange Dataload utility.

   For example:
   runCommodityDetails.bat "d:\Agile\Agile921\AgilePI\pidataLoad\files\commoditycodes.xls" "d:\Agile\Agile921\AgilePI\pidataLoad\config\config.properties"

### Getting Aliases for Manufacturers and Manufacturer Parts

Use the following scripts to create output files containing the aliases for manufacturers and manufacturer parts from your system:

- runInternalMfrAliasesGetter.bat
- runExternalMfrAliasesGetter.bat
- runMpnAliasGetter.bat

#### To get manufacturer aliases for an internal data source:

1 Open a Command Prompt window.

2 Change directories to the $agile_home$\AgilePI\pidataload directory.

3 Run a script called runInternalMfrAliasesGetter.bat using the following syntax:
   runInternalMfrAliasesGetter <Output_File> <Config_File_Path>

   where
   <Output_File> is the path to the output file that the script generates.
   <Config_File_Path> is the path to the config.properties file for the Agile Product Interchange Dataload utility.
For example:

```
runInternalMfrAliasesGetter.bat
"d:\Agile\Agile921\AgilePI\pidataLoad\aliasFiles\InternalMfrAliases.txt"
"d:\Agile\Agile921\AgilePI\pidataLoad\config\config.properties"
```

To get manufacturer aliases for external data sources:

1. Open a Command Prompt window.
2. Change directories to the `<agile_home>\AgilePI\pidataload` directory.
3. Run a script called `runExternalMfrAliasesGetter.bat` using the following syntax:

   ```
   runExternalMfrAliasesGetter <Output_File> <Config_File_Path>
   ```

   where
   - `<Output_File>` is the path to the output file that the script generates.
   - `<Config_File_Path>` is the path to the `config.properties` file for the Agile Product Interchange Dataload utility.

   For example:
   ```
   runExternalMfrAliasesGetter.bat
   "d:\Agile\Agile921\AgilePI\pidataLoad\aliasFiles\ExternalMfrAliases.txt"
   "d:\Agile\Agile921\AgilePI\pidataLoad\config\config.properties"
   ```

To get the mapping table for manufacturer part aliases:

1. Open a Command Prompt window.
2. Change directories to the `<agile_home>\AgilePI\pidataload` directory.
3. Run a script called `runMpnAliasGetter.bat` using the following syntax:

   ```
   runMpnAliasGetter <Output_File> <Config_File_Path>
   ```

   where
   - `<Output_File>` is the path to the output file that the script generates.
   - `<Config_File_Path>` is the path to the `config.properties` file for the Agile Product Interchange Dataload utility.

   For example:
   ```
   runMpnAliasGetter
   "d:\Agile\Agile921\AgilePI\pidataLoad\aliasFiles\PartAliases.txt"
   "d:\Agile\Agile921\AgilePI\pidataLoad\config\config.properties"
   ```
CHAPTER 11

Installing and Configuring Agile Java Client

This chapter describes how to install and configure the Agile Java Client on client computers. It includes the following information:

- Agile Java Client Requirements
- Installing the Agile Java Client
- Running Agile Java Client 9.0 and Agile Java Client 9.2.1 on the Same Computer
- Reconfiguring Java Client JNLP Files

Agile Java Client Requirements

All users need to install JRE 5.0 to use Agile Java Client. JRE 5.0 is available at:

http://java.sun.com/j2se/1.5.0/download.html

The server-side deployment files for Agile Java Client are installed with the Agile Application Server.

Note: The Agile PLM administrator must send users the URL to connect to the Agile Java Client.

Installing the Agile Java Client

To use the Agile Java Client, you must install it on your client computer. Agile Java Client uses Java Web Start technology to download the software and keep it updated.

To install the Agile Java Client:

1. Open your browser and type the following:

   http://<webserver>.<domain>:<port>/JavaClient/start.html

   For example, the URL might look something like this:

   http://plmserver.mycompany.com/JavaClient/start.html

2. Click Launch.

   Java Web Start proceeds to download Java Client files and install them on your computer. This may take a few minutes.

3. If a Security Warning dialog box appears, click Start.

4. If the Agile 9.2.1 Desktop Integration dialog box appears, click Yes to integrate the Agile Java Client with your desktop.
You are prompted to log in to the Agile server.
5 Enter your Agile PLM username and password, and then click **OK**.

The main Agile Java Client window opens.

**Running Agile Java Client 9.0 and Agile Java Client 9.2.1 on the Same Computer**

Agile Java Client 9.0 and Agile Java Client 9.2.1 require different versions of the Java Runtime Environment (JRE). Agile Java Client 9.0 requires JRE 1.4.2, whereas Agile Java Client 9.2.1 requires JRE 5.0.

If you have both JRE 1.4.2 and JRE 5.0 installed on the same computer, you need to configure the Agile 9.0 application in Java Web Start to disable JRE 5.0. Otherwise, you will experience problems. For example, you won’t be able to add files to the Attachments tab of an object.

**To force Agile Java Client 9.0 to use JRE 1.4.2:**

1. Go to the directory where JRE 1.4.2 is installed (such as `D:\Program Files\Java\j2re1.4.2_09`), and open the `javaws` subfolder.
2. Run Java Web Start (`javaws.exe`).
3. Choose **View > Downloaded Applications**.
4. Select the **Agile 9.0** application.
5. Choose **File > Preferences**.
6. Click the **Java** tab.
7. In the **Platform Version** column, select 1.5. Make sure the **Enabled** checkbox is unchecked.

![Java Web Start Preferences window](image)

8. Click **OK**.

**Reconfiguring Java Client JNLP Files**

When you install the Agile Application Server, the following two JNLP files are configured for the Agile Java Client. These files are embedded with the application.ear file and deployed with the application:

- `pcclient.jnlp`
- `ext.jnlp`
Chapter 11
Installing and Configuring Agile Java Client

A JNLP file is an XML document that describes a Java application to be launched by Java Web Start. Ordinarily, the JNLP files are configured correctly during installation of Agile PLM. However, if you have an application server cluster and are unable to start Java Client and download its classes, you may need to reconfigure the JNLP files to point to the right servers.

In the <agile_home>/install/bin folder, Agile provides two utilities for unpacking the JNLP files from the application.ear file and repacking them again after you’ve modified them:

Table 11-1: Scripts for unpacking and repacking JNLP files

<table>
<thead>
<tr>
<th>Windows Scripts</th>
<th>UNIX Scripts</th>
</tr>
</thead>
<tbody>
<tr>
<td>ExtractJNLPFiles.cmd</td>
<td>ExtractJNLPFiles.sh</td>
</tr>
<tr>
<td>RepackJNLPFiles.cmd</td>
<td>RepackJNLPFiles.sh</td>
</tr>
</tbody>
</table>

To extract and modify the JavaClient JNLP files:

1. Stop the Web proxy server or load balancer.
2. Stop the Agile Application Server.
3. On the application server computer, open a command prompt window.
4. Run the ExtractJNLPFiles script to extract the JNLP files from the application.ear file.
   ```
   \langleagile_home\rangle\install\bin\ExtractJNLPFiles
   ```
   **Important** If you have an OAS cluster, extract the JNLP files only on the Repository Host Server. When you redeploy the Agile application, the updated JNLP files will be propagated to all servers in the cluster.
5. Open the pcclient.jnlp file in a text editor. The file is located in the <agile_home>/agileDomain/applications folder.
6. Find the following tags and edit the values listed below in blue:
   - **jnlp:**
     ```xml
     <jnlp spec="1.0+" codebase="http://<proxy/loadbalancer>.<domain>:<port>/JavaClient">
     ```
   - **serverURL:**
     ```xml
     <argument>serverURL=<protocol>://<appserver>.<domain>:<port>/<appserver_virtual_path></argument>
     ```
   - **webserverName:**
     ```xml
     <argument>webserverName=<proxy/loadbalancer>.<domain>:<port></argument>
     ```
   where
   - `<protocol>` is the protocol used by the application server. Enter t3 for BEA WebLogic Server and ormi for Oracle Application Server.
   - `<proxy/loadbalancer>` is the Web proxy server hostname or the alias for the load balancer
   - `<domain>` is the fully qualified domain name
   - `<port>` is the Web proxy server port or virtual port for the load balancer.
   - `<appserver_virtual_path>` is the Agile Application Server virtual path. The default is “Agile”.
7. Save the file.
8. Open the ext.jnlp file in a text editor. The file is located in an OAS or WebLogic subfolder beneath the <agile_home>/agileDomain/applications folder.
9. Find the following tag and edit the values listed below in blue:
jnlp:
  <jnlp spec="1.0+" codebase="http://<proxy/loadbalancer>.<domain>:<port>/JavaClient">
where
  • <proxy/loadbalancer> is the Web proxy server hostname or the alias for the load balancer
  • <domain> is the fully qualified domain name
  • <port> is the Web proxy server port or virtual port for the load balancer.

10  Save the file.
11  Run the RepackJNLPFiles script to repack the JNLP files into the application.ear file.
    \<agile_home>\install\bin\RepackJNLPFiles
12  Undeploy the Agile application.
    \<agile_home>\agileDomain\bin\UnDeployAgile
13  Deploy the Agile application.
    \<agile_home>\agileDomain\bin\DeployAgile
14  Start the Agile Application Server.
15  Start the Web proxy server or load balancer.
APPENDIX A

Agile PLM Installer Panels

This appendix describes panels in the Agile PLM installer. It includes the following information:

- Common Agile PLM Installer Panels
- Database Server Panels
- Application Server Panels
- Web Server Panels
- View Server Panels
- File Manager Panels
- Directory Server Panels
- Product InterChange Panels

Common Agile PLM Installer Panels

The following Agile PLM installer panels are common to all components:

Table 11-2: Common Agile PLM installer panels

<table>
<thead>
<tr>
<th>Panel</th>
<th>Step(s) to Perform</th>
</tr>
</thead>
<tbody>
<tr>
<td>Welcome</td>
<td>Click Next.</td>
</tr>
<tr>
<td>License Agreement</td>
<td>Read the Agile PLM license agreement, and then select I accept the terms of the license agreement.</td>
</tr>
<tr>
<td>Customer Information</td>
<td>Enter your user name, company name, and license key. Your license key determines which Agile PLM components can be installed.</td>
</tr>
<tr>
<td>Choose Component(s)</td>
<td>Select the components to install. The list of components depends on the license key that you entered in the previous panel. When you select each component, a description of it appears in the Description box. <strong>Important:</strong> If a component that you would like to install does not appear in the list, you have entered the wrong license key in the Customer Information panel. Do not click Previous to try to correct the license key. Instead, exit from the installer, obtain the correct license key from Agile, and then restart the installer. Enter the correct license key when prompted.</td>
</tr>
<tr>
<td>Installation Location</td>
<td>Enter the directory where you want to install Agile PLM components. This directory is also referred to as the Agile Home.</td>
</tr>
</tbody>
</table>
A-2 Installing Agile PLM with Oracle Application Server

Database Server Panels

The following Agile PLM installer panels appear when you install the Database Server:

Table 11-3: Agile PLM Database Server installer panels

<table>
<thead>
<tr>
<th>Panel</th>
<th>Step(s) to Perform</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Product Interchange Database Schema</td>
<td>To create a Product Interchange database schema in addition to the Agile PLM database schema, make sure the Create Product Interchange Database Schema box is checked. Otherwise, leave the box unchecked to create only an Agile PLM database schema.</td>
</tr>
<tr>
<td>Agile PLM Database Details</td>
<td>Enter your Agile PLM database information. If you do not know these values, see the database administrator responsible for your Agile PLM database server. Agile Database Host Name The fully qualified domain name of the computer where the Agile PLM database server is installed. Agile Database Port For Oracle, the default database port is 1521. Agile Database SID Enter the Oracle System Identifier that refers to the instance of the Oracle database running on the server. The default SID is agile9. Agile Database User Enter the database user. The default user is agile. Agile Database User Password Enter the password for the Agile PLM database user. The default password is tartan. Note: If your Agile PLM database is configured to use different values than the defaults listed above, specify that information instead.</td>
</tr>
<tr>
<td>Oracle Database Version</td>
<td>Select the version of your Oracle database server. Agile supports the following Oracle versions: • Oracle 9i R2 Database Server • Oracle 10g Database Server</td>
</tr>
</tbody>
</table>
Appendix A  Agile PLM Installer Panels

Application Server Panels

The following Agile PLM installer panels appear when you install the Application Server:

<table>
<thead>
<tr>
<th>Panel</th>
<th>Step(s) to Perform</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Application Server Type</strong></td>
<td>Select the type of application server you are using. Agile PLM supports Oracle</td>
</tr>
<tr>
<td></td>
<td>Application Server 10g (10.1.2.0.2), BEA WebLogic Server 8.1 SP2, and IBM</td>
</tr>
<tr>
<td></td>
<td>WebSphere 5.1.</td>
</tr>
<tr>
<td><strong>Important:</strong></td>
<td>The application server you select should be installed BEFORE you install Agile PLM.</td>
</tr>
<tr>
<td><strong>Installation Type</strong></td>
<td>Select <strong>Standalone Installation</strong> or <strong>Cluster Installation</strong>.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>If you are installing Application Server and File Manager on the same computer,</td>
</tr>
<tr>
<td></td>
<td>selecting <strong>Cluster Installation</strong> will cause both to be clustered. A</td>
</tr>
<tr>
<td></td>
<td>standalone installation requires only a single server, and therefore is not as</td>
</tr>
<tr>
<td></td>
<td>scalable or as reliable.</td>
</tr>
<tr>
<td></td>
<td>A cluster is a group of servers that work together to provide a more scalable,</td>
</tr>
<tr>
<td></td>
<td>more reliable application platform than a single server. A cluster appears to its</td>
</tr>
<tr>
<td></td>
<td>clients as a single server, but is actually a group of servers acting as one. A</td>
</tr>
<tr>
<td></td>
<td>cluster provides two key advantages over a single server:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Scalability:</strong> The capacity of a cluster is not limited to a single server or</td>
</tr>
<tr>
<td></td>
<td>a single machine. New servers can be added to the cluster dynamically to increase</td>
</tr>
<tr>
<td></td>
<td>capacity. If more hardware is needed, a new server on a new machine can be added.</td>
</tr>
<tr>
<td></td>
<td>• <strong>High-Availability:</strong> A cluster uses the redundancy of multiple servers to</td>
</tr>
<tr>
<td></td>
<td>insulate clients from failures. The same service can be provided on multiple servers</td>
</tr>
<tr>
<td></td>
<td>in the cluster. If one server fails, another can take over. The ability to fail</td>
</tr>
<tr>
<td></td>
<td>over from a failed server to a functioning server increases the availability of the</td>
</tr>
<tr>
<td></td>
<td>application to clients.</td>
</tr>
<tr>
<td><strong>Oracle Application Server Home</strong></td>
<td>Enter the directory where Oracle Application Server is installed, or where you plan</td>
</tr>
<tr>
<td></td>
<td>to install it. This directory is also referred to as the Oracle Home.</td>
</tr>
<tr>
<td><strong>Important:</strong></td>
<td>If you are installing an Oracle Application Server cluster, all servers in the</td>
</tr>
<tr>
<td></td>
<td>cluster must use a like operating system.</td>
</tr>
<tr>
<td><strong>Oracle Application Server Information</strong></td>
<td>Enter details for your Oracle Application Server installation.</td>
</tr>
<tr>
<td><strong>OAS Home Name</strong></td>
<td>Enter the OAS home name (not the directory location).</td>
</tr>
<tr>
<td><strong>IAS Instance Name</strong></td>
<td>Enter the OracleAS 10g instance name (for example, oas).</td>
</tr>
<tr>
<td><strong>IAS Admin Password</strong></td>
<td>Enter the password for the OracleAS 10g administration user, ias_admin. It</td>
</tr>
<tr>
<td></td>
<td>must be at least five characters and it must contain one number.</td>
</tr>
<tr>
<td><strong>Oracle Application Server 10g Setup Path</strong></td>
<td>Enter the path where the Oracle Application Server 10g installation program is</td>
</tr>
<tr>
<td></td>
<td>located. Click <strong>Choose</strong> to browse to the path.</td>
</tr>
<tr>
<td><strong>Repository Host ID</strong></td>
<td>When installing the cluster, the first machine is always the Repository Host server.</td>
</tr>
<tr>
<td></td>
<td>All other machines in the cluster are non-Repository Host servers.</td>
</tr>
<tr>
<td></td>
<td>Enter the Repository ID created during the installation of the Repository Host</td>
</tr>
<tr>
<td></td>
<td>server. The Repository Host ID is in the form</td>
</tr>
<tr>
<td></td>
<td><code>&lt;hostname&gt;:</code>&lt;port&gt;</td>
</tr>
<tr>
<td><strong>JMS Server</strong></td>
<td>The JMS Server host name is the computer name of the previously installed</td>
</tr>
<tr>
<td></td>
<td>Repository Host server. Enter the fully qualified host name.</td>
</tr>
</tbody>
</table>
### Table 11-4: Agile PLM Application Server installer panels (continued)

<table>
<thead>
<tr>
<th>Panel</th>
<th>Step(s) to Perform</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Server Type</strong></td>
<td>Select the type of server to install, <strong>Administration Server</strong> or <strong>Managed Server</strong>. A typical cluster configuration contains one Administration server and one or more Managed servers. BEA recommends that all the WebLogic servers should be located in the same subnet to ensure the multicast messages are reliably transmitted.</td>
</tr>
</tbody>
</table>
| **Administration Server Details** | Enter details for the computer where the BEA WebLogic Administration Server is installed.  
  **Administration Server Host Name**  
  Enter the fully qualified domain name of the Administration Server.  
  **Administration Server Listen Port**  
  Enter the port number on which Administration Server listens. The default is 7001. You should accept the default unless you know that this port is unavailable. |
| **Cluster Details**            | Enter the cluster name and the IP multicast address for the Administration server.  
  **Cluster Name**  
  Enter the name of the cluster.  
  **IP Multicast Address**  
  Enter an IP multicast address in the range from 224.0.0.0 to 239.255.255.255 that enables multiple applications to subscribe to a given IP address and port number and listen for messages.  
  **Note:** For a successful cluster installation, all the components of the cluster need to be installed in the same directory structure on each machine in the cluster. |
| **BEA Home Directory**         | Type the location of the BEA WebLogic Server Home Directory, or click **Choose** to browse to it.  
  The BEA Home directory is a repository for common files that are used by multiple BEA products installed on the same machine. |
| **BEA Product Directory**      | Type the location of the BEA Product Directory, or click **Choose** to browse to it.  
  The BEA Product directory is the location where BEA WebLogic Server is installed (for example, c:\bea\weblogic81). |
| **BEA WebLogic Server Ports**  | Enter WebLogic Server listen ports.  
  **BEA WebLogic Server Listen Port**  
  Enter WebLogic Server listen port. The default port is 7001.  
  **BEA WebLogic Server Secure (SSL) Listen Port**  
  Enter the WebLogic Server secure listen port. The default port is 7002.  
  **Note:** You should accept the default ports unless you know they are unavailable. |
| **IBM WebSphere Home**         | Type the location of the IBM WebSphere Home directory, or click **Choose** to browse to it.  
  The IBM WebSphere Home directory is a repository for common files used by WebSphere products installed on the same machine. |
Appendix A
Agile PLM Installer Panels

The following Agile PLM installer panels appear when you install Agile Proxies:

Table 11-5: Agile PLM Web Server installer panels

<table>
<thead>
<tr>
<th>Panel</th>
<th>Step(s) to Perform</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>WebSphere Ports</strong></td>
<td>Enter the WebSphere Application Server ports:</td>
</tr>
<tr>
<td></td>
<td><strong>WebSphere HTTP Transfer Port</strong></td>
</tr>
<tr>
<td></td>
<td>Enter the WebSphere HTTP transfer port. The default port is 9080.</td>
</tr>
<tr>
<td></td>
<td><strong>WebSphere Bootstrap Port</strong></td>
</tr>
<tr>
<td></td>
<td>Enter the WebSphere Server bootstrap port. The default port is 900.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Use the default ports unless you know they’re unavailable. To change the bootstrap port, use the WebSphere administrative console.</td>
</tr>
<tr>
<td><strong>WebSphere Administration User</strong></td>
<td>Enter the WebSphere Application administration user name and password:</td>
</tr>
<tr>
<td></td>
<td><strong>WebSphere Administration User Name</strong></td>
</tr>
<tr>
<td></td>
<td>Enter the WebSphere administration user name. The default user name is ws_admin.</td>
</tr>
<tr>
<td></td>
<td><strong>WebSphere Administration User Password</strong></td>
</tr>
<tr>
<td></td>
<td>Enter the administration user password.</td>
</tr>
<tr>
<td><strong>Windows Service</strong></td>
<td>Select whether to run Agile PLM as a Windows service. Choose Yes or No.</td>
</tr>
</tbody>
</table>

**Web Server Panels**

The following Agile PLM installer panels appear when you install Agile Proxies:

Table 11-5: Agile PLM Web Server installer panels

<table>
<thead>
<tr>
<th>Panel</th>
<th>Step(s) to Perform</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type of Web Server</strong></td>
<td>On Windows, only Microsoft IIS Web Server is supported for the web proxy server.</td>
</tr>
<tr>
<td></td>
<td>On Solaris or Linux, only Apache Web Server is supported for the web proxy server.</td>
</tr>
<tr>
<td><strong>Apache Home Directory</strong></td>
<td>Enter the Apache Web Server home directory.</td>
</tr>
<tr>
<td></td>
<td>You can click <strong>Choose</strong> to browse to the Apache home directory.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If you are installing Agile PLM on Oracle Application Server (OAS), DON’T select the home directory for Oracle HTTP Server, a version of Apache Web Server that is included with OAS.</td>
</tr>
<tr>
<td><strong>Web Server Information</strong></td>
<td>Enter information for the Web server used to proxy Agile PLM. If you are using a load balancer, specify the alias and virtual port for it instead.</td>
</tr>
<tr>
<td></td>
<td><strong>Host Name</strong></td>
</tr>
<tr>
<td></td>
<td>Enter the fully qualified domain name (for example, computer-name.company.com) of the Web server. If you are using a load balancer, specify the alias for the load balancer virtual IP address.</td>
</tr>
<tr>
<td></td>
<td><strong>Port Number</strong></td>
</tr>
<tr>
<td></td>
<td>Enter the HTTP or HTTPS port used by the Web server. General Web access is typically available on port 80, but your company may use a different port. If you are using a load balancer, specify the virtual port number of the load balancer.</td>
</tr>
</tbody>
</table>
View Server Panels

The following Agile PLM installer panels appear when you install View Server:

Table 11-6: Agile PLM View Server installer panels

<table>
<thead>
<tr>
<th>Panel</th>
<th>Step(s) to Perform</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agile View Server Type</td>
<td>Select the Agile View Server type:</td>
</tr>
<tr>
<td></td>
<td>• Regular Viewer – The view server used for regular viewing of Agile PLM files.</td>
</tr>
<tr>
<td></td>
<td>• Caching Viewer – A special-purpose view server used to convert files to an internal metafile format, which speeds up rendering of large 2D and 3D files. If you install a Caching Viewer, you must enable the offline metafile caching utility in the Agile Java Client.</td>
</tr>
<tr>
<td>Agile View Server</td>
<td>Enter Agile View Server information.</td>
</tr>
<tr>
<td>Host Name</td>
<td>Enter the fully qualified domain name (for example, computer-name.company.com) of the View Server.</td>
</tr>
<tr>
<td>Port Number</td>
<td>Enter the port used by the View Server. The default port is 5099, but your company may use a different port if 5099 is not available.</td>
</tr>
<tr>
<td>Platform</td>
<td>Select the operating system platform for your View Server. Choose Windows or Solaris.</td>
</tr>
<tr>
<td>Insert View Server CD</td>
<td>Insert the Agile Viewer and Agile Advanced Viewer CD and navigate to the specific operating system directory where the View Server will be installed. If you have copied the Viewer CD to your local directory, enter the path to the operating system directory.</td>
</tr>
</tbody>
</table>

File Manager Panels

The following Agile PLM installer panels appear when you install File Manager:

Table 11-7: Agile PLM File Manager installer panels

<table>
<thead>
<tr>
<th>Panel</th>
<th>Step(s) to Perform</th>
</tr>
</thead>
<tbody>
<tr>
<td>File Manager User Authentication</td>
<td>A user account is used by the File Manager to communicate with the Application Server and its peers. You can use the default internal account or create a separate user account. Choose the type of user account you want to use for authentication.</td>
</tr>
<tr>
<td>File Manager User Account</td>
<td>The File Manager user account is used by the File Manager to communicate with the Application Server and its peers. The default user account is ifsuser.</td>
</tr>
<tr>
<td>File Manager User Name</td>
<td>Enter the user account used to communicate with the Application Server.</td>
</tr>
<tr>
<td>File Manager User Password</td>
<td>Enter the File Manager user password.</td>
</tr>
<tr>
<td>File Manager Storage Location</td>
<td>Enter the directory where the File Manager files are stored. Click Choose to browse to the path. Note: Make sure the directory you specify is one to which you have write access. For clustered File Managers, you must specify a network location.</td>
</tr>
</tbody>
</table>
Appendix A

Agile PLM Installer Panels

Table 11-7: Agile PLM File Manager installer panels (continued)

<table>
<thead>
<tr>
<th>Panel</th>
<th>Step(s) to Perform</th>
</tr>
</thead>
<tbody>
<tr>
<td>File Manager Virtual Path</td>
<td>Enter the virtual path used to connect to the Agile File Manager. The default virtual path is “Filemgr”, but you can change it to something appropriate for your company. The complete path for your Agile File Manager will be http://&lt;web_server&gt;:@&lt;port&gt;/&lt;file_manager_virtual_path&gt;/AttachmentServlet. Important: The virtual path for Agile File Manager should be different from the virtual path for the Agile Application Server, especially if they use the same proxy server. The virtual paths should also have a different prefix. For example, if the Agile Application Server Virtual Path is “Agile”, the name of the Agile File Manager Virtual Path must start with something other than “Agile”.</td>
</tr>
<tr>
<td>Agile File Manager</td>
<td>Enter the machine name where File Manager is installed as well as the port number. Agile File Manager Host Name Enter the fully qualified domain name of the machine where you are installing the File Manager. Agile File Manager Port Number Enter the port number on which other Agile PLM applications will connect to the File Manager. The default port is 8080. If the File Manager is accessed through a proxy server or load balancer, enter the host name and port number of that machine.</td>
</tr>
<tr>
<td>Application Server Virtual Path</td>
<td>Enter the virtual path used to connect to the Agile Application Server. The default virtual path is “Agile”, but you can change it to something appropriate for your company. The complete path for your Agile Application Server will be http://&lt;web_server&gt;:@&lt;port&gt;/&lt;appserver_virtual_path&gt;/PLMServlet. The virtual path for Agile Application Server should be different from the virtual path for the Agile File Manager, especially if they use the same proxy server.</td>
</tr>
<tr>
<td>Agile Application Server</td>
<td>Enter the Agile Application Server information. Agile Application Server Host Name Enter the fully qualified domain name for the Agile Application Server. Agile Application Server Port Enter the HTTP listen port for the application server. The port depends on type of application server you are using. For Oracle Application Server, the default port is 7777. For BEA WebLogic Server, the default port is 7001. For IBM WebSphere, the default port is 9080.</td>
</tr>
</tbody>
</table>

Directory Server Panels

The following Agile PLM installer panels appear when you choose to authenticate users through a Directory Server:

Table 11-8: Agile PLM Directory Server installer panels

<table>
<thead>
<tr>
<th>Panel</th>
<th>Step(s) to Perform</th>
</tr>
</thead>
<tbody>
<tr>
<td>Directory Server</td>
<td>Choose whether to use a Directory Server or the Agile PLM database for authentication. You can integrate Agile PLM with your company’s existing Directory Server to manage your users in one place. After installation is complete, you must use the Agile Java Client to configure the Directory Server for Agile PLM. For instructions on how to configure the directory server, see the Agile PLM Administrator Guide. If your company does not have a Directory Server currently implemented, select No, use a Database for authentication.</td>
</tr>
</tbody>
</table>
Product InterChange Panels

The following Agile PLM installer panels appear when you install Product InterChange:

Table 11-9: Agile PLM Product InterChange installer panels

<table>
<thead>
<tr>
<th>Panel</th>
<th>Step(s) to Perform</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tomcat Listen Ports</td>
<td>Specify the Tomcat listen ports.</td>
</tr>
<tr>
<td></td>
<td><strong>Tomcat Listen Port (non-SSL)</strong></td>
</tr>
<tr>
<td></td>
<td>Enter the Tomcat listen port. The default port is 8080.</td>
</tr>
<tr>
<td></td>
<td><strong>Tomcat Secure Listen Port (SSL)</strong></td>
</tr>
<tr>
<td></td>
<td>Enter the Tomcat secure listen port. The default port is 8443. You may also use</td>
</tr>
<tr>
<td></td>
<td>the industry standard SSL port 443 if it is available.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> You should accept the default ports unless you know they are unavailable.</td>
</tr>
<tr>
<td>SMTP Information</td>
<td>Enter the SMTP server information that Product InterChange uses. SMTP is short</td>
</tr>
<tr>
<td></td>
<td>for Simple Mail Transfer Protocol, a protocol for sending e-mail messages</td>
</tr>
<tr>
<td></td>
<td>between servers.</td>
</tr>
<tr>
<td></td>
<td>The Product InterChange application uses this information email any exceptions</td>
</tr>
<tr>
<td></td>
<td>that it encounters in its Web Controller. Product InterChange must be able to</td>
</tr>
<tr>
<td></td>
<td>send both internal and external email from this host. Otherwise, the application</td>
</tr>
<tr>
<td></td>
<td>will fail.</td>
</tr>
<tr>
<td></td>
<td><strong>SMTP Server Name</strong></td>
</tr>
<tr>
<td></td>
<td>Enter the fully qualified domain name of the SMTP server name.</td>
</tr>
<tr>
<td></td>
<td><strong>Email Address</strong></td>
</tr>
<tr>
<td></td>
<td>Enter the email address of the Product InterChange administrator.</td>
</tr>
</tbody>
</table>
**APPENDIX B**

**Agile Application Server Scripts**

This appendix describes scripts that are installed on the Agile Application Server. It includes the following information:

- **Installation and Configuration Scripts**
- **Application Scripts**

### Installation and Configuration Scripts

Agile provides several scripts that can be used during installation and configuration of the Agile Application Server. The scripts are installed into the `<agile_home>`\install\bin directory:

Table B-1: Installation and configuration scripts

<table>
<thead>
<tr>
<th>Windows Script</th>
<th>Solaris Script</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ExtractArchive.cmd</td>
<td>ExtractArchive.sh</td>
<td>Unpacks all of the files in the Agile application.ear file.</td>
</tr>
<tr>
<td>ExtractConfigFiles.cmd</td>
<td>ExtractConfigFiles.sh</td>
<td>Extracts configuration files from the Agile application.ear file.</td>
</tr>
<tr>
<td>ExtractJavaClient-Files.cmd</td>
<td>ExtractJavaClient-Files.sh</td>
<td>Unpacks all of the Java Client files from the Agile application.ear file.</td>
</tr>
<tr>
<td>ExtractJNLPFiles.cmd</td>
<td>ExtractJNLPFiles.sh</td>
<td>Extracts JNLP files for Java Client from the Agile application.ear file. A JNLP file is an XML document that describes a Java application to be launched by Java Web Start. To successfully download and install Java Client using Java Web Start, you must configure the JNLP MIME type for your server.</td>
</tr>
<tr>
<td>GetInstanceName.cmd</td>
<td>GetInstanceName.sh</td>
<td>Gets the instance name in a cluster for Oracle Application Server 10g.</td>
</tr>
<tr>
<td>GetRepository.cmd</td>
<td>GetRepository.sh</td>
<td>Gets the Repository Host ID from a cluster for Oracle Application Server 10g.</td>
</tr>
<tr>
<td>RepackArchive.cmd</td>
<td>RepackArchive.sh</td>
<td>Repacks all of the files into the Agile application.ear file. After you run this script, you are ready to redeploy the Agile application.</td>
</tr>
<tr>
<td>RepackConfigFiles.cmd</td>
<td>RepackConfigFiles.sh</td>
<td>Repacks configuration files into the Agile application.ear file. After you run this script, you are ready to redeploy the Agile application.</td>
</tr>
<tr>
<td>RepackJavaClient-Files.cmd</td>
<td>RepackJavaClient-Files.sh</td>
<td>Repacks all Java Client files into JavaClient.war, and then updates the JavaClient.war file contained in the Agile application.ear file. After you run this script, you are ready to redeploy the Agile application.</td>
</tr>
<tr>
<td>RepackJNLPFiles.cmd</td>
<td>RepackJNLPFiles.sh</td>
<td>Repacks JNLP files for Java Client into the Agile application.ear file. After you run this script, you are ready to redeploy the Agile application.</td>
</tr>
<tr>
<td>RestartEMAgent.cmd</td>
<td>RestartEMAgent.sh</td>
<td>Restarts the Oracle Application Server Control Console.</td>
</tr>
<tr>
<td>RestartOAS.cmd</td>
<td>RestartOAS.sh</td>
<td>Restarts the Oracle Application Server instance and the dcm-daemon process.</td>
</tr>
</tbody>
</table>
**Application Scripts**

Agile provides several scripts for deploying and starting the Agile application. The scripts are installed into the `<agile_home>\agileDomain\bin` directory:

<table>
<thead>
<tr>
<th>Windows Script</th>
<th>UNIX Script</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>checkLDAPConfig.cmd</code></td>
<td><code>checkLDAPConfig.sh</code></td>
<td>Tries to connect to the Directory Server and verify whether LDAP configuration is correct.</td>
</tr>
<tr>
<td><code>DeployAgile.cmd</code></td>
<td><code>DeployAgile.sh</code></td>
<td>Deploys the Agile application on Oracle Application Server 10g.</td>
</tr>
<tr>
<td><code>encryptpwd.cmd</code></td>
<td><code>encryptpwd.sh</code></td>
<td>Encrypts a password.</td>
</tr>
<tr>
<td><code>InstallService.cmd</code></td>
<td>n/a</td>
<td>Installs Agile PLM as a Windows service.</td>
</tr>
<tr>
<td><code>installService-managed-server.cmd</code></td>
<td>n/a</td>
<td>Installs Agile PLM as a Windows service for a BEA WebLogic Managed Server.</td>
</tr>
<tr>
<td><code>migrateUsersToDB.cmd</code></td>
<td><code>migrateUsersToDB.sh</code></td>
<td>Migrates users from the Directory Server to the Agile PLM database. After you run this script, make sure to restart your application server.</td>
</tr>
<tr>
<td><code>setEnv.cmd</code></td>
<td><code>setEnv.sh</code></td>
<td>Sets common environment variables used to run other Agile scripts.</td>
</tr>
<tr>
<td><code>startAgile.cmd</code></td>
<td><code>startAgile.sh</code></td>
<td>Starts the Agile application on BEA WebLogic Server.</td>
</tr>
<tr>
<td><code>startAgileCluster.cmd</code></td>
<td><code>startAgileCluster.sh</code></td>
<td>Starts the Agile cluster on BEA WebLogic Server.</td>
</tr>
<tr>
<td><code>stopAgile.cmd</code></td>
<td><code>stopAgile.sh</code></td>
<td>Stops the Agile application on BEA WebLogic Server.</td>
</tr>
<tr>
<td><code>uninstallService.cmd</code></td>
<td>n/a</td>
<td>Uninstalls the Agile PLM service on Windows.</td>
</tr>
</tbody>
</table>
This appendix discusses the procedures required to enable integration with an Agile e5.1 system. It contains the following tasks:

- **Overview**
- **Configuring Agile PLM**
- **Configuring Agile e5.1**

**Overview**

Once Agile PLM installation is complete, the procedures described in this appendix are required to enable interaction between the Agile PLM system and Agile e5.1.

Updates to Agile e5.1 from Agile PLM can only be performed by users who have permission to log into the Agile e5.1 Web Client. Similarly, the ability to add Agile e5.1 deliverables and links in Agile PE can be performed only by users who have permission to log in to the Agile e5.1 Web Client.

**Note**  You must stop the Agile PLM and Agile e5.1 servers before making any of the following configuration changes. When done with the configuration changes, restart the servers.

**Configuring Agile PLM**

To configure the external adapter:

1. Using a text editor, open the file agile.properties in the `<agile_home>\agileDomain\config\` folder.
2. Update the `external.adapter.class` property value as follows:

```java
external.adapter.class=com.agile.integration.eigner.EignerAdapter
```

To edit Agile e5.1 properties:

1. Using a text editor, open the file agile.properties in the `<agile_home>\agileDomain\config\` folder.
2. Edit the following Agile e5.1 connection properties:

```text
eigner.axa_host=localhost
eigner.axa_socket=16067
eigner.axa_env=axalantORIGIN
eigner.axa_conn_timeout=3600000
eigner.axa_call_timeout=3600000
eigner.http_port=8088
# EIGNER ADMIN USER PASSWORD.
#
eigner.axa_admin_user=DEMOEP_M
eigner.axa_admin_pwd=87B00781D80D58EEE50C
```
Note  The admin user name and password should be generated for the system. The encrypted password can be generated by running the following utility; at the prompt, enter the cleartext password to be encrypted:

```
<agile_home>\agileDomain\bin\encryptpwd.cmd
```

On a Solaris or Linux system, use the shell script `encryptpwd.sh`

To enable the Activity field:

1  Run the following SQL script to automatically enable the LIST25 attribute in the Activity class in Agile PLM:

```
sqlplus dbuser/dbuserPwd@<TNSName to Agile PLM Database>
SQL> @EignerSetup.SQL
```

- **Note**  You can also enable the List field using administrative functionality available in the Agile Java Client.

2  In the agile.properties file, find the line:

```
external.childSyncFlexField=LIST25
```

Replace `LIST25` with the attribute name of the list field you enabled.

Optional Edits:

You can modify certain values in the agile.properties file as needed:

- The following property value controls the interval at which Users and User Groups are automatic synchronized from Agile e5.1 into Agile PE.

  ```
  external.resourceNGroupSyncTimeInMillis=3600000
  ```

  The default value is 3600000 milliseconds, that is, every hour.

- The following property value controls the interval at which Deliverables in Agile PE are evaluated to see if its completion criteria are met in Agile e5.1.

  ```
  external.deliverablesSyncTimeInMillis =1800000
  ```

  The default value is 1800000 milliseconds, that is, every 30 minutes.

### Configuring Agile e5.1

Configure Agile e5.1 to prevent users from deleting deliverable or link objects referenced by Agile PLM objects.

**To set up a database link to the Agile PLM database:**

1  Add the following roles and privileges to the Agile e5.1 database user:

   ```
   SQL> grant connect, resource role to <Agile e5.1 Database User>;
   SQL> grant create database link, create synonym system privileges to <Agile e5.1 Database User>;
   ```

2  On the Agile e5.1 database machine, set up the TNS name for the Agile PLM database as:

   ```
   database_SID.domain_name
   ```

   **Note**  The TNS name must be this format: `database_SID.domain_name`, where `database_SID` is the Agile PLM database system identifier, such as agile9, and `domain_name` is the Agile PLM database server domain name, such as agilesoft.com.

3  Log on to the Agile e5.1 database user in SQLPlus and create a database link and synonym:

   ```
   SQL> CREATE DATABASE LINK agile9 CONNECT TO eigner IDENTIFIED BY tartan USING 'agile9.agilesoft.com'
   SQL> CREATE SYNONYM s_a_ext_obj FOR external_object_view@agile9;
   ```

   **Note**  If you receive an ORA-02085 error after creating the database and synonym, run the following script before attempting to recreate the database and synonym:

   ```
   ALTER SYSTEM SET GLOBAL_NAMES=False;
   ```
4 Test to make sure you can connect to the Agile PLM database using the new Database Link:

   SQL> select count(*) from external_object_view@agile9;

To load Agile e5.1 Loader files:

1 Load the loader file lgv_pe_int2.dat in INSERT mode.
2 Load the loader file dtv_pe_int2.dat in INSERT mode.
3 Add the respective LGV calls to the standard forms and lists as the last Pre-Action Trigger. For each object type (documents, parts, processes, EWOs, EWRs, folders, projects), add a new LGV call to the respective mask as Pre-Action-Userexit (not in the loader file) as listed below:

   "EP_PE_INT/DocCheckDeliverable_PRA"
   "EP_PE_INT/PrtCheckDeliverable_PRA"
   "EP_PE_INT/PrcCheckDeliverable_PRA"
   "EP_PE_INT/EWOCheckDeliverable_PRA"
   "EP_PE_INT/EWRCheckDeliverable_PRA"
   "EP_PE_INT/FolCheckDeliverable_PRA"
   "EP_PE_INT/ProCheckDeliverable_PRA"
This appendix contains the following tips for maintaining and using your Agile system. It includes the following information:

- Using the Server as a Client
- Performance Tuning
- Configuring Database Access using Agile Administrative Settings
- Restarting Windows Servers Periodically
- Color Settings
- Dynamic Versus Static IP Addresses
- Checking Your TCP/IP Connection
- Configuring Browsers on Client Computers
- Uninstalling Agile PLM

**Using the Server as a Client**

After installation, test Agile PLM on the server to make sure that client systems can start Agile products. You may also need to test Agile administration modifications as well. For best results, apart from this testing, do not use the Agile PLM server to perform data-related tasks such as creating and modifying Items and Changes.

**Performance Tuning**

This section provides some information on how to tune the application server to improve the performance of Agile PLM.

**Tuning JVM Parameters**

Oracle Application Server Containers for J2EE (OC4J) is a Java process that requires a Java virtual machine (JVM) to run. You can fine-tune your system’s JVM settings to improve memory management and garbage collection.

JVM settings for OC4J are contained in the `<oracle_home>\opmn\conf\opmn.xml` file. To find JVM settings, look for the following lines in that file:

```xml
<ias-component id="OC4J">
  <process-type id="home" module-id="OC4J" status="enabled">
    <module-data>
      <category id="start-parameters">
        <data id="java-options" value="<enter JVM settings here>"/>
      </category>
    </module-data>
  </process-type>
</ias-component>
```
Important: If you modify the opmn.xml file, you must restart Oracle Application Server.

The following table provides recommended JVM settings for the Agile Application Server:

Table D-1: JVM settings

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Windows</th>
<th>Solaris/Linux</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Xms</td>
<td>Minimum Heap Size</td>
<td>1024m</td>
<td>1024m</td>
<td>The Minimum and Maximum Heap Sizes should be set to the same value. On Windows, the maximum value that can be safely set is 1236m. On Solaris or Linux, there is no upper limit, but it is not advisable to have higher heap sizes unless there are more CPUs available. The general Rule of Thumb is 1GB Heap Size for every 2 CPUs.</td>
</tr>
<tr>
<td>Xmx</td>
<td>Maximum Heap Size</td>
<td>1024m</td>
<td>1024m</td>
<td></td>
</tr>
<tr>
<td>XX:MaxPermSize</td>
<td>Maximum space for permanent objects</td>
<td>256m</td>
<td>256m</td>
<td>Based on the Max Heap Size, this value can be increased proportionately.</td>
</tr>
<tr>
<td>XX:NewSize</td>
<td>Initial memory size for new objects</td>
<td>256m</td>
<td>256m</td>
<td>Based on the Max Heap Size, this value can be increased proportionately.</td>
</tr>
<tr>
<td>XX:MaxNewSize</td>
<td>Maximum memory size for new objects</td>
<td>256m</td>
<td>256m</td>
<td>Based on the Max Heap Size, this value can be increased proportionately.</td>
</tr>
<tr>
<td>VMType</td>
<td>Hotspot or server</td>
<td>hotspot</td>
<td>server</td>
<td>On Windows, -hotspot VM gives the best results. On Solaris or Linux, -server option gives the best results</td>
</tr>
</tbody>
</table>

Note: The Agile PLM installer adjusts JVM parameters to the following values if available physical memory of the machine exceeds 1.5Gb:

- Xms1024m -Xmx1024m -XX:MaxPermSize=256m -XX:NewSize=256m -XX:MaxNewSize=256m

For more information about how to tune JVM settings for OC4J, see the Oracle Application Server Performance Guide. Also see “Performance Documentation for the Java Hotspot VM” available at the Sun Developer Network: http://java.sun.com/docs/hotspot/index.html

Tuning Oracle HTTP Server

This section describes how to tune Oracle HTTP Server to improve Agile PLM performance. The main configuration file for Oracle HTTP Server is httpd.conf. It is located in the following directory:

Windows: <oracle_home>\Apache\Apache\conf

Solaris or Linux: <oracle_home>/Apache/Apache/conf

Open the httpd.conf file to edit it. You can use any text editor.

In the httpd.conf file, search for the following parameters: ThreadsPerChild and MaxClients. The recommended settings are shown below:

```
# Number of concurrent threads (i.e., requests) the server will allow.
# Set this value according to the responsiveness of the server (more requests active at once means they're all handled more slowly) and the amount of system resources you'll allow the server to consume.
# ThreadsPerChild 25 (for every 2 CPUs on the Application Server)
#
# Limit on total number of servers running, i.e., limit on the number of clients who can simultaneously connect --- if this limit is ever reached, clients will be LOCKED OUT, so it should NOT BE SET TOO LOW. It is intended mainly as a brake to keep a runaway server from taking the system with it as it spirals down...
```


MaxClients 25 (for every 2 CPUs on the Application Server)

Important  If you modify the httpd.conf file, you must restart Oracle Application Server.

Configuring Database Access using Agile Administrative Settings

Access to the Agile database is controlled through the roles and privileges you grant users using the Agile web client administrative settings. Before allowing any external access to your Agile servers, you must first consider who needs access and what they need to access.

The list of potential external users may include, but is not limited to:

- Contract manufacturers
- Suppliers
- Customers
- Licensees
- Remote manufacturing facilities
- Field service personnel
- Traveling employees

Allowing access to third-party companies, such as contract manufacturers, may require special consideration. Most likely, you do not want these users to have access to all of your product information. Instead, you may want to grant them access to only a small subset of your data. For instance, they may need access only to data about products that they build for you.

Agile recommends that you create a role using the Agile Java client administrative settings for each different type of external user. Once the role is defined, users can be assigned to the role. All users assigned to the role will inherit the privileges that are assigned to the role.

The Agile Web client administrative settings includes with a role called Example - Subcontractor that can be used as a template for setting up access for external users. For more information, see the Agile Administrator Guide.

You can take this one step further, and create a Page Two field on all Items and Changes called External User. This field can be filled with any external usernames that are allowed to access each Item or Change. A privilege can then be created for each role that allows access only to objects based on the value of this field. For instance, privileges can be created and granted so that Acme CEM employees can read only objects that have the value Acme in the External User field.

Configuring Your Firewall

Most likely, your Agile servers are located behind your corporate firewall. An important part of system security is allowing incoming connections from the Agile web client to Agile Application Server and Agile Viewer, while restricting access to other parts of your system.

If the computer with Agile Application Server does not have registered IP addresses, the firewall will most likely have to do some sort of IP address translation.

Restarting Windows Servers Periodically

If your Agile PLM servers are running on Windows, arrange for them to be restarted occasionally. In some environments, Windows servers should not be left running for prolonged periods. Network or client problems can cause memory problems on the server that lead to poor performance and ultimately to server errors.

Agile recommends restarting once a week, which should be more than sufficient for most environments. However, you may wish to experiment to see if your servers can benefit from being restarted more frequently.
**Color Settings**

For best support of the current Agile PLM color-coded user interface, set client computers to display more than 256 colors.

**Dynamic Versus Static IP Addresses**

You can use dynamic IP addresses with “long-term lease” assignments, as well as static addresses, for Oracle systems. For best results, do not change the hostname of computers in the system, and use static addresses for Windows servers.

**Checking Your TCP/IP Connection**

To verify that the client computer has a TCP/IP connection to the Web server:

1. Open a Command Prompt window.
2. In the Command Prompt window, ping the Web server by typing:

   ```bash
   ping servername
   ```

   The system returns a statement similar to the following:

   ```
   Pinging server_name [10.1.1.160] with 32 bytes of data:
   Reply from 10.1.1.160: bytes=32 time =1ms TTL=128
   ```

   This response verifies that your TCP/IP connection is working.

**Configuring Browsers on Client Computers**

Agile recommends that all browsers are set to check for newer versions of stored pages every visit to the page.

To set Internet Explorer to check for newer versions of stored pages every visit to the page:

1. Open **Start > Settings > Control Panel > Internet Options**.
2. On the **General** tab of the Internet Properties dialog box, click **Settings** in the Temporary Internet files section.
3. Select **Check for newer versions of stored pages: Every visit to the page**, then click **OK**.
4. Click **OK** to close the Properties dialog box.

**Uninstalling Agile PLM**

Follow these instructions to remove Agile PLM 9.2.1.

To remove Agile PLM 9.2.1 on Windows:

1. Stop the following services:
   - IIS Admin Service
   - World Wide Web Publishing Service
   - AgileService (if you installed the Application Server as a service)

   **Note** If Trend Micro anti-virus software is running on the same computer where Agile PLM is installed, stop the Trend Micro service before stopping AgileService.

2. Undeploy the Agile application from Oracle Application Server. To do this, follow these steps.
   - Make sure Oracle Application Server is still running.

   To check OAS status, open a command prompt window, change to `<OAS_Home>\opmn\bin` directory, and run `opmnctl status`. If OAS isn’t running, run `opmnctl startall`. 
b From a command prompt window, change to the `<agile_home>/agileDomain/bin` directory.
c Run `UnDeployAgile`.

3 Choose `Start > All Programs > Agile > Agile 9.2.1 > Uninstall Agile 9.2.1`.
4 Click `Uninstall` on the Uninstall Agile window.
5 Click `Done` when finished.
6 Restart the computer.
Tuning Memory for Java Applets

The Agile Web Client uses Java applets for advanced functionality. Examples include the Gantt Chart and the Agile Viewer. These applets use the Java Plug-in to run inside your browser.

The amount of memory an applet requires depends on the content it attempts to load. If you experience memory problems while running the Gantt Chart, the Agile Viewer, or other Java applets, you should increase the amount of memory available to Java applets. To configure Java applet runtime parameters, use the Java Control Panel.

To adjust Java applet runtime parameters on Windows:
1. From the Windows Control Panel, run Java to open the Java Control Panel.
2. Click the Java tab.
3. In the Java Applet Runtime Settings box, click View. The Java Runtime Settings dialog box appears.
4. In the Java Runtime Parameters box, add the following:
   
   -Xmx<memory-limit>

   For example, to set maximum available memory to 256Mb, enter -Xmx256M.
5. Click OK to close the Java Runtime Settings dialog box.
6. Click OK to close the Java Control Panel.
7. Restart the browser.

To adjust Java applet runtime parameters on Solaris or Linux:
1. Determine which version of the Java Plug-in the browser is using.
2. Run the script <java-dir>/jre/bin/ControlPanel to open the Java Control Panel.
3. Click the Java tab.
4. In the Java Applet Runtime Settings box, click View. The Java Runtime Settings dialog box appears.
5 In the **Java Runtime Parameters** box, add the following:

   `-Xmx<memory-limit>`

   For example, to set maximum available memory to 256Mb, enter `-Xmx256M`.

6 Click **OK** to close the Java Runtime Settings dialog box.

7 Click **OK** to close the Java Control Panel.

8 Restart the browser.

**To adjust Java applet runtime parameters on Mac OS X:**

1 Determine which version of the Java Plug-in the browser is using.

2 In Finder, run the **Applications > Utilities > Java > Java <java-version> > Plugin Settings** command.

3 In the **Java Runtime Parameters** box, add the following:

   `-Xmx<memory-limit>`

   For example, to set maximum available memory to 256Mb, enter `-Xmx256M`.

4 Click **Apply**.

5 Close the control panel, and restart the browser.

**Java Control Panel**

For more information about the Java Control Panel and how to configure Java runtime settings on your client computer, go to [http://java.sun.com](http://java.sun.com) and search for “Java Control Panel”.

**Frequently Asked Questions**

**How much physical available memory do I need to run Agile PLM applets?**

Please see the *Agile PLM Capacity Planning and Deployment Guide* for all Agile PLM hardware and software requirements.

In general, you will need at least 256Mb free available memory to use for Java applets. If the machine does not have that much memory available, a RAM upgrade is recommended to achieve the best performance.

On Windows, you can see the free available memory by opening the Windows Task Manager and clicking the Performance tab.

**Do you need Administrator privileges on the client machine to modify Java runtime settings?**

It depends on who installed Java on the machine. If the Administrator installed it, only he will have permission to modify Java runtime settings.

**What is the -Xmx Java runtime parameter?**

It sets the maximum size of the memory allocation pool. The default value is 64Mb.

**Are there other Java runtime parameters?**

Yes, there are several other Java runtime parameters that you can configure. For a complete list, see the Java Control Panel documentation.
INDEX

A
Agile Integration Framework 3-5
Agile Integration Services (AIS) 3-5
Agile PLM 9.2
  system requirements 3-2
  View Server 8-1
    architecture 8-2
    HTTPS 8-3
    security 8-2
Agile PLM ActiveX Control 9-6
Agile Product Governance & Compliance 9-1
  privileges 9-4
Agile SDK 3-5
  AgileSDK.cache folder 4-6
Apache Tomcat, configuring 10-2
AutoVue Server Console 8-7

B
browser configuration D-4

C
ccheckLDAPConfig script B-2
  clients
    View Server requirements 8-2
    cluster, defined 5-2
    commodity codes
      loading 10-7
    configuring browsers D-4
    configuring client computers D-4
    configuring load balancer 5-5
    CreateArchive script B-1
    CreatePCWar script B-1

D
debugin, View Server 8-7
DeployAgile script B-2
  directory server 3-5
disk space requirements 2-2
distributed file management server
  configuring 6-4
dynamic IP addresses D-4

E
toencryptpwd script B-2
error logs, Product Interchange 10-2
ExpandArchive script B-1
ExpandPCWar script B-1
ext.jnlp 11-2
ExtractConfigFiles script B-1
ExtractJNLPFiles script B-1

F
file vault, reorganizing 2-3
file.server.url property 6-6
firewalls
  configuration 7-2
  Java client D-3
  port requirements 8-3

G
garbage collection D-1
GetInstanceName script B-1
GetRepository script B-1
global-web-application.xml file 4-8
hardware
  color settings D-4
  IP addresses D-4
  restarting D-3
HTTP session replication 5-4
httpd.conf file 4-7, D-2
HTTPS
  View Server 8-3
i
iFS port usage 7-2
iFSReorgV2.jar 2-3
isisforward.dll 7-10
isisproxy.dll 7-10
installing
  Java client 11-1
  starting 3-3
InstallNTService script B-2
installNTService-managed-server script B-2
IP addresses D-4
ISAPI filters 7-4

J
Japan Green Procurement Survey Standardization Initiative (JGPSSI) 9-1
Java applets, memory E-1
Java client
  access D-3
  firewall configuration D-3
  installing 11-1
log files 7-10
overview
  security 7-1
Java Control Panel E-2
JNLP files 11-2, B-1
JRE 5.0 11-1
JVM parameters D-1
jVue, see View Server

L
LDAP authentication 3-5
license.xml 9-6
load balancer 5-5
log files, Java client 7-10
logging priority 7-11
logging, View Server 8-7

M
manufacturer aliases
  getting 10-7
  loading 10-5
manufacturer codes
  loading 10-6
manufacturer part aliases
  getting 10-7
manufacturer part number aliases
  loading 10-6
MaxClients parameter D-2
memory management D-2
memory, Java applets E-1
Microsoft Excel-based Client for Agile PG&C 9-1
  license file 9-6
  notifications 9-3
  troubleshooting 9-10
migrateUsersToDB script B-2

N
non-repository host, defined 5-2
notifications, Microsoft Excel-based Client for Agile PG&C 9-3

O
opmn.xml file 4-8
Oracle Application Server
terms 5-2
Oracle Application Server Control
  service 4-3
Oracle HTTP Server, configuring 4-7
orion-web.xml 5-6
overview
  Java client 7-1

P
passwords, encrypting B-2
pcclient.jnlp 11-2
Portlet_50 folder 3-5
Agile PLM 9.2.1

Portlet_51 folder 3-5
ports
  iFS 7-2
prerequisites
  ports 8-3
privileges, PG&C 9-4
Product Interchange data load 10-3
data file formats 10-3
Product Interchange error logs 10-2
proxies
  Oracle 7-3
proxy timeout 7-10
R
RepackConfigFiles script B-1
RepackJNLPFiles script B-1
replication, session 5-4
repository host, defined 5-2
requirements 3-2
  IP addresses D-4
  Java client 7-1
  ports 8-3
  Web server security 7-2
RestartEMAgent script B-1
restarting servers D-3
RestartOAS script B-1
round-robin policy 5-6
runCommodityDetails.bat 10-7
runExternalMfrAliasesGetter.bat 10-7
runInternalMfrAliasesGetter.bat 10-7
runMpnAliasGetter.bat 10-7
S
sdk/extensions property 4-6
sdk.extensions.lib folder 4-6
security
  firewall configuration 7-2, D-3
  HTTPS with View Server 8-3
  Java client 7-1
  open ports 8-3
  View Server 8-2
  Web server requirements 7-2
server farm, defined 5-2
server.conf file 6-6
servers
  IP addresses D-4
  restarting D-3
  stopping 2-2
services, stopping 2-2
setEnv script B-2
startAgile script B-2
startAgileCluster script B-2
starting the installer 3-3
starting the installer
static IP addresses D-4
stopAgile script B-2
stopping
  servers 2-2
services 2-2
system requirements 2-1, 3-2
  IP addresses D-4
  ports 8-3
T
temp directory, setting 4-7
Temp folder 9-10
ThreadsPerChild parameter D-2
TMP environment variable 4-7
troubleshooting
  Microsoft Excel-based Client for
  Agile PG&C 9-10
  View Server errors 8-6
U
uninstallNTService script B-2
upgrading
  application server 2-3
  database 2-3
  disk space requirements 2-2
  server components 2-1
  system requirements 2-1
upgrading file vault 2-3
url-handlers.jar 4-5
V
View Server
  architecture 8-2
  debugging 8-7
  HTTPS 8-3
  overview 8-1
  security 8-2
  troubleshooting 8-6
W
Web client
  logging in 7-9
  troubleshooting 7-9
Web servers
  security requirements 7-2
Windows
  Agile PLM 9.2 requirements 3-2
X
xmlparserv2.jar 4-5